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Safety Information 

 Except	as	explained	in	this	manual,	do	not	attempt	to	service	BTECH	equipment	yourself.	
Opening	the	equipment	may	expose	you	to	dangerous	voltages.	Refer	servicing	beyond	that	
described	in	this	manual	to	authorized	personnel.	

 Do	not	allow	liquids	or	moisture	to	get	into	the	equipment.	If	liquid	does	get	into	the	
equipment,	unplug	it	immediately	and	contact	your	nearest	authorized	service	center	or	
BTECH	directly.	

 Ensure	equipment	is	provided	adequate	ventilation.	Do	not	block	equipment	ventilation	
openings.	

 Do	not	exceed	equipment	voltage	or	power	ratings	and	capabilities.	

 Make	sure	that	equipment	is	properly	grounded.	

 Do	not	let	unauthorized	persons	operate	the	equipment.	

 Do	not	energize	the	cabinet	or	any	component	with	115VAC	or	battery	voltage	until	after	
the	installation	is	complete.		

 Use	of	this	product	in	a	manner	not	specified	could	compromise	the	designed‐in	safety	of	
this	product.		

	

 

WARNING!		The	Battery	Validation	System	is	designed	to	connect	to	UPS	systems	that	are	
600VDC	or	less	and	a	maximum	of	300V	with	respect	to	earth	ground.	The	voltage	with	respect	
to	earth	ground	must	be	verified	before	connecting	the	system.	This	can	be	done	by	measuring	
the	voltage	from	each	battery	post	referenced	to	earth	ground.	The	voltage	cannot	exceed	300V. 

 

	
WARNING!		High	Voltage	or	current	may	be	present	in	the	equipment.	Only	qualified	personnel	
should	perform	the	operations	described	in	this	manual. 

 

WARNING!		High	Voltages	exist	inside	the	system	components	and	on	the	equipment	terminals.	
Calibration	must	be	performed	only	by	technically	qualified	persons.	Observe	electrical	safety	
precautions	when	removing	and	installing	equipment	covers,	and	when	connecting	leads	and	
making	adjustments. 

 

	
WARNING!		Fuses	cannot	be	changed	by	the	operator.	 

 

WARNING!		Only	use	the	AC	power	cord	provided	with	the	system.		Substituting	this	cord	may	
cause	damage	to	the	system	and	place	personnel	at	risk	electric	shock. 

 

 

 



Technical Specifications 
 

SCM‐600	 	 	 	 	
AC	Input	 Models	 S5x‐xxxxxx‐xx‐xx‐A0	

S5x‐xxxxxx‐xx‐xx‐A1	
	 Voltage	 90	–	125	 VAC		 US,CAN,	&	JPN	

100	–	240	 VAC	 Europe,	Korea	
	 Power	 Maximum	 75	 Watts	 	
	 Frequency	 50‐60	 Hz	 	
DC	Input	 Models	 S5x‐xxxxxx‐xx‐xx‐D2	

S5x‐xxxxxx‐xx‐xx‐D3	
Voltage	 Nominal		48VDC	 26‐60	 VDC	 	

Nominal		
120VDC	

95‐145	 VDC	

	 Power	 Maximum	 75	 Watts	 	
Operating	
Environment	

Temperature	Range	 41	–	104		 °F	 5	–	40	°C	

	 Humidity	 0%	to	80%	RH	(32	–	86°F)	 0	–	30	°C	
0%	to	50%	RH	(88	–	104	
°F)	

31	–	40	°C	

	 Altitude	 0	–	2000		 m	 	
Mechanical	 Length	 16.875	 ins	 (429	mm)	
	 Width	 16.5625	 ins	 (421	mm)	
	 Depth	 3.5	 ins	 (89	mm)	
	 Weight	 24	 lbs	 (10.9	kg)	
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BTECH	Inc.	takes	pride	in	the	quality	of	its	new	documentation.	However,	technical	inaccuracies,	
typographical	errors	and	editorial	omissions	do	occur	from	time	to	time.	Although	the	
documentation	is	provided	“as	is,”	and	BTECH	Inc.	disclaims	all	direct,	indirect,	or	consequential	
damages	that	may	result	from	such	errors,	please	let	BTECH	Inc.	know	immediately	if	you	
discover	inaccuracies,	errors,	or	omissions.	We	will	make	every	effort	to	correct	the	deficiencies	
in	new	editions	and	updates.	

Copyright	2012	by	BTECH	Inc.	

All	Rights	reserved	

10	Astro	Place	

Rockaway,	NJ	07866	

M	7.5‐2	

Ver.	2.0	(August	2012)	

Printed	in	the	United	States	of	America	

 

BTECH SERVICE AND SUPPORT 
 

 

Phone:	1‐973‐983‐1120	

Fax:	1‐973‐983‐1125	

E‐mail:		techsupport@btechinc.com	

Web	page:	http://www.btechinc.com	
 

 

 

 

 

This product has been tested to the requirements of CAN/CSA-C22.2 No. 61010-1, 
second edition, including Amendment 1, or a later version of the same standard  
incorporating the same level of testing requirements. 

This Class A digital apparatus complies with Canadian ICES-003.   
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 

This device complies with part 15 of the FCC Rules.  Operation is subject to the following two 
conditions:  (1)  This device may not cause harmful interference, and, (2)  this device must accept any 
interference received, including interference that may cause undesired operation. 

 

 

Caution	to	user:	Changes	or	modifications	not	expressly	approved	by	the	
party	responsible	for	compliance	could	void	the	user's	authority	to	operate	
the	equipment	

 

 

Note:	This	equipment	has	been	tested	and	found	to	comply	with	the	limits	for	a	Class	
A	digital	device,	pursuant	to	part	15	of	the	FCC	Rules.	These	limits	are	designed	to	
provide	reasonable	protection	against	harmful	interference	when	the	equipment	is	
operated	in	a	commercial	environment.	This	equipment	generates,	uses,	and	can	
radiate	radio	frequency	energy	and,	if	not	installed	and	used	in	accordance	with	the	
instruction	manual,	may	cause	harmful	interference	to	radio	communications.	
Operation	of	this	equipment	in	a	residential	area	is	likely	to	cause	harmful	
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interference	in	which	case	the	user	will	be	required	to	correct	the	interference	at	his	
own	expense.	
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Figure 52‐ Daisy‐chained VM‐24i units.  The last unit MUST have the ‘termination plug 
installed ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐70 
Figure 53‐Matching serial numbers between a CT and S5 ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐71 
Figure 54 – S5 Grounding Example ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐72 
Figure 55 – S5 Mid‐panel showing with certain connections Labeled ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐73 
Figure 56‐The Win 7 Print Dialog ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐74 
Figure 57‐Accept or change the date or the date range for a report. ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐80 
Figure 58‐ Selecting Strings and/or Units for Reports ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐81 
Figure 59‐The Reports menu from the BVM4 main screen. ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐82 
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Figure 62‐The Alarms and Alerts Logs (partial illustration) ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐84 
Figure 63‐System Analysis Report from the BVM Main Screen Side Bar ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐86 
Figure 64‐Discharge Intervals (Home screen sidebar – partial illustration) ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐87 
Figure 65‐Alerts and Alarms, Sidebar  (partial illustration) ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐87 
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Figure 80‐Date‐Time Spin box.  Some boxes only have one entry ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐97 
Figure 81‐The BVM4 ‘Graphs’ drop‐down menu ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐99 
Figure 82‐An extended example of the View menu. ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 100 
Figure 83‐Unit Snapshot [of Unit Measurements] Graphs for Voltage, Impedance, and 
Temperature ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 101 
Figure 84‐Unit Trend (Trend of Unit Measurement) Graphs for Voltage, Impedance, 
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Figure 87‐System Trend (Trend of System Measurements) Graph ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 104 
Figure 88‐Power Outage Interval Graph ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 105 
Figure 89‐ Voltage and Temperature Discharge Measurements Graph ‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐‐ 106 
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1.   Product Overview 
Thank	you	for	choosing	BTECH’s	S5	Battery	Monitoring	and	Validation	System.	The	S5	is	BTECH’s	fifth	
generation	of	battery	monitoring	products,	including	all	of	the	engineering	and	field	experience	the	
company	has	generated	since	its	inception	in	1989.	Today,	with	over	30		00	systems	installed	
worldwide,	BTECH	is	the	undisputed	leader	in	the	battery	monitoring	industry	with	experience	that	is	
unmatched.	BTECH	has	a	staff	of	engineers	and	technicians	supporting	the	product	at	our	
headquarters	in	Rockaway,	NJ,	and	has	built	a	network	of	trained	service	technicians	across	North	
America,	Asia,	Europe,	Africa	and	the	Middle	East.	We	are	there	for	your	questions	and	concerns.  

BTECH	Inc.	manufactures	the	only	patented	online	real‐time	impedance	monitor.	BTECH	believes	that	
the	best	way	to	assure	emergency	critical	power	continuity	is	to	empower	our	customers	with	
immediate	battery	data.	Thus	enabled,	preventative	battery	maintenance	can	be	performed,	
minimizing	the	chance	of	the	DC	plant	being	compromised	at	its	most	critical	moment,	going	under	
load.	BTECH’s	battery	management	system	is	comprised	of	two	principle	components,	the	BVS	
(Battery	Validation	System)	hardware	and	BVM	(Battery	Validation	Manager)	software.	The	combined	
package	allows	you	to	have	at	your	computer	fingertips	the	following	monitoring	power:	

 

 Individual	unit	/	cell	impedance	monitor	

 Pilot	unit/cell	temperature	monitor	

 Individual	unit	/	cell	voltage	monitor	

 Total	voltage	monitor	

 String	current	float	and	discharge	monitor	

 Battery	discharge	monitor	

 Cycle	counter	monitor	

 Real‐time	system	monitoring	
 

This	monitor	is	the	most	powerful	battery	management	system	available	today.	

Battery	health	and	its	correlative	relationship	to	impedance	is	well	documented.	A	rise	in	a	battery’s	
impedance	signifies	diminished	battery	health.	The	single‐most	powerful	feature	is	the	ability	to	trend	
daily	or	weekly	impedance	readings	in	the	software	and	automatically	alarm	when	default	conditions	
are	met.	Simultaneous	alarm	communications	to	cell	phones,	pagers,	and	host	computers	are	
available.	Thus,	the	user	is	continually	informed	with	preemptive	data,	empowering	the	ability	to	
implement	proactive	battery	preventative	maintenance	before	disaster	can	strike.	

For	more	detailed	information	about	analyzing	your	battery	data,	see	our	Complete	Guide	To	Battery	
Monitoring,	included	in	the	box.	
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General	Information	

Customer and Product Support 

To	obtain	assistance	and	support	for	any	BTECH	product	contact	the	company	as	described	below.	

Main Office 

BTECH, Inc. 
10 Astro Place 
Rockaway, NJ, USA 

07866  

Web Site: 

www.btechinc.com	

Phone:	

973‐983‐1120	

973‐983‐1125	(fax)	

Email:	

Customer Support 

Support Desk  Phone  Email 

Technical Support  (US) 973‐983‐1120  techsupport@btechinc.com 

     

	

Additional Product Technical Information 

The	following	publications	are	available	from	BTECH	and	can	be	downloaded	from	the	BTECH	
website	as	PDF	files.	

S5 Communications  

This	document	describes	the	S5	communication	options	including	serial	connection	links,	telephone	
and	internet	links,	and	Ethernet	network	links.		

MODBUS Messaging to the S5 Battery Validation System  

This	document	describes	how	to	configure	a	computer	to	monitor	and	evaluate	measurements	taken	
by	the	S5	and	send	them	to	a	Building	Management	System.	

SNMP Integration of the S5 Battery Validation System  

This	document	describes	how	to	configure	the	S5	BMS	software	as	an	agent	on	an	SNMP	network.	
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Technical Support Bulletins 

BTECH	posts	technical	support	bulletins	as	PDF	files	on	its	website.		These	files	and	other	support	
materials	can	be	downloaded	as	necessary.			

 

 

Customers are encouraged to check the site periodically to see if important 
new information has been added. 

 

About This Guide 

All	of	the	information	contained	in	this	guide	was	current	and	accurate	at	time	of	publication.		Check	
the	BTECH	website	to	see	if	any	‘Service’	or	‘Product’	update	bulletins	have	been	issued	or	additional	
documentation	posted	following	the	Guide’s	publication.	

This	guide	is	intended	to	be	printed	‘duplexed’.		If	printed	uniplex	some	blank	pages	will	occur	with	
just	heading	and	footings.		This	is	normal	and	DOES	NOT	indicate	missing	material.	

 

In some instances Metric measurements in this document have been 
rounded. 

Internal Document Links – MS Word and Adobe PDF 

Both	the	MS	Word	and	the	Adobe	PDF	document	versions	contain	embedded	internal	links.		The	links	
consist	of	the	following:	

 Table	of	Contents,	Figures,	and	Tables	List,	

 References	to	Figures	and	page	numbers	within	the	text,	

 References	to	Headings	and	Titles	within	the	text.	

Embedded MS Word Links 

To	follow	a	link	in	MS	Word,	place	the	cursor	on	a	link	item.		If	the	tool‐tip	shown	below	appears	hold	
down	the	Ctrl	key	and	click.		The	user	jumps	to	the	target	link	location	

	

Adobe PDF Files 

Place	the	cursor	on	a	link	item.		The	cursor	changes	to	a	pointing	finger	(see	below).		Click	and	the	
user	jumps	to	the	target	link	location.	
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Symbols and Terms Used in the Guide 

Throughout	the	guide	there	are	items	set	off	by	themselves	and	preceded	by	one	of	the	symbols	
shown	below.		The	symbol	indicates	the	type	of	information	and	its	relative	importance.	

 

Symbol  Name  Purpose 

	

Note  Indicates an important point that customers should be 
aware of.   

	

Important  Indicates a critical, non‐safety related item.  In general, 
failure to comply with these items may result in 
damage to equipment and voiding of Warranty. 

	

Safety Warning   Indicates a procedure that can result in personal injury 
if not performed properly and with the necessary 
safeguards in place. 

 

Key	Terms	

Key	terms	used	throughout	this	manual	are	defined	below.		Refer	to	Figure	2‐	Battery	System	
Diagram	

	
 

Term		 Definition	

Alarm  A critical warning requiring immediate attention. 

Alarm Relays  A physical connection on the rear of the S5 used to pass alarm data to a 
building system central monitoring station. 

Alert  Refers to a non‐critical warning.  Sometimes called a “maintenance” alert. 

Battery  The battery backup system in its entirety 

Battery Bar or Strap  A piece of metal or cable connecting two battery cells/jars 

Battery Jar  One to six cells enclosed in a common smallest replaceable part 

Battery String  A set of battery cells/jars wired in series 

Battery Unit  The smallest segment of the battery being monitored by the S5 system 
(can be 1 or more cells/jars in a unit) 

Controller  An individual S5 unit.  Sometimes specific to the memory functions. 

Observer  BVS Observer.  A Windows service that runs in the background of the host 
computer and collects data from the S5. 

POTS  “Plain Old Telephone Service”.  A basic service line used with a dial‐up 
modem. 

Site  References a particular S5 unit (i.e. one location can have multiple sites) 
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Term		 Definition	

SNMP  Simple network management protocol.  A IP network protocol that can be 
used when linking a S5 to battery system locations using a network. 

SQL (Sequel)   A sophisticated database system that can be used with BVM 4.x 

Status Monitor  BVS Status Monitor.   

   

 

Integrated	User	HELP	

The	BVM	software	includes	integrated	Help	available	by	clicking	HELP	in	the	menu	bar.		Select	Help	
Topics	in	the	drop‐down	menu.		A	two‐pane	screen	is	displayed	with	a	master	volume	shown	on	the	
left	side,	(see	Figure	1‐	Partially	Expanded	Help	panel	

To	view	help	content	–	

a. Double‐click	on	a	master	volume	icon	to	expand	it.		This	displays	a	set	of	topic	volumns,	
b. Click	on	a	topic	volume	to	display	its	topics,	
c. Select	a	topic	to	view	its	content	in	the	right	pane.	

 

 

Integrated User HELP can be printed by selecting a volume, folder or topic and 
clicking the Print icon.  The complete Help content can be printed by selecting 
the master volume and clicking the Print icon. 

 

Figure	1‐	Partially	Expanded	Help	panel	
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Figure	2‐	Battery	System	Diagram	
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2.  Installing the Software 

BVM	Software	Applications	

Battery	Validation	Monitor	(BVM):		Enables	users	to	analyze	and	interpret	all	measurement	data	
by	providing	a	graphical	analysis	of	performance.		It	also	serves	as	the	direct	link	to	the	controller	to	
manipulate	system	settings,	clear	alarms,	or	enter	the	system’s	diagnostic	mode.		Additionally,	it	
provides	a	real‐time	discharge	data	logger	that	enables	users	to	view	ongoing	voltage	and	current	
information	during	a	discharge	event	or	discharge	test.	

BVS	Observer:		Observer	is	a	Windows	service	that	runs	in	the	background	on	the	host	PC	and	
periodically	collects	the	latest	measurement	data	from	the	battery	monitoring	system	controllers,	
(S5s).		Over	time,	a	valuable	battery	trend	database	is	built	that	continually	tracks	the	battery	
system’s	performance	and	compares	it	with	results	obtained	when	the	battery	system	was	new.	

BVS	Status	Monitor:		Provides	the	user	with	a	summary	of	all,	or	a	group	of	battery	systems'	status.		
It	provides	‘drill‐down’	functionality	from	all	of	the	battery	systems	to	individual	units	by	launching	
the	BVM.		It	also	provides	the	user	with	an	audible	and	visible	alert	when	new	alarms	are	received	by	
the	BVS	Observer.			

BVM Filed Types 

Database	Files:		BVM	installs	one	or	more	database	files	in	the	“BVMData”	folder.		Generally	these	
are	“MS	Access”	files	but	the	user	has	the	option	of	switching	to	SQL	databases	if	they	prefer.	

.bvm	File:		Microsoft	database	file.	

.set	File:		These	are	supplied	by	BTEC	and	contain	the	initial	controller	settings	based	on	
manufacturer	specifications.		Users	can	overide	the	file	content	or	create	new	.set	files	as	needed.		It	
is	particularly	relevent	to	backing	up	and	restoring	the	controller	settings,	(see	The	Get/Set	
Configuration,	on	pg.	63).		When	multiple	locations	are	monitored	by	an	S5	there	will	be	one	.set	file	
for	each	location.	

.mib	files:		These	are	supplied	by	BTECH	on	an	as‐needed	basis.		They	are	used	when	a	customer	
implements	SNMP	traps	in	a	network	environment,	(see	SNMP	Manager	Description	and	
Configuration,	beginning	on	page	136).	

 

 

The	.bvm	and	.mdb	files	MUST	have	matching	serial	numbers	and	MUST	be	
located	in	the	same	directory.	

	
 

 

 The BTECH installation disk includes a copy of Microsoft’s SQL Server Express.  
A number of other Microsoft SQL server packages will also work with BVM 4.x 
(see Appendix).  For sites using ‘Server Express’, BTECH provides a stored 
procedure for use with back‐ups. 



	
S5	Operating	Manual		

	 Installing the Software 

 

Ver.	2.0	(August	2012)			 P a g e 	|	8	

	
 

 All BTECH application and data files should be included as part of regular 
computer or server backup scheduling. 

 

There	is	one	each	of	the	following	program	files	for	each	S5	unit	in	the	installation.		They	are	created	
by	BTECH	specifically	for	the	site	and	are	identified	by	the	serial	number	of	the	unit.		They	must	all	be	
in	the	same	directory	on	the	host	computer	or	the	server’s	hard	drive.	

 Sitename+Serial	Number.mdb	–	This	is	a	Microsoft	Access	database	file,	

 Sitename+Serial	Number.bvm	–	There	will	be	one	of	these	files	for	each	S5,	

 Sitename+Serial	Number.set	–	This	is	a	text	file	containing	the	site	settings.	

Installation Machine Requirements 

The	following	Windows	and	computer	hardware	specifications	are	required.	

Machine	Requirements	

OS  Processor  Memory  HD Space  Display 

Windows XP (SP3) 
(32‐bit) or 

Windows 2003 (32‐bit) 

800 MHz Pentium 
III 

512 MB  100 MB for programs 
and small data files 

1024 x 768 

Windows Vista (32‐bit) 

Windows 2008 (32‐bit) 

Windows 7 (32‐bit) 

1.4 GHz – x86 or 
x64 processor 

2 GB  100 MB for programs 
and small data files 

1024 x 768 

Windows Vista (64‐bit) 

Windows 2008 (64‐bit) 

Windows 7 (64‐bit) 

2 GHz – x64 
processor 

2 GB  100 MB for programs 
and small data files 

1024 x 768 

 

 Mouse or other pointing device 

 Dial‐up modem if one or more S5 units will utilize communication over a POTS line. 

 IP network connection for sites communicating over a network. 

 

 

The BVM software can be run on a virtual machine provided that the 
processor resources, memory, and disk space described above are 
available. 

Installation	Files	and	Directory	Structure	

When	the	BVM	software	is	installed	on	a	local	disk	it	creates	a	new,	BVM4	directory	and	various	
certain	sub‐folders	where	it	copies	files.		Some	additional	files	are	specific	to	each	particular	location	
and	must	be	transferred	to	the	host	computer	or	server	manually,(	see	Starting	Observer	and	Adding	
Locations,	,	pg.	10).		Other	programs	are	placed	in	specific	folders	where	they	must	remain	or	the	
system	will	not	function	properly.		See	Figure	3,	page	9,	for	an	illustration	of	the	folder	structure.	
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Installing	the	BVM	Software	on	a	Windows‐based	PC	or	
Server	

The	BVM	software	is	supplied	on	a	standard	CD‐ROM.		Once	the	installation	is	complete	the	CD	and	
sleeve	should	be	kept	in	a	safe	location	for	future	use.		The	CD	can	be	used	to	activate	future	versions	
of	the	BVM	software.	

 

Figure	3‐The	BVM	4.x	Install	Directory		

	

To	install	the	software	use	the	following	procedure,	(see	Figure	4,	below).	

a. Insert	the	BVM	software	CD‐ROM	into	the	machine’s	CD.		In	a	few	moments	the	Autoplay	
panel	is	displayed.	

b. Click	run	BVM_4.x.x_Setup.exe.		
c. In	the	resulting	options	check	box	select	the	following	items	based	on	the	Installation:	
 Install	BVS	Observer	if	the	S5	will	be	monitored	on	a	full‐time	basis,	by	a	server	or	dedicated	

work	station,	(only	one	instance	of	BVM	can	be	run	on	a	network).			

 Install	the	USB	Com	Port	driver	if	the	S5	will	be	monitored	by	directly	connecting	a	computer	
via	a	USB	cable.	

The	Update	System	panel	is	displayed	showing	a	progress	bar	indicating	the	installation	status.		If	the	
BVM	Software	Activation	dialog	is	displayed	refer	to	Activating	BVS	Observer,	pg.	12.		This	only	
occurs	under	certain	circumstances.	

d. Select	the	desired	destination	folder	and	click	Next.			
 MS	Windows	selects	a	default	drive	and	folder	for	the	software	installation	on	the	computer’s	

hard	drive.		In	general	it’s	best	to	accept	the	default.		To	install	the	BVM	software	in	another	
location,	click	the	Browse	button	in	the	Destination	Folder	box	to	display	a	list	of	drives	and	
folders.		

e. Click	Finish	when	the	“successful	installation	dialog”	is	displayed.			
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Figure	4‐BVM	4	Installation	Component	Selection	Dialog	

	
 

 

Do not remove the CD‐ROM from the computer at this time.  Some BVM files 
must be transferred from the CD to the BVM directory on the computer’s hard 
drive. 

 

Adding Locations to BVM  

In	the	S5	‘world’	a	“location”	refers	to	a	specific	battery	system	being	monitored	by	an	S5	controller.		
For	illustration	purposes	this	guide	uses	only	one	location	with	two	strings.		The	BVM	software	
delivered	with	the	S5	unit(s)	includes	a	.bvm	file	for	each	S5	unit	in	the	order.		These	files	must	be	
transferred	to	the	BVM	application	folder	manually	before	battery	monitoring	can	take	place.		

 

 

The .bvm files MUST be transferred as described in this section.  They 
CANNOT be copied and pasted. 

 

 

All files for a specific site will be labeled: 

[location id]+S5+[sequence #]+x4.bvm 

where the sequence number = 1,2,3, etc, (see Figure 5, page 11).   
 

Starting BVM and Transferring Location Files from the CD 

The	BTECH‐supplied	CD	includes	one	or	more	custom	files	used	by	the	BVM	software	(one	.bvm	file	
for	each	S5	being	added).		These	files	are	NOT	copied	during	the	installation	process	and	must	be	
transferred	to	the	BVM4	folder	on	the	computer’s	hard	drive	using	the	BVM	application.		As	shown	
above,	each	.bvm	file	is	uniquely	identified	by	its	serial	number.					

a. Start	the	BVM	software	by	doing	either	of	the	following:	

 If	there	is	a	BVM	icon	in	the	Windows	Start	menu	 click	on	it,	
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 Open	the	Windows	Start	menu	and	select	“All	programs”.		Navigate	to	the	BTECH	folder	and	
double‐click	on	the	Battery	Validation	Manager	4.x	entry.	

b. The	first	time	the	BVM	software	is	started,	a	dialog	will	appear	asking	if	the	user	wants	to	
add	Locations.		Click	Yes.		The	Location	List	screen	is	displayed	(see	Figure	5	below).	

The Location List Screen 

c. In	the	Location	List	screen	click	the	Add	Locations	from	CD	button,	a	Windows	Explorer	
dialog	opens.			
 Navigate	to	the	Installation	CD	if	necessary.	

d. In	Explorer,	select	the	correct	.bvm	file	using	its	serial	number	and	click	Open.			

The	user	returns	to	the	Location	List	screen	which	is	populated	with	the	selected	file.		Repeat	this	
process	for	each	available	file.		Once	all	site	files	have	been	added,	the	CD	can	be	removed	from	the	
computer,	placed	in	its	sleeve,	and	stored	in	a	safe	location.			

 

 

 If the number of installed S5 units increases, a corresponding .bvm file (provided by 
BTECH) must be added as described above.   

 If the number of installed S5 units decreases, the corresponding .bvm file(s) for the unit(s) 
should be deleted from the Location List screen. 

 

Figure	5‐The	Location	List	screen	with	Windows	Explorer	inset			

	

Installing	the	BVS	Observer	Software	

The	BVS	Observer	software	should	be	installed	anytime	the	S5	will	be	monitored	24/7	by	a	dedicated	
computer	or	server	connected	either	directly,	or	over	a	TCP/IP	network	(see	Installing	BVM	4.x	
Software	on	a	Server,	pg.	112).			



	
S5	Operating	Manual		

	 Installing the Software 

 

Ver.	2.0	(August	2012)			 P a g e 	|	12	

	
 

Adding S5 Locations to Observer  

The	same	locations	added	to	BVM	must	also	be	added	to	Observer.		This	process	is	essentially	
identical	to	the	process	used	for	BVM.		Observer	has	the	same	hardware	and	OS	requirements	as	
BVM.	

Starting Observer and Adding Locations 

Observer	serves	as	data	collector	and	automatically	retrieves	the	latest	measurements	and	alarms	
from	the	S5	controller	on	a	user‐defined	schedule.		It	also	builds	a	battery	performance	database	on	
the	server	or	host	computer.		If	configured	for	it	can	also	distribute	detailed	email	and/or	cell	phone	
alarm	information	text	messages.		

Observer	is	installed	along	with	the	BVM	software	in	the	BVM4	folder	on	the	host	computer.		Like	
BVM,	it	must	be	correctly	configured	for	each	location.		The	first	time	Observer	is	started,	locations	
must	be	added	to	it.		To	start	Observer	use	the	following	procedure.	

a. Navigate	to	the	BVM	folder	on	the	computer’s	hard	drive,	
b. Double‐click	the	Observer	icon		to	start	the	program.		The	Locations.cfg	–	Observer	screen	is	

displayed,	(see	below),	

c. Click	on	the	plus	sign	(+),	or	click	File	and	select	Add	Location(s)	in	the	menu	list.		A	
Windows	Explorer	screen	opens,	

d. Navigate	to	the	location	files	to	be	added	and	select	them,	
 

 

To select multiple locations in the Windows Explorer screen hold down the 
Control key (Ctrl) and click on the individual locations. 

 

e. Click	Open.		The	selected	files	are	added	in	the	Locations.cfg	–	Observer	screen.	
 

Figure	6‐The	Locations.cfg	–	Observer	Screen	with	a	Location	Selected	

	

Activating BVS Observer 

THE	FOLLOWING	STEP	IS	ONLY	REQUIRED	IF	THE	ACTIVATE	BVS	OBSERVER	SOFTWARE	DIALOG		
IS	DISPLAYED	
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If	the	BVS	Observer	software	validation	dialog	is	displayed	as	part	of	the	initial	install	process,		
enter	the	installation	code	printed	on	the	CD	sleeve	(see	below).		This	can	occure	when	10	or	more	
S5s	are	used	in	the	system.	

a. Type	the	16‐character	code	printed	on	the	CD	sleeve	into	the	four	boxes	shown	in	the		
Activation	dialog.		Type	four	characters	in	each	box,	see	below.	

b. Click	OK.	
c. Click	Finish	when	the	successful	installation	window	is	displayed.			

 
 
 

 

The Activation dialog is displayed only when a location has at least ten (10) S5 units 
installed.   

 

Figure	7‐The	Activate	BVS	Observer	software	dialog		

	

The	BVM	Home	Screen	

The	BVM	Home	screen	(see	Figure	8,	pg.	16)	provides	a	summary	of	the	selected	location	as	well	as	
quick	access	to	various	additional	features	such	as	reports,	and	graphs.			

Status Colors  

The	BVM4	Home	screen	is	displayed	when	a	particular	site	is	opened	from	the	Location	List	screen	
and	provides	access	to	a	large	number	of	features.		Strings	and	individual	batteries	are	shown	in	one	
of	three	colors,	based	on	the	latest	set	of	measurements.	

 Green	–	System	is	running	within	set	points	and	is	considered	to	be	healthy.		No	analysis	of	
the	system	is	necessary.	

 Yellow	–	System	is	in	maintenance	status	based	on	predetermined	set	points.		Analysis	of	the	
string	is	recommeded	unless	the	alert	cause	is	alredy	known.	

 Red	–	System	is	in	critical	alarm	status	based	on	predetermined	set	points.		Detailed	analysis	
of	the	indicated	string(s)	should	be	performed	immediately.	
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Quick Measurements 

These	measurements	(sometimes	referred	to	as	“Tool	Tips”)	appear	when	the	cursor	is	placed	on	an	
icon	in	the	Home	screen.			

 

 

More detailed data can be viewed using the options listed under Reports and 
Graphs in the menu bar.  Consult the following Guide sections: 

 7 Reports, beginning on page 80, 
 8 Graphs, beginning on page 97 

 

Home Screen Display Options 

While	the	status	color	coding	is	permanent,	the	user	has	limited	control	over	the	way	battery	system	
architecture	is	displayed.		For	details	on	changing	the	Home	Screen	display	see:	BVM	Home	Screen	
Display	Options,	beginning	on	page	128.	

The Home Screen Menu and Icon Bar 

The	Home	Screen	menu	bar	provides	access	to	a	variety	of	functions	covered	in	this	guide	(see	Figure	
9,	pg.	17).		The	availability	of	items	on	the	Icon	bar	varies	depending	on	Menu/Submenu	selections.		
Available	items	are	displayed	at	full	value.		Unavailable	items	are	displayed	in	shades	of	gray.		See	
next	illustration.	

Basic Individual Battery Measurements 

To	view	basic	measurements	for	a	single	battery	place	the	cursor	over	the	battery’s	numbered	block	
to	display	a	tool	tip	with	the	following	data.	

 Unit	#,	String	#	–	This	identifies	the	specific	battery	by	its	string	and	sequence	within	the	
string.	

 Unit	Voltage	–	Volts	DC.	

 Unit	Impedance	–	in	milOhms.	

 Unit	Temperature	–	Pilot	cell	temperature	in	Fahrenheit	or	Celsius	(user	selectable).	

Individual Battery Measurement Graphs 

Double‐clicking	on	the	battery	icon	displays	a	date	dialog	(see	Figure	80,	page	97).		By	entering	a	
specific	date,	(or	date	range)	a	user	can	graph	the	data.		Within	the	graph	the	user	can	select	Voltage,	
Impedance,	or	Temperature	by	selecting	the	appropriate	icon	in	the	tool	bar.	

 

 

The graphs available from the battery rectangle are also available from the Home 
Screen Graph menu.  For additional information and examples refer to: 

 Graphs, beginning on page 97. 
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Figure	8‐‐An	exploded	illustration	of	the	BVM	Home	screen	
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Figure	9‐The	BVM4	Home	Screen	Menus	

	

Notes:	

Throughout	this	guide	various	procedures	require	the	user	to	navigate	to,	and	select,	certain	menu	
items.		The	above	graphic	displays	most	menu	items	and	sub‐items.			

 The	availability	of	some	menu	items	depends	on	the	specific	function	the	user	is	performing.	

 Reports	and	Graphs	are	described	in	detail	in	sections	7	and	8	respectively.	

 Information	on	the	Help	functionality	is	located	at:	About	This	Guide,	beginning	on	page	3.		
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3.  S5 Start‐Up  
Once	the	S5	controller	has	been	installed	and	the	software	loaded	onto	the	computer,	the	controller	
and	computer	must	be	linked	and	the	locations	configured.		For	new	installations	initial	S5	controller	
location	files	must	be	added	to	the	BVM	software.			

Connecting	a	Computer	to	the	S5	Controller	Via	USB	Cable	

In	order	to	load	the	BVM	software	and	complete	an	initial	S5	configuration	a	host	computer	must	be	
connected	directly	to	the	S5	unit.		To	connect	a	local	computer	to	an	S5,	use	the	BTECH‐provided	USB	
communication	cable.		

a. Plug	the	USB	cable	into	the	port	on	the	S5	front	panel,	and	to	an	available	USB	port	on	the	
computer,	

b. In	the	BVM	menu	bar	click	Communications	and	select	Establish	Local	Communications	with	
Controller	from	the	submenu.		The	Local	Communication	Settings	dialog	is	displayed	(see	
below),	

c. If	the	Comm	Port	list	box	is	not	showing	a	default	entry	(or	if	the	default	is	incorrect)	click	
the	drop‐down	arrow	and	select	the	communications	port	to	be	used	to	connect	to	the	S5,	
 Enter	the	correct	port	number	if	it	does	not	appear	in	the	drop‐down	list.	

d. If	the	Comm	Speed	drop‐down	is	available	select	the	communication	speed	or	accept	the	
default,	

e. Click	OK	to	open	the	communications	port	and	establish	communications	with	the	controller,	
 NOTE:		These	communication	parameters	become	the	defaults	used	by	the	BVM	software	as	

long	as	the	same	USB	port	is	utilized.		

f. Click	OK	in	the	dialog	asking	if	‘all	new	data	should	be	retrieved’.	

The	Communications	screen	is	now	displayed.		It	serves	as	the	base	or	‘core’	location	for	the	
remainder	of	the	configuration	process,	(see	Figure	12,	pg.	22).	

 

Figure	10‐Local	Communications	Settings	dialog	
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Start‐up	for	New	Locations	

The	first	time	that	BVM	is	started	–	and	any	time	a	new	location	is	added	and	configured	–	this	
procedure	should	be	followed.	

a. Connect	the	S5	unit	and	the	computer	using	the	USB	cable	(see	“Connecting	a	Computer	to	
the	S5	Controller	Via	USB	Cable“	beginning	on	page	18),	

b. Turn	the	S5	ON	and	start	the	BVM4	software	by	clicking	the	BVM	icon	 	in	the	start	menu.		
A	location	list	screen	is	displayed,	(see	Figure	11,	below),		
 If	the	BVM	Location	List	screen	is	not	displayed	when	the	software	is	started	–	click	File	in	the	

menu	bar	and	select	Open	in	the	option	list.	

c. Select	the	location	to	configure	in	the	Location	List	screen	and	click	OK.	
 If	the	target	location	is	not	listed	it	must	be	added.		See	“Adding	Locations	to	BVM”,	beginning	

on	page	10.	

The	BVM	home	screen	is	displayed	for	the	selected	location,	(see	Figure	8,	pg.	16).	
 

 

 The serial number of the S5 and the selected site MUST match or errors will 
be generated by the controller. 

 The first time a location is opened the user is given an option to add and 
configure user privileges.  This can be done at this point or any time in the 
future. 
see:  Managing Users, beginning on page 34. 

 

 
For sites with multiple S5s, each unit must be set up individually. 

 

Opening the Communications Screen 

Most	of	the	initial	steps	for	configuring	a	location	are	accessed	from	the	main	communications	
screen.		Use	the	following	procedure.	

a. In	the	Home	screen	menu	bar	click	Communications	and	select	Establish	Local	
Communications	with	Controller,	(see	Figure	9,	pg.	17),	

b. In	the	Communications	dialog:	
 Accept	or	change	the	Comm	Port	and	Comm	Speed	settings	and	click	OK.	

c. The	first	time	a	location	is	opened	an	[BVM]	error	dialog	is	displayed.		This	is	normal.		Click	
OK.	

d. The	main	Communications	screen	is	displayed,	(see	Figure	12‐ 	,	pg.	22).	
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Figure	11‐The	BVM4	Locations	List	Screen	‐		

	

Reviewing the Battery System Configuration 

The	location	file	provided	by	BTECH	with	the	S5	contains	data	on	the	battery	system.		This	procedure	
checks	the	actual	system	configuration	against	the	file	data.	

a. Click	Advanced	in	the	main	Communications	screen	and	click	System	Configuration.		A	

group	of	six	property	sheets	are	displayed,	(see	Figure	12‐ 	,	pg.	22),	
b. In	the	System	Configuration	property	sheet	click	the	Module	Config	button	to	display	the	

Module	Configuration	screen,	(see	Figure	12‐ 	,	pg.	22),			
c. Click	the	Module	Diagnostics	button	to	display	the	Module	Diagnostics	screen,	(see	Figure	

12‐ 	,	pg.	22),	

The	first	time	this	screen	is	opened	it	performs	an	audit	on	the	default	module	(Module	1)	and	
display	results	at	the	bottom	of	the	Units	Assigned	and	Temps	columns.		The	count	for	each	group	
should	be	identical.			

 Units	Assigned	must	equal	Units	Found	

 Temps	must	equal	Temps	[Found]	

d. Click	the	Module	drop‐down	and	select	the	next	module.		Repeat	this	procedure	for	all	
modules	in	the	system.	

 

 

If the totals for any module do NOT match, a problem with the battery 
system hardware connections is present.  Resolve the hardware issue, 
see Equipment Checks and Troubleshooting, beginning on page 67. 

When the problems have been corrected repeat this procedure. 

Re‐learning the Connections 

Once	the	Module	Diagnostic	results	are	correct	the	next	process	is	to	re‐learn	the	connections.		
Proceed	as	follows.	
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a. Navigate	to	the	main	Communications	screen	and	click	Advanced	if	necessary	(see	Figure	12‐
,	pg.	22),		

b. Click	on	System	Configuration	to	display	the	property	sheets,		
c. In	the	System	Configuration	property	sheet	click	the	Clear	Memory	drop‐down	arrow,	(see	

Figure	12‐ ,	pg.	22),	
d. Click	Relearn	Connections	in	the	drop‐down	list	and	click	OK	in	the	Warning	dialog.	

The	Communication	screen	elements	are	all	unavailable	(grayed	out)	for	a	brief	time	period.		When	
the	screen	is	refreshed	the	process	is	complete.		If	the	Communications	screen	indicates	an	error	the	
cause	must	be	corrected	and	this	procedure	repeated.	

Obtaining Preliminary Measurements 

Initial	measurements	are	obtained	using	the	following	procedure.	

a. Navigate	to	the	main	Communications	screen	and	click	Advanced	if	necessary	(see	Figure	12‐
,	pg.	22),	

b. Click	Perform	Measurements	to	capture	battery	data	to	the	controller,	(see	Figure	12‐ ,	
pg.	22),	
 The	screen	controls	will	become	inactive	for	a	period	of	time	until	“Measurement	Complete”	

appears	in	the	status	line.	

c. Click	the	Retrieve	Data	drop‐down	arrow	and	select	Retrieve	All	in	the	list.		The	data	has	
now	been	updated	to	the	computer,	(see	Figure	12‐ ,	pg.	22).	
 Click	OK	if	a	dialog	is	displayed.	

 

 

For	a	large,	multi‐string	site,	measurements	can	take	up	to	approximately	2	
hours	–	during	which	the	controller	is	unavailable.	
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Figure	12:		Configuration	Procedure	Screen	Flow	

	

Verify the Measurement Data 

Impedance	(together	with	voltage	and	temperature)	start‐up	data	is	verified	through	the	“Graphs”	
function.	

a. In	the	Home	screen	menu	bar	click	on	Graphs	and	select	Snapshot	of	Unit	Measurements,	(see	
Figure	9,	pg.	17),		
 see	Unit	Snapshot	Graph,	beginning	on	page	100	for	a	description	of	the	graph	data.	

b. Select	the	current	date	in	the	date	dialog,	
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When	the	graph	is	displayed	the	default	measurement	is	‘Voltage”.		Click	the	Impedance	symbol	in	

the	icon	bar,	 ,	(see	Figure	8,	pg.	16).	

 It	is	advisable	to	also	check	voltage	and	temperature	data	by	clicking	their	respective	icons.	

 Pressing	F10	will	cycle	through	the	available	graphs.	
 

 
If the data indicates a problem, resolve the issue(s) before continuing.   

Impedance	Multipliers	

Obtaining Baseline Impedance Values 

Certain	parameters	must	be	set	once	the	computer	and	the	S5	controller	are	communicating.		This	is	
done	from	various	functions	contained	in	the	primary	Communications	screen.		Utilizing	this	screen	
the	user	can	acquire	a	base	set	of	measurements	from	the	S5,	save	them	to	the	S5’s	location	file,	and	
store	them	in	the	controller	memory.	

Impedance	Multipliers	compensate	for	the	output	impedance	of	the	battery	charger,	the	impedances	
of	other	parallel	strings	of	cells,	and	also	DC	bus	wiring	and	switching.		They	can	be	set	for	systems	
requiring	the	impedance	measurements	to	have	absolute	accuracy	(as	contrasted	with	relative	
accuracy).		Multipliers	exist	for	both	the	positive	and	negative	half	of	each	string.		Multipliers	are	set	
using	the	automated	function.	

 

 

Setting Impedance Multipliers automatically can be done when – and 
only when –  

   There are an equal number of batteries in the positive and negative halves 
of the string, 

In ALL other situations impedance multipliers must be set manually.  
Before attempting to set multipliers manually, customers should contact 
the BTECH Technical Support department for assistance. 

Setting Impedance Multipliers Automatically 

a. Navigate	to	the	main	Communications	screen	and	click	Advanced	if	necessary	(see	Figure	12‐
,	pg.	22),	
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Figure	13‐Impedance	Multipliers	Populated	Automatically	

	

b. Click	System	Configuration.		The	System	Configuration	properties	tab	screen	is	displayed,	
(see	Figure	12‐ ,	pg.	22),	

c. Click	the	Impedance	Multipliers	property	tab.		The	properties	are	displayed,	(see	above),			
d. Click	Auto	Multiplier	Set	Up.		BVM	begins	capturing	impedance	data	from	each	unit,	
 The	new	data	populates	the	screen	fields.	

e. In	the	Choose	Units	dialog	select	the	Positive	and	Negative	half	units,	(see	below).	
 BTECH	recommends	NOT	using	the	first	or	last	unit	in	this	procedure.	

Figure	14‐	The	Choose	Units	dialog	

	
 

 

It takes about 15 seconds per unit to acquire each reading.  Depending on the 
overall size of the installation it may take several minutes to complete the 
process. 
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Setting Impedance Multipliers Manually 

Setting Impedance Multipliers Manually 

This	option	is	generally	used	only	when	the	number	of	units	in	the	positive	and	negative	parts	of	the	
string	are	unequal.		BTECH	strongly	advises	that	customers	consult	with	the	Technical	Support	
department	prior	to	making	any	manual	impedance	changes.	

 

Obtain a New Set of Base Measurements 

Once	the	Impedance	Multipliers	have	been	set,	new,	post‐Impedance	multiplier	values	must	be	
obtained.	

 Repeat	“Obtaining	Preliminary	Measurements”,	page	21.			
 

 
Generally it is not necessary to repeat the data verification procedure. 

Copy Initial Impedance Values to BVM Software Settings 

The	new	data	obtained	in	this	procedure	is	used	for	trend	analysis	as	well	as	any	user‐requested	
reports	or	graphs.	

a. Navigate	to	the	main	Communications	screen	and	click	Advanced	if	necessary	(see	Figure	12‐
,	pg.	22),	

b. Click	the	Initial	Impedance	drop‐down	arrow,	
c. Select	“Retrieve	Initial	Impedance	Measurements	from	Controller	and	Save	to	BVM	Software	

Unit	Settings”,	(Figure	12‐ ,	pg.	22)	
d. Select	the	date	of	the	measurements	and	click	Yes	in	the	confirmation	dialog,	
e. Click	OK.			

The	unit’s	initial	impedance	measurements	in	the	BVM	software	settings	have	now	been	replaced	
with	the	data	from	the	selected	date.			

Load Initial Impedance Values to the S5 Controller 

The	new	data	obtained	in	this	procedure	is	used	for	trend	analysis	as	well	as	any	user‐requested	
reports	or	graphs.	

a. Navigate	to	the	main	Communications	screen	and	click	Advanced	to	display	the	options	
contained	in	the	screen	extension,	(see	Figure	12‐ ,	pg.	22)	

b. Click	the	Initial	Impedance	drop‐down	arrow,	
c. Select	“Load	Initial	Impedance	Measurements	to	the	Controller	from	the	BVM	Software,”	
d. Click	Yes	in	the	confirmation	dialog,	
e. Click	OK.	
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The	unit’s	initial	impedance	measurements	in	the	controller	have	now	been	replaced	with	the	data	
from	the	selected	date.			

Changing	Software	Setting		

Units Properties 

Once	the	new	impedance	values	have	been	added	to	the	controller	and	to	BVM,	some	software	
configuration	changes	must	be	made.	

a. In	the	Home	screen	menu	bar	click	Settings,	and	select	Software	Settings.		A	group	of	tabbed	
property	sheets	are	displayed,	(see	Figure	8,	pg.	16),	

b. Click	the	Units	Properties	sheet,			
c. In	“Impedance”	(mid	section	of	the	screen)	click	the	Analysis	Method	drop‐down	arrow	and	

select	Initial	from	the	list,	(see	below),	
d. Click	OK	to	change	the	setting.	

Changing Controller Settings Properties 

a. Navigate	to	the	main	Communications	screen	and	click	Advanced	to	display	the	options	
contained	in	the	screen	extension,	(see	Figure	12‐ ,	pg.	22),	

b. Click	Controller	Settings.		A	group	of	tabbed	property	sheets	is	displayed,	

c. Select	the	Unit	Limits	sheet,	(see	Figure	15‐ 		below),	
d. Click	the	Analysis	Method	drop‐down	and	select	“Initial”,	
e. Click	OK	to	change	the	setting.	

Adding Setup Notes 

BTECH	strongly	advises	that	setup	notes	be	added	to	BVM	once	the	setup	procedures	are	complete.		
This	is	accomplished	using	the	following	procedure.	

a. Navigate	to	the	BVM	home	page	(see	Figure	12,	pg.	16),	
b. Click	the	Measurement	Listings	button	at	the	bottom	of	the	left	panel.		The	Measurement	sheet	

is	displayed,	(see	Figure	60,	pg.	83),	
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Figure	15‐	Unit	Settings	Property	Sheet	

	
 

c. Select	the	record	for	the	current	date	(usually	at	the	list	bottom).		
d. Right	click	and	select	“Edit	Measurement	Note”,	from	the	context	menu,	
 Click	OK	in	the	Select	Measurement	dialog.	

e. In	the	Note	dialog	enter	a	brief	commentary	including	the	site	location	and	technicial	ID.		
Click	OK	when	finished.	
 Enter	“This	data	used	for	initial	impedance”.	

 Notes	can	be	edited	at	any	time	however	the	user	is	limited	to	the	column	space	in	the	
Measurement	sheet.	

Identifying Problems 

If	the	S5	system	indicates	an	alarm	or	alert	use	the	following	procedure	to	identify	the	cause.			

Navigate	to	the	BVM	Home	screen	and	click	Measurement	Listings	at	the	bottom	of	the	left	panel,	
(see	Figure	8,	pg.	16).	

a. In	the	Measurement	Listing’s	three‐tab	sheet	screen	select	Alarms	and	Alerts,	page	3,	(see	
Error!	Reference	source	not	found.,	pg.	29).	

b. Identify	any	Alarm/Alert	messages	for	the	date	and	time	that	the	startup	process	was	begun.	
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The	Alarm	and	Alerts	column	message(s)	indicate	the	source	problem(s)	that	must	be	corrected.		
Once	all	problems	have	been	resolved,	clear	the	alarm	state	as	described	below	and	continue	with	
the	startup.	

Acknowledging Alarms and Alerts  

Once	the	hardware/software	problem(s)	is	corrected	use	the	following	procedure	to	acknowledge	
the	record	in	the	Alarms/Alerts	column	(see	Error!	Reference	source	not	found.,	below).		The	
Alarm/Alert	message	(and	the	acknowledgement)	will	remain	as	part	of	the	log.			

a. Navigate	to	the	Communications	screen	and	click	the	Retrieve	Data	drop‐down,			
b. Select	Retrieve	Alarms	and	Alerts	from	the	drop‐down	list.		This	copies	the	alarm	data	to	the	

BVM	software,	
c. Navigate	to	the	BVM	Home	screen	and	click	Measurement	Listings	at	the	bottom	of	the	left	

panel,		
d. In	the	Measurement	Listing’s	three‐page	screen	select	Alarms	and	Alerts	–	page	3,		
e. Select	the	alarm	or	alert	to	be	acknowledged,		
 NOTE:			Multiple	Alarms/Alerts	can	be	selected	by	holding	down	the	Ctrl	key	while	selecting	

individual	entries.	

f. Right‐click	to	display	a	popup	menu	and	select	Acknowledge	Alarm(s).		Click	OK	in	the	
confirmation	dialog,			
 BVM	populates	the	“Acknowledged”	and	“By	User”	columns	for	the	selected	entry(ies)	with	

user	data,	and	clears	the	alarm.			

g. Close	the	Alerts	and	Alarms	page	by	clicking	the	red	“X”	in	the	corner	and	navigate	back	to	the	
Communications	screen.			

Setting Read Date/Time  

At	start‐up	the	S5	needs	to	have	the	current	date	and	time	set	so	that	it	can	accurately	label	events	
and	perform	certain	scheduled	tasks	correctly.		Use	the	following	procedure.	

a. Navigate	to	the	Communications	screen	(see	Figure	31,	pg.	48),	
 NOTE:		expand	the	screen	by	clicking	the	Advanced	button	if	necessary.	

 

b. Click	Check	Time.		The	screen’s	Status	line	displays	the	time	the	S5	currently	has	in	its	
memory.	
 If	the	S5	time	and	the	host	computer	time	differ,	a	dialog	suggesting	that	the	date/times	be	

synchronized	is	displayed.		Click	OK.		
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Figure	16‐	The	Alerts	and	Alarms	page	with	popup	menu	inserted.	

	

Scheduling Periodic Measurement Readings 

Measurements	can	be	downloaded	to	the	S5’s	controller	on	a	user‐entered	schedule.		This	usually	
provides	the	most	consistent	data	set	for	trending	and	other	purposes.		Manual	readings	can	still	be	
taken	if	necessary.			

a. Navigate	to	the	Controller	Measurement	Setup	tab,	
b. Enter	the	date‐time	information	using	the	spinbox	located	in	the	in	the	Measurement	Interval	

block,	
 The	Date	and	Time	entries	in	the	Next	Measurement	block	(re‐)	adjust	automatically.	

c. In	the	Measurement	Freq[uency]	drop‐down	list,	select	the	appropriate	frequency.	

The	measurements	will	occur	automatically	on	the	schedule	entered.		Schedules	can	be	revised	as	
necessary.	

Alarm Output Relays 

The	alarm	output	relays	connect	the	S5	to	a	building	management	system.		As	shown	below	up	to	six	
output	relays	can	be	connected.	

	

Figure	17‐Scheduling	Controller	Measurements	Automatically	
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 The S5 Controller stores a maximum of 5 readings.  As new readings are added 
the oldest ones are deleted. 

 BTECH recommends setting the measurement interval at seven to 30 days. 
 

All	six	relays	are	Com,	ND/NC.		Three	terminals	(COM‐ND‐NC)	for	each	relay	are	present	in	the	(2)	6‐
pin	plugs	(see	diagram	below).	

Figure	18‐Alarm	Output	Relays	

	
 

Wire Connections 

 ALARM	#1	=	1‐3	CLOSURE	=	ALARM;	1‐2	OPEN	=	ALARM	

 ALARM	#2	=	4‐6	CLOSURE	=	ALARM;	4‐5	OPEN	=	ALARM	

 ALARM	#3	=	7‐9	CLOSURE	=	ALARM;	7‐8	OPEN	=	ALARM	

 ALARM	#4	=	10‐12	CLOSURE	=	ALARM;	10‐11	OPEN	=	ALARM	

 ALARM	#5	=	13‐15	CLOSURE	=	ALARM;	13‐14	OPEN	=	ALARM	

ALARM #6 = 16‐18 CLOSURE = ALARM; 16‐17 OPEN = ALARM	

 

Relay outputs are in the specified condition when the S5 is in normal 
operating mode and no programmed alarms are present.  If the S5 is 
unpowered all relays will change state and alarms are activated. 
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4.   Configuring the BVM and BVS Software 

The	site	files	added	to	the	BVM	system	have	been	configured	at	the	factory	according	to	the	
battery	manufacturer’s	specifications.		A	few	items	(e.g.	time	zones,	temperature	scale)	
must	be	set	locally.		Any	of	the	software’s	settings	can	be	modified	as	necessary	although	
this	should	only	be	done	when	absolutely	necessary.	

Settings	are	checked	and	changed	from	the	BVM	menu	bar	displayed	in	the	Home	screen	
(see	Figure	9,	page	17).		Some	settings	are	specific	to	each	site	and	consequently	this	
procedure	must	be	performed	each	time	a	site	(a	new	S5	unit)	is	added.		Certain	site‐specific	
measurements	(e.g.	Impedance)	must	be	recorded	from	the	battery	installation	and	loaded	
into	the	host	computer.	

 

Figure	19‐	Settings	Menu	Map	

	

Downloading	and	Copying	Local	Measurements	

Unlocking a Location File 

When	the	BVM opens	a	location	file,	it	locks	the	file	to	prevent	another	BVM	from	making	
any	changes	to	the	settings	(not	the	data).		If	a	location	file	remains	locked,	this	command	is	
available	to	unlock	the	location	file	manually.		Before	doing	so,	make	sure	the	location	file	is	
not	being	used	by	anyone	else.	

a. Select	the	location	to	be	unlocked,	
b. Click	File‐Unlock	to	unlock	the	location.	
 If	the	‘Unlock’	submenu	option	is	grayed	out,	the	location	file	is	not	locked.	

Data Merge Functions  

This	menu	command	merges	data	from	a	selected	location	file	into	the	currently	open	
location.		After	selecting	this	command,	a	Windows	Explorer	File	Open	dialog	box	appears	
where	the	user	can	select	the	source	location	file.		Once	the	file	is	selected,	the	location	is	
opened	and	various	criteria	are	checked	to	ensure	that	the	data	being	merged	is	from	the	
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same	location.		The	location	number	and	number	of	units	in	the	source	location	file	must	
match	those	in	the	currently	open	location.		If	there	is	a	difference	in	the	number	of	strings,	
the	user	is	notified.		The	user	then	chooses	the	date	range	and	the	type	of	data	to	merge.	

The	merge	process	begins	after	the	user	clicks	Start.		A	status	bar	shows	the	progress	of	the	
merge	operation	which	can	take	some	length	of	time.	

 

Figure	20‐File	Menu:		Merge	Data	sub‐menu	dialog	

	
 

Table	1. Merge	Data	Screen	Content	

Entry Name  Description 

Date Range 

Begin/End	 Use	the	drop‐down	box	to	select	the	beginning	and	ending	dates	of	the	data	
merge	procedure.	

Merge	Initial	
Imp[edance]	

Takes	baseline	unit	impedance	values	and	merges	them	into	a	new	file.	

Merge	Interconnect	
Imp[edance]	

Takes	long	interconnect	values	and	merges	them	into	a	new	file.	

Merge	Battery	Layout	 Represented	by	the	battery	map	in	the	Home	page.	
Merge	Temp	Sensor	
Mapping	

Assigns	pilot	cell	temperature	units	in	software.	

Merge	Measurements	 Merges	measurement	data	from	the	user‐selected	date	range	to	the	currently	
open	location	file.	

Merge	Discharge	Data	 Merges	discharge	data	from	the	user‐selected	date	range	to	the	currently	
open	location	file.	

Merge	Alarms	and	
Alerts	

Merges	alarm	and	alert	data	from	the	user‐selected	date	range	to	the	
currently	open	location	file.	

Exchange Unit Data  

This	is	used	to	exchange	the	measurement	data	of	two	units	and	is	useful	in	situations	
where	two	or	more	units	in	the	battery	system	are	physically	swapped	during	maintenance.		
Typically	this	date	range	would	be	the	entire	time	the	battery	system	was	monitored	before	
the	swap	took	place	and	must	be	selected	first.		The	string	and	unit	of	the	two	units	to	be	
swapped	must	be	selected	and	the	OK	button	clicked.	
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After	the	user	confirms	the	swap	in	a	dialog,	the	swap	operation	continues	to	completion	
and	the	data	is	swapped.		Note:	this	operation	may	take	some	time	to	complete.	

 

 
Once	the	process	begins	it	cannot	be	stopped	and	the	results	cannot	be	reversed.	

 

Figure	21‐File	Menu:	Exchange	Unit	Data	Dialog	menu	option	

	

Exporting Data 

The	Export	Data	selection	in	the	File	menu	allows	the	user	to	export	all	archived	data	in	a	
selected	date	range	to	a	comma‐delimited	text	file.		This	file	can	then	be	imported	into	
spreadsheets,	databases,	and	other	software.		The	following	options	are	available.	

a. Click	the	Begin	and	End	Dates‐	select	the	beginning	and	ending	dates	for	the	source	
data	from	the	drop‐down	date	lists,	

b. Change	Path	–	accept	the	default	location	or	select	the	path	to	a	new	location	where	
the	data	will	be	exported,	

c. Click	Start.	
 

Figure	22‐File	menu:	Export	Data	Dialog	
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Managing Users 

User	management	is	done	from	the	Manage	Users	option	of	the	File	menu.		This	option	
enables	the	system	manager	to	add,	remove,	or	change	user	profiles.		By	default,	there	are	
no	users	listed	in	the	software	so	changes	can	be	made	to	the	location	file	by	anyone	
accessing	it.		Once	a	user	is	added,	anyone	opening	the	location	file	will	be	prompted	for	a	
user	name	and	password.	

 

 

BTECH recommends that customer employ strong security measures and 
user management policies to protect any location information, 
measurement data, analysis or notification messages that are deemed 
sensitive or proprietary.  This is especially important if data I s sent over 
public networks. 

 

There	are	three	permission	levels:		

 Technicians	are	limited	to	viewing	data,		

 Supervisors	have	access	to	everything	except	for	the	Manage	Users	function,	

 Administrators	have	no	limitations	on	what	they	can	do,		

To	add,	remove,	or	modify	a	user	do	the	following	(see	Figure	23,	below):	

a. In	the	File	submenu	select	Manage	Users.		The	Manage	Users	screen	is	displayed.	

To add a user – 

b. Click	Add	User	.	.	.		The	Add	User	screen	is	displayed.	
c. Complete	the	required	entries	and	click	OK.	

To change a user’s privileges or remove a user – 

d. Open	the	Manage	Users	screen	as	described	above,	
e. Select	the	user	to	be	removed	or	modified	by	clicking	on	their	entry	and	do	one	of	

the	following:	
 To	remove	a	user	click	Remove	or,	

 To	modify	a	user	click	Modify	User.		The	User	screen	(identical	to	the	Add	User	
screen)	is	displayed.		Make	any	necessary	changes	and	click	OK.	

The	changes	are	effective	immediately.	
 

 

Exercise caution when removing a user.  There is no confirmation dialog after the 
Remove button is clicked and no ‘un‐do’ function is available. 
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Figure	23‐	Manage	Users/Add	Users	dialogs	

	

The Preferences Menu Option 

The	BVM Preferences	screen	is	used	to	configure	settings	which	apply	to	all	locations.		
These	settings	are	also	used	by	the	BVS	software,	(see	above).	

a. In	the	BVM	menu	bar	click	Settings,	and	select	Preferences	from	the	drop‐down	list,	
b. Enter,	or	change	any	of	the	available	fields,	radio	buttons,	or	checkboxes	and		

click	OK.			

Changes	become	effective	immediately.	
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Figure	24‐The	[Software]	Preferences	Menu	Option	

	
 

Table	2. Preferences	Menu	Entries	

Entry Name  Description 

Temp.	Units	 Select	either	Fahrenheit	or	Celsius	for	use	when	reporting	
temperature	information.	

Display Time 

Display	Time	 Select	either	Universal	Time,	local	time,	or	a	time	zone	for	use	when	
displaying	time.	The	local	time	is	determined	by	Window's	Time	
Zone	selection.	

SQL	Server	
NOTE:		SQL	entries	are	only	used	when	an	SQL	server	is	used	to	create	and	maintain	the	BVM	
database(s).		See:	Installing	BVM	4.x	Software	on	a	Server	beginning	on	page	112	for	
additional	information.	
Prompt	to	create	
Locations	.	.	.		

When	this	is	selected,	the	user	is	prompted	whether	to	store	the	
new	location’s	settings	and	data	in	an	SQL	Server	database.			

Defaults	for	new	
Locations	

The	SQL	Server	instance	is	where	new	locations	are	created	or	
added.	Click	the	button	to	view	a	list	of	all	the	available	SQL	Servers.		

SQL	server	TCP	port		 The	default	TCP	port	to	use	when	creating	or	adding	new	locations.		
The	default	value	is:	1433.	

User	SQL	Server	
Authentication	

Not	available	in	the	preferences	menu.		A	new	SQL	User	name	and	
Password	should	be	entered	when	the	SQL	server	is	installed	and	
set	up.	
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Entry Name  Description 

Username		 Not	available	in	the	preferences	menu.		Entered	during	SQL	setup.	
Password	 Not	available	in	the	preferences	menu.		Entered	during	SQL	setup.	
Password	Con.	 Not	available	in	the	preferences	menu.		Entered	during	SQL	setup.	
Prompt	the	user	.	.	.	 When	enabled,	the	software	scans	through	its	‘saved	measurements’	

to	detect	any	units	that	may	have	been	replaced.		If	it	finds	any,	it	
prompts	the	user	for	confirmation.		Following	a	confirmation,	it	sets	
the	installation	date	and	initial	impedance.	

Show	Full	Location	.	.	.	 Displays	the	full	path	of	the	location	file	in	the	title	bar.	
Automatically		
check	.	.	.	

When	enabled,	the	software	checks	BTECH's	website	for	new	or	
updated	software.			
NOTE:		to	download	the	new	software,	a	software	maintenance	
subscription	with	BTECH	is	required	(one	year	is	included	free	with	
the	purchased	of	the	software).	

Software	Settings	Menu	Option	

The	Settings	menu	option	displays	a	set	of	five	property	sheets	described	in	this	section.	

The Location Settings Property Sheet 

This	property	sheet	is	used	to	capture	basic	descriptive	information	for	the	associated	BVS.		
The	Location	settings	tab	is	completed	as	described	below:	

a. In	the	BVM	menu	bar	click	Settings,	and	select	Location	Settings	from	the	drop‐
down	list,	

b. Enter	or	change	any	of	the	available	fields,	radio	buttons,	or	checkboxes,	
c. Click	Apply.		

The	entries	become	effective	immediately.	

Table	3. Location	Settings	Property	Sheet	field	descriptions	

Entry Name  Description 

Location	ID	 This	entry	is	used	to	identify	each	controller.		This	is	especially	important	
when	there	are	multiple	monitors.	
NOTE:		Information	is	supplied	by	BTECH	and	should	NOT	be	changed.	

Serial	Number	 The	System	Controller	Module	serial	number	found	on	the	side	of	the	
controller.	
NOTE:		Information	is	supplied	by	BTECH	and	should	NOT	be	changed.	

Model	 Chose	the	model	of	the	BVS	from	the	drop‐down	list.		For	an	S5	system	with	
multiple	strings,	utilizing	isolated	charges,	choose	the	"S5	w/Isolated	
Chargers."	option.	
NOTE:		Information	is	supplied	by	BTECH	and	should	NOT	be	changed.	

Name	 A	name	identifying	the	BVS	and	the	battery	string	being	monitored.	
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Figure	25‐Location	Settings	Property	Sheet	of	the	Settings	Menu	

	
 

Entry Name  Description 

Address	1‐2	 The	first	line	of	the	address	where	the	system	is	installed.	
Description	1‐2	 A	place	to	enter	any	descriptive	text	used	to	identify	the	system.	
Type	of	System	 The	type	of	system	the	BVS	is	monitoring	e.g.	UPS	or	telecommunications.	
Type	of	Batteries	 The	type	and	model	of	jars	the	BVS	is	monitoring	e.g.	VLRA,	Flooded,	NiCad.	
Contact	Info	 The	contact	information	for	the	person	responsible	for	the	battery	system	at	

the	install	location.	
Note	1‐2	 Used	to	enter	any	additional	information	that	would	help	manage	the	battery	

system.	
 

The System Settings Property Sheet 

System	Settings	contain	essential	parameters	used	by	the	software.		When	setting	up	a	new	
location	the	software	automatically	creates	default	values	for	the	remaining	fields	when	
enough	data	has	been	entered	into	the	first	fields.		The	default	values	can	be	changed	as	
necessary.			

To	complete	the	System	Settings	property	sheet	proceed	as	follows:		

a. In	the	BVM	menu	bar	click	Settings	and	select	the	System	Settings	from	the	drop‐
down	list,	

b. Select	the	Systems	Settings	Property	sheet	in	the	resulting	tabbed	screen,	
c. Enter,	or	change	any	of	the	available	fields,	radio	buttons	or	checkboxes	and	click	

Apply.	

The	entries	become	effective	immediately.	
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Figure	26‐System	Settings	Property	Sheet	

	
 

Table	4. System	Settings	Property	Sheet	field	descriptions	

Entry Name  Description 

Battery Configuration 

Units	per	String	 Enter	the	number	of	units	per	battery	string,	i.e.	the	total	number	of	units	
(cells	or	jars)	per	string	that	the	BVS	is	measuring.		A	unit	can	be	an	
individual	cell,	a	jar	consisting	of	multiple	cells,	or	multiple	jars.			
NOTE:		The	number	of	units	is	NOT	equal	to	the	number	of	leads	connected	
to	the	BVS.		

Number	of	Strings	 The	number	of	strings	MUST	range	from	1	to	8	–	the	maximum	for	a	single	
S5	unit.	

Units	per	Pos	
String	Half	

The	number	of	individual	batteries	in	the	first	(positive)	side	of	a	string.		If	
there	are	12	batteries	in	a	string,	units	1‐6	are	in	the	positive	half.	

Positive	to	
Negative	Unit	
Numbering	

This	checkbox	indicates	the	battery	unit	numbering	runs	from	positive	to	
negative,	(for	telecommunications	battery	systems,	the	unit	numbering	
may	be	negative	to	positive).	For	the	S5	controller	clicking	this	checkbox	
changes	the	numbering.	
NOTE:		see	BVM	Home	Screen	Display	Options,	pg.	128	for	additional	
information.	

System Voltage Measurements 

Max	Charge	
Voltage	

The	maximum	and	minimum	system	float	voltage	limits	should	be	set	to	
the	battery	manufacturer's	recommended	specification.			
NOTE:		BTECH	sets	these	values	to	manufacturer’s	specifications	and	
recommends	keeping	them	at	the	factory	values.			

Loaded	Voltage	 The	minimum	voltage	the	UPS	or	other	load	requires	during	a	discharge.		
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Entry Name  Description 

Limit	 This	value	is	shown	on	the	System	Discharge	Voltage	Graph	by	a	dashed	
line.	

Min	Charge	
Voltage	

see	Max	Charge	Voltage.	

Graph	Scale	Max	 Determines	the	ordinate	range	of	the	temperature	graph.	
Enable	
Temperature	
Compensated	
Limits	

The	voltage	limits	are	adjusted	based	on	the	measured	temperature.	

Graph	Scale	Float	
Min	

These	values	determine	the	ordinate	values	for	the	battery	voltage	graphs.		
Values	are	used	that	clearly	show	the	changes	that	take	place.			

Graph	Scale	
Discharge	Min	

These	values	determine	the	ordinate	values	for	the	battery	voltage	
discharge	graphs.		Use	values	that	clearly	show	the	changes	that	take	place	
–	including	load	periods.			

Current Measurements 

Current	Measured	 Choose	whether	current	is	being	measured	and,	if	so,	whether	on	a	system	
wide	or	individual	string	basis.	

Current	Charge	
Graph	Max	

This	value	is	the	maximum	scale	value	on	the	Charge	Current	graphs.	

Discharge	Current	
Graph	Max	

This	value	is	the	maximum	scale	value	on	the	Discharge	Current	graphs.	

Charge	Current	
Limit	

This	value	is	the	upper	charge	current	limit.			

Discharge	Current	
Limit	

This	value	is	the	upper	discharge	current	occurring	during	a	discharge.			

Temperature Measurements 

Maximum	Temp	
Limit	

Specifies	the	highest	temperature	measurement.			

Temp	Graph	Scale	
Max	

Specifies	the	maximum	numeric	value	to	be	displayed	in	any	temperature	
graph	generated	by	the	BVM4	software.	

Minimum	Temp	
Limit	

The	lower	temperature	limit	for	all	temperatures.	

The Unit Settings Property Sheet 

Unit	Settings	contain	essential	parameters	that	are	used	by	the	software.		If	a	new	location	is	
being	set	up,	the	software	automatically	creates	default	values	for	the	remaining	fields	when	
enough	data	has	been	entered	in	the	first	fields.		The	default	values	can	be	changed	at	the	
discretion	of	the	user.			

Every	unit	(cell	or	jar)	is	capable	of	having	a	unique	array	of	unit	settings,	i.e.	this	sheet	can	
be	used	to	enter	settings	for	all	strings	or	for	just	selected	strings.		This	tab	is	the	interface	
for	entering	and	modifying	these	settings.		On	the	left	of	the	sheet	is	a	list	of	all	the	units	in	
the	system	with	the	entry	of	All	Units	at	the	top	which	is	selected	by	default.		If	All	Units	is	
selected,	the	value	shown	in	a	field	is	the	value	for	all	the	units.			

When	all	units	do	not	have	the	same	value	for	a	particular	setting,	the	field	will	be	blank.		By	
selecting	individual	units	or	groups	of	units,	each	can	be	assigned	unique	settings.		
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Normally,	most	settings	are	identical	for	all	units.		The	Initial	Impedance	and	Interconnect	
Impedance	are	exceptions	and	usually	have	different	values.	

To	complete	the	Unit	Settings	property	sheet	(see	Figure	27	below)	proceed	as	follows:		

a. In	the	BVM	Home	screen	menu	bar	click	Settings,	and	select	Software	Settings	from	
the	drop‐down	list,	(see	Figure	9,	pg.	17),	

b. Select	the	Unit	Settings	tab,	
c. In	the	left	side	panel	select	the	unit	that	is	to	have	its	settings	changed,	
d. Enter	or	change	any	of	the	available	fields,	radio	buttons	or	checkboxes	and	click	

Apply.		

The	entries	become	effective	immediately.	
 

 

Although very typical – not all installations include temperature sensors in the 
system. 

 

Figure	27‐Unit	Settings	Property	Sheet	

	
 

Table	5. Unit	Settings	Property	Sheet	Field	Descriptions	

Entry	Name	 Description	

Voltage	
Min.	and	Max	
Maint.	Limit	

Set	the	unit’s	maximum	and	minimum	voltage	limits	to	indicate	units	
outside	of	the	manufacturer’s	recommended	range.		These	limits	are	
shown	on	the	unit	voltage	graphs.			

Discharge	Maint.	
Limit	

The	discharge	voltage	limits	are	the	minimum	voltages	a	unit	is	allowed	
to	reach	during	a	discharge.		These	values	are	shown	on	the	unit	voltage	
graphs	for	discharge.	
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Entry	Name	 Description	

Discharge	Critical	
Limit	

The	discharge	voltage	limits	are	the	minimum	voltages	a	unit	is	allowed	
to	reach	during	a	discharge.	These	values	are	shown		on	the	unit	voltage	
graphs	for	discharge.	

Min.	and	Max.	
Critical	Limit	

Set	the	unit's	maximum	and	minimum	critical	unit	voltage	limits	so	that	
any	voltage	outside	of	them	indicates	a	critical	problem.	These	limits	are	
shown	on	the	unit	voltage	graphs.	

Max.	Graph	Scale	 The	unit	voltage	graph	maximum	and	minimum	values	determine	the	
ordinate	range	of	units	on	voltage	graphs.	

Float	Min.	and	Max.	
Graph	Scale	

Set	these	values	to	most	clearly	display	the	range	of	impedance	on	the	
unit	impedance	graphs.		The	values	are	in	milliohms.	

Enable	
Temperature	.	.	.	

Check	this	box	to	adjust	the	voltage	limits	based	on	temperature.	

Impedance	
Maint.	Percent	
Limit	

This	entry	determines	the	point	where	increased	unit	impedance	
indicates	a	potential	problem.		The	value	is	the	percent	increase	of	an	
impedance	measurement	above	the	average	or	initial	impedance	reading.	
	
Units	with	impedance	values	above	the	alarm	limit	should	be	
investigated	further.		This	limit	is	shown	as	a	box	on	the	impedance	
graphs	and	is	also	used	to	identify	units	in	the	various	unit	reports.	

Min.	and	Max.	
Graph	Scale	

The	unit	voltage	graph	maximum	and	minimum	values	determine	the	
ordinate	range	of	the	vertical	(y‐axis)	on	unit	voltage	graphs.	

Percent	Limit	
Critical	

This	entry	has	the	same	function	as	the	Maintenance	Percent	Limit	but	
should	be	set	to	a	higher	value	to	indicate	more	severe	problems.		Units	
with	impedance	values	above	the	critical	alarm	limit	should	be	
investigated	immediately.		These	units	appear	in	the	various	unit	reports	
in	boldface	type	and	as	a	box	on	the	impedance	graphs.	

Analysis	Method	
Drop‐down	List	

Select	one	of	the	two	available	types	of	impedance	analysis	methods	by	
clicking	the	drop‐down	arrow	and	pick	one	of	the	two	options.	
Average	method:		compares	each	unit	to	the	average	string	impedance	
and	sets	the	Maintenance	and	Critical	Percent	alarm	limits	to	the	
percentages	above	the	average	impedance.		If	the	temperature	of	the	
battery	room	is	relatively	constant	(+/‐	5°	Fahrenheit,	+/‐	3°	Celsius),	
this	method	should	be	used.	
Initial	method:		compares	each	unit	to	its	own	initial	reading	and	sets	the	
Maintenance	and	Critical	Percent	alarm	limits	to	the	percentages	above	
this	initial	impedance	reading.		If	the	battery	room	is	not	temperature‐
controlled	this	method	should	be	used.	
Preferably,	this	initial	impedance	reading	should	be	taken	shortly	after	
the	battery	is	first	installed,	or	alternatively	when	the	monitor	is	
installed.	The	main	criterion	to	consider	in	choosing	the	impedance	
analysis	method	is	the	thermal	environment	of	the	battery	room.			
If	the	Initial	method	is	chosen,	the	initial	impedance	readings	will	have	to	
be	established	in	the	BVS	and	the	software	settings.	

Initial	Impedance		 The	initial	impedance	value	the	software	uses	when	the	Analysis	Method	
is	set	to	“Initial”.	

Interconnect	
Impedance		

The	value	used	to	adjust	individual	unit	impedance	readings	where	there	
are	different	length	interconnects	used	on	the	rest	of	the	battery,	(e.g.	a	
long	interconnect	that	cannot	be	compensated	for	by	another	voltage	sense	
lead,	or	the	absence	of	a	short	interconnect	on	the	last	jar	of	a	string.)		
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Entry	Name	 Description	

	
A	positive	interconnect	value	reduces	the	impedance	value	to	compensate	
for	a	long	interconnect.		A	negative	interconnect	value	increases	the	
impedance	value.		This	latter	correction	is	almost	always	needed	at	the	
end	of	a	row	or	tier	where	a	link	or	short	interconnect	between	jars	is	
not	measured.		
	
This	particular	unit	will	have	lower	impedance	than	those	that	include	
the	link	between	jars.		If	the	impedance	is	being	analyzed	using	the	
average	method,	it	is	important	to	bring	the	impedance	value	of	those	
jars	up	to	the	average	impedance.		
	
If	this	is	not	done,	one	of	the	jars	will	have	to	undergo	a	greater	
impedance	change	to	bring	it	to	the	alarm	point.	
It	is	important	to	load	these	values	into	the	BVS	after	they	have	been	
changed	on	this	sheet.		This	is	done	using	the	"Load	Interconnect	Values	
To	Controller	From	BVM	Software"	in	the	Advanced	section	of	main	
Communications	screen.	

Temperatures		
Differential	Limit	
above	Ambient	

The	maximum	increase	that	temperature	sensors	associated	with	each	
battery	unit	can	record	above	the	ambient	temperature.		The	purpose	of	
this	limit	is	to	sense	a	possible	thermal	runaway	condition.	

Installation	Date	 This	field	contains	the	installation	date	of	a	unit,	which	is	used	for	
analyzing	the	data	and	graphing.		When	a	report	or	graph	calculates	the	
rate	of	change	for	the	impedance,	it	will	only	use	the	measurements	
taken	after	the	unit	is	installed.		When	a	unit	is	replaced,	the	new	unit's	
installation	must	be	entered	here.			
	
A	replaced	unit's	previous	measurements	are	shown	in	the	graphs	with	a	
dimmed	color.		The	replacement	unit's	measurements	are	shown	with	a	
full	value	color.	

Serial	Number	 This	optional	field	allows	the	user	to	enter	a	serial	number	of	a	unit.	
Slope	Analysis	
Enable	Voltage	
Slope	Analysis	

This	checkbox	enables	the	slope	analysis	of	the	voltage	measurements	
(see	Unit	Trend	Graph	(Voltage),	pg.	101).		This	can	provide	an	early	
alert	to	a	unit	failure	when	the	unit's	voltage	starts	trending	lower.		
BTECH	recommends	enabling	this	option	for	wet	cell	applications.		The	
default	is	off	(unselected).	
	
The	analysis	can	be	set	–	in	days	–	anywhere	from	two	weeks	up	to	two	
years	(720	days).		Note	the	following:	
 the larger the interval the less precise the analysis, 
 a 35 to 90 day interval is suggested for VRLA batteries, 
 the minimum interval for flood jar systems is 180 days. 

Analysis	Interval	 Indicates	the	maximum	number	of	days	of	data	to	be	included	in	trending	
calculations	before	the	measurements	are	re‐set	to	zero.	

Enable	Impedance	
Slope	Analysis	

This	checkbox	enables	the	slope	analysis	of	the	impedance	
measurements	(see	Unit	Trend	Graph	(Impedance),	pg.	101).		This	
provides	an	early	alert	to	a	failing	unit	when	the	unit's	impedance	starts	
trending	higher.	
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Child Screens 

Export Unit Settings Button 

Clicking	the	Export	Unit	Settings	screen	button	displays	a	Windows	Explorer	window	where	
the	user	must	navigate	to,	and	select	the	destination	file	where	the	settings	are	to	be	stored.			

a. In	the	Windows	Explorer	screen	navigate	to	the	BVM4Data	directory,	
b. Select	the	location	file	the	settings	will	be	exported	to.			
c. Click	Open.		The	settings	are	written	to	the	file.	

Temperature Sensor Settings Property Sheet 

This	sheet	allows	the	user	to	label	the	battery	temperature	sensors	available	on	an	S5	as	
well	as	enable	their	limits.	

Figure	28‐Temperature	Settings	Property	Sheet	

	
 

Table	6. Temperature	Settings	Screen	Content	

	
Entry	Name	

	
Description	

Sensor	 Temperature	sensor	number.	
Unit	Limits	 This	setting	determines	whether	the	software	checks	the	

temperature	sensor	against	the	temperature	limits.	
Description	 A	user‐entered,	free	form	description	for	the	associated	

temperature	sensor.	

Communication Settings Property Sheet 

The	communication	settings	determine	how	the	communications	with	the	BVS	will	occur.		
The	most	commonly	used	settings	are	displayed	as	defaults.		BVM	supports	two	types	of	
communication	with	the	BVS.			

 Serial	Communication	between	the	serial	port	of	the	PC	and	the	BVS	utilizing	an	
external	modem	connected	to	the	serial	port	on	the	mid‐panel	of	the	S5,	a	USB	serial	
cable	(for	short	distances)	connected	to	the	front	of	the	S5,	or	a	short‐haul	modem	
pair	(for	long	distances)		

 Network	Communication	between	the	PC	and	BVS	using	a	TCP/IP	network.		

To	set	parameters	in	the	Communications	Settings	property	sheet	proceed	as	follows:	
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a. In	the	BVM	menu	bar	click	Settings,	and	select	Software	Settings	from	the	drop‐
down	list,	

b. Select	the	Communications	Settings	tab	in	the	property	sheets,	
c. Enter	or	change	any	of	the	available	fields,	radio	buttons,	or	checkboxes,		
d. Click	Apply.			

The	entries	become	effective	immediately.			
 

Figure	29	–Communications	Settings	Property	Sheet	

	
 

 

Only one of the options in this property sheet can be in effect at any given 
time.  The selection of the group radio button determines which data set is 
active. 

 

Table	7. Communications	Settings	Property	Sheet	

	
Entry	Name	

	
Description	

Serial	Communications	[Settings]	Radio	Button	
Phone	Number	 If	the	battery	monitor	communicates	through	dial‐up	modems,	

enter	the	phone	number	of	the	modem.		Otherwise	leave	this	space	
blank.	

Init	String	 Enter	an	initialization	string	to	supplement	the	initialization	string	
of	the	modem	in	use.			

Comm	Port	 Choose	the	port	to	use	for	communications.		All	available	ports	on	
the	PC	will	be	listed.	

Speed	 Select	the	speed	of	the	communications	port.		If	direct	
communications	are	being	used	(short	haul,	etc.),	the	speed	must	
match	the	communication	speed	of	BVS	–	19,200	bps.		If	an	external	
modem	is	used,	select	a	speed	of	19,200	bps.		
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Entry	Name	

	
Description	

Network	Communications	[Settings]	Radio	Button	
NOTE:		Uses	incoming	port	3001,	and	outgoing	port	8842	
Network	Address	 The	unique	IP	address	assigned	to	the	battery	monitor.		If	the	PC	

and	the	BVS	are	connected	to	a	company	network,	the	address	for	
the	BVS	should	be	obtained	from	the	network	administrator.		The	
network	address	of	the	BVS	can	be	set	in	the	Network	
Configuration	sheet.	
If	a	DNS	server	is	available,	each	battery	monitor	could	be	"named"	
and	that	name	used	as	the	network	address.		This	can	also	be	
accomplished	on	a	small	network	using	a	host	file.	

Network	Port	 This	is	the	"address"	of	the	BVS	on	its	network	adapter.		This	value	
should	not	be	changed.		The	default	port	is	3001.	
note:		BVM	Listens	on	Port	3001	and	responds	on	Port	8842.	

 

Child Screens 

Auxiliary Input Descriptions 

Clicking	the	Auxiliary	Input	Descriptions	screen	button	displays.		Each	of	the	six	inputs	can	
have	a	description	added	to	it.	This	description	will	be	used	when	an	alert	is	generated	from	
the	input.	

Refer	to:		Alarm	Output	Relays,	beginning	on	page	29	for	additional	information.	
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5.   Communications Menu Options 

Communications	Menu	options	enable	the	user	to	select	and	configure	the	communications	
parameters	that	the	S5	uses	to	talk	with	the	host	computer.		These	include:	

 A	direct	interface	using	a	USB	cable,	

 Netwok	interface	(see	Installing	SQL	Server	Express	2008,	page	114),	

 A	basic	service	(POTS)	telephone	line	connected	to	the	S5’s	internal	modem	via	the	center	
panel	serial	port,	(see	Figure	55,	pg.	73).	

 

Figure	30‐The	Communications	Screen	Property	Sheet	Map	

	

Primary	Communication	Screen	Options	

Once	communications	are	established	with	the	S5	the	primary	communications	screen	is	displayed	
(see	Figure	31,	pg.	48).		There	are	a	substantial	number	of	functions	and	property	sheets	available	
from	this	screen.		The	functions	contained	in	the	‘primary’	screen	are	described	in	this	section.			

The Retrieve Data Drop‐down 

The	Retrieve	drop‐down	in	the	Primary	Communications	screen	provides	options	for	retrieving	
different	types	of	data.	

The	Retrieve	Data	drop‐down	list	enables	the	user	to	select	the	data	set	and	download	it	from	the	
S5	controller	to	the	Site	file.		The	options	are:	

 Retrieve	All	–	retrieves	Alarms,	Alerts,	Measurements,	and	Discharge	data,	
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 Retrieve	Alarms	and	Alerts	–retrieves	any	alarms	or	alerts	the	S5	has	in	memory.		Alarms	
and	alerts	are	saved	to	the	database	file	and	can	be	viewed	in	the	alarm	listing.		The	user	is	
prompted	to	clear	the	alarms	from	the	S5's	memory,	
 Measurements that are ‘cleared’ after downloading are removed from the controller memory 

but remain in the software database. 

 Retrieve	Measurements	–retrieves	and	saves	any	measurements	stored	in	the	S5.		Up	to	
five	measurements	can	be	stored	in	the	S5's	memory.			

 Retrieve	Discharge	Data	–retrieves	and	saves	any	new	discharge	data	stored	in	the	S5.		
The	user	is	prompted	to	delete	the	discharge	data	to	make	room	for	any	future	discharge	
retrievals.		

 

Figure	31‐The	Primary	Communications	screen	(including	Advanced’	Options)		

	

Perform Measurements Function 

Click	this	button	to	initiate	a	measurement.		A	progress	bar	is	displayed	in	the	Status	line	and	the	
simulated	Measuring	LED	turns	green	(see	above).			

 When	the	measurement	is	complete,	click	the	Retrieve	Data	list	box	arrow	and	select	
Retrieve	Measurements	to	download	the	data	to	the	host	computer	for	review	and	analysis,	
(see	Figure	31,	above).			

Enable Real‐time Measurements Function 

This	enables	the	S5	to	begin	monitoring	measurements	in	real‐time	and	send	all	the	data	to	BVM.		
When	viewed	in	a	graphical	format	the	graphs	are	refreshed	each	time	a	new	data	item	is	received	
by	the	computer.		Three	graphs	are	available.	
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 The	Real‐time	Graph	of	Unit	Measurements	displays	all	of	the	unit's	voltages	and	
temperatures,	see	Unit	Snapshot	Graph	beginning	on	page	100.	

 The	Real‐time	Graph	of	System	Voltage	displays	a	moving	graph	of	the	system	voltage.		The	
user	can	also	opt	to	show	real‐time	graphs	of	System	Current	and	Ambient	Temperature.	

 Real‐time	graphs	of	String	Voltages	and	Currents,	and/or	System	Voltage	and	Current	
(availability	depends	on	configuration)	displays	the	system	and/or	each	string's	charge	or	
discharge	current.		The	title	of	the	graph	changes	to	reflect	the	measurement	selected.		If	
both	the	system	and	string	graphs	are	available,	they	can	be	selected	from	the	View	menu.		
See	Comments	

 Individual	Graph	data	can	be	exported	or	printed	using	the	File	menu.	

 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 Users	can	select	a	specific	sensor	from	the	drop‐down	list	in	the	tool	bar.	

 Data	can	be	graphed	as	either	data	points	(shown)	or	bars	by	pressing	F8.	

 String	Trend	beginning	on	page	102.	
 

 

Features and options of graphs are described in section 8  Graphs, beginning on  
page 97. 

Diagnostic Measurements Option 

Diagnostic	Measurements	is	a	tool	for	collecting	specific	battery	information	and	troubleshooting	
the	system.			

Table	8. Diagnostic	Measurements	screen	content	

Entry Name  Description 

System	
Voltage	 Displays	the	(total)	voltage	for	the	currently	selected	system.	
Ambient	Temp	 This	displays	the	ambient	temperature	for	the	currently	selected	

system.	
String	
Current	 This	displays	the	current	in	the	selected	string.	
String	Voltage	 This	displays	the	total	string	voltage	in	the	selected	string.	
Unit	
Unit	
(spin	box)	

Use	the	arrows	to	increment	and	select	the	unit	number	in	the	
selected	string	to	be	viewed.			

Unit	Voltage		 This	displays	the	unit	voltage	of	the	selected	unit.	
Unit	Temperature	 This	displays	the	temperature	of	the	selected	unit.			
Temperature	
Sensor	
(spin	box)	

Use	the	arrows	to	increment	and	select	the	sensor	number	in	the	
selected	string	to	be	viewed.		Unit	1	is	the	default.	

Auxiliary	Inputs	
Aux.	1‐6	 	
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Figure	32‐Diagnostic	Measurements	Display	Screen	

	

Advanced	Communication	Screen	Options	

These	options	are	displayed	(or	hidden)	by	clicking	the	Advanced	button	appearing	in	the	
‘Primary’	Communications	base	window.			

Check Time 

Clicking	the	Check	Time	button	displays	the	date	and	time	set	in	the	S5	unit	in	the	Status	line	of	
the	tab	screen.		The	time	is	used	to	label	all	events	recorded	by	the	unit	as	well	as	to	schedule	any	
measurements	set	in	the	software.		If	the	time	is	different	from	the	computer’s	actual	current	date	
and	time	the	user	is	prompted	to	synchronize	the	time.		The	time	is	displayed	in	the	status	line	of	
the	Communications	home	screen	when	the	Check	Time	button	is	clicked.			

Initial Impedance 

See	Obtaining	Baseline	Impedance	Values,	beginning	on	page	23	for	additional	information.	

System Configuration [Property Sheets] 

This	“System	Configuration”	button	displays	the	six	property	sheets	shown	in	Figure	33	below.			

System Configuration Properties   
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The	first	properties	tab	displays	the	system	configuration	screen	containing	the	settings	that	are	
programmed	into	the	battery	monitoring	hardware.			

 

Figure	33‐System	Configuration	Property	Sheet	

	
 

Table	9. 		System	Config	Property	Sheet	Screen	Content	

Entry Name  Description 

Location	ID	 This	number	is	used	to	identify	each	S5.		Especially	important	
when	there	are	multiple	units	in	the	configuration.	

Serial	Number	 The	serial	number	of	the	S5	found	on	the	side	of	the	controller.	
Firmware	Version	 The	version	number	of	the	firmware	in	the	unit’s	controller.	
Nbr	of	Strings	 The	number	of	strings	connected	to	the	selected	S5.	
Nbr	of	Voltage	Modules	 The	number	of	voltage	modules	in	the	strings	connected	to	the	

selected	S5.	
Nbr	of	Units/Strings	 The	number	of	units	(batteries)	in	each	string	connected	to	the	

selected	S5.	
Nbr	of	Current	Modules	 The	number	of	current	modules	in	the	strings	connected	to	the	

selected	S5.	
Units	in	Pgs	String	Half	 	
Clear	Memory	
(drop‐down)	

Clicking	this	button	drops	down	a	menu	allowing	the	user	to	
perform	the	following	actions:	
Clear	Alarm	Memory	‐	This	command	clears	the	controller's	
alarm	memory	regardless	of	whether	the	data	has	been	retrieved.	
Clear	Measurement	Memory	‐	This	command	clears	the	
controller's	measurement	memory.	This	normally	does	not	have	
to	be	performed	since	measurements	are	overwritten	
automatically.	
Clear	Discharge	Memory	‐	This	command	clears	the	controller's	
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Entry Name  Description 

discharge	memory.
Clear	Memory	and	Load	Factory	Defaults	‐	This	clears	all	
controller	memory	and	loads	the	factory	defaults.	
Note:		This	command	should	only	be	issued	under	the	direction	of	
BTECH.	

Child Screens 

Module Config[uration] Button 

This	function	displays	information	about	the	state	of	Voltage	and	Current	modules.		Data	is	
populated	automatically.	

Figure	34‐	Module	Configuration	Button	Screen	

	
 

Table	10. 		Module	Configuration	screen	entries	

Entry Name  Description 

Voltage	Module		
ID	 The	module	identifier	from	the	controller.		It	can	range	from	0‐24.		

These	are	numbered	in	the	order	they	are	connected	to	the	controller.		
The	module	closest	to	the	controller	is	number	001.	

Firmware	 This	field	displays	the	firmware	version	of	the	voltage	module.	
Voltages	 This	is	the	number	of	active	voltage	channels	used	on	each	voltage	

module.	
Temperature		 This	is	the	number	of	active	temperature	channels	used	on	each	

voltage	module.	
Status	 Displays	the	module	status	byte.	This	is	only	used	for	diagnostic	

purposes.	
NOTE:		Contains	“0xff”	if	module	is	off	line.	

Current	Module	
ID	 This	is	the	module	identifier	from	the	controller.	They	are	numbered	in	

the	order	in	which	they	are	connected	to	the	controller.	
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Entry Name  Description 

Firmware	 This	field	displays	the	firmware	version	of	the	voltage	module.	
Multiplier	 The	Multiplier	determines	the	full	scale	current	value	based	on	the	

current	transducer.		Select	and	change	the	current	Multiplier	by	
"double‐clicking"	to	highlight	the	value	and	entering	a	new	number.		In	
the	case	of	the	current	transducer,	this	value	is	also	used	to	determine	
the	current	based	on	the	number	of	cables	that	the	current	clamp	goes	
around.	

Direction	 This	indicates	the	direction	of	the	current	clamp	used	within	the	
system.			
NOTE:		Check	this	box	ONLY	if	the	clamp	is	installed	in	reverse.	

Current	Sensor	Location	 This	is	used	to	indicate	whether	the	current	clamp	is	in	the	positive	
half	or	negative	half	of	the	string.		Click	the	arrow	within	the	field	and	
select	the	proper	option	from	the	displayed	list.	

Status	 Displays	the	module	status	byte.	This	is	only	used	for	diagnostic	
purposes.	
NOTE:		Contains	“0xff”	if	module	is	off‐line.	

 

Definition Block  

Clicking	this	button	displays	a	dialog	where	the	user	can	view	or	change	various	options	that	are	
set	through	the	definition	block.	

 

Figure	35‐Definition	Block	screen	

	
 

Table	11. Definition	Block	Screen	Content		

Entry Name  Description 

Unit	Numbering	
Normal*	 Selecting	this	radio	button	displays	the	units	shown	in	the	home	

screen	from	1	to	‘n’	beginning	on	the	positive	side.	
Reverse*	 Selecting	this	radio	button	displays	the	units	shown	in	the	home	

screen	from	‘n’	to	1	beginning	on	the	negative	side.	
Dial	Modem	 	
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Entry Name  Description 

USA	Mode	 	
International	Mode	 	
*			see	BVM	Home	Screen	Display	Options,	pg.	128	for	additional	information.	

 

Figure	36‐The	Password	dialog.	

	

Discharge Setting Properties 

Table	12. Discharge	Settings	Properties	

Entry Name  Description 

Discharge	Trigger	Levels	
Current	Trigger	Level	
(Amps)	

The	current	level,	in	amps,	at	which	point	the	controller	determines	a	
battery	discharge	is	occurring.	

Current	Reset	Level	(Amps)	 The	current	level,	in	amps,	at	which	point	the	controller	determines	a	
battery	discharge	has	stopped.	

Voltage	Trigger	Level	(Volts)	 If	a	BVS	has	no	current	module,	it	uses	the	system	voltage	to	
determine	when	a	discharge	is	occurring.		When	the	system	voltage	is	
below	this	level,	the	controller	determines	a	discharge	is	occurring.			
NOTE:		Because	the	system	voltage	drop	at	the	beginning	of	a	
discharge	is	not	instantaneous,	determining	discharges	is	more	
accurate	using	a	current	transducer.			

	

Figure	37‐Discharge	Settings	Properties	
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Table	13. Discharge	Settings	Properties	

Entry Name  Description 

Voltage	Reset	Level	(Volts)	 If	a	BVS	has	no	current	module,	it	uses	the	system	voltage	to	
determine	when	a	discharge	is	occurring.		If	the	system	voltage	is	
above	this	level	(and	in	discharge),	the	controller	determines	that	a	
discharge	has	stopped.	

Discharge	Measurement	Settings	
Initial	Discharge	Period‐
(seconds)	

Enter	the	amount	of	time	at	the	beginning	of	a	discharge	where	only	
system	current	and	voltage	are	measured.		The	default	is	15	seconds.	

Discharge	Measurement	
Interval	(min:sec)	

This	is	the	amount	of	time	between	complete	measurement	cycles	
during	a	discharge.		During	one	measurement	cycle,	all	of	the	unit	
measurements	and	four	system	and	string	measurements	are	taken.	

Discharge	Alarm	
Short	Discharge	Delay	
(seconds)	

The	length	of	time	in	seconds	that	a	discharge	has	to	exist	before	a	
discharge	alarm	is	triggered.		Typically	the	delay	is	set	to	15	seconds	
to	eliminate	any	nuisance	alarms	from	short	power	discharges.	

Discharge	Alarm	Repeat	
Intervals	(minutes)	

During	a	battery	discharge,	the	alarm	will	be	sent	out	and	repeated	at	
this	interval	–	specified	in	minutes.	

Alarm Setup Properties 

This	screen	sets	various	alarm	parameters	as	described	in	the	subsequent	table.			
 

Figure	38‐Alarm	Setup	Properties				
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Table	14. System	Configuration:	Alarm	SetupProperties		Screen	Content	

Entry Name  Description 

Re‐Alarm	Delay‐(min)	 The	amount	of	time	the	BVS	waits	before	re‐triggering	a	
specific	alarm.		If	the	system	voltage	is	out	of	limits	and	the	
Alarm	Delay	is	set	to	1	minute,	the	BVS	will	go	into	alarm	
mode,	send	out	an	alarm,	be	reset	by	the	BVS	Observer,	and	
wait	for	1	minute	before	going	back	into	alarm	for	system	
voltage.	

Transmit Alarms to the BVS Observer 

Transmit	Alarm	Enable	 When	this	box	is	checked,	alarms	are	emailed	out	after	they	
occur.			

Alarm	Resend	Interval	(min)	 Determines	the	time	interval	before	an	active	alarm	is	re‐sent.	
Alarm	Priority	 Check	the	appropriate	button	to	indicate	which	alarm	mode	–	

network	or	modem	–	has	priority.		Alarms	for	the	selected	
mode	are	sent	out	first.		If	the	alarm	is	not	reset,	it	resends	the	
alarm	using	the	non‐priority	mode.	

Enable	Modem	Alarm	 Check	this	box	to	have	alarms	dialed	out	over	a	phone	line.	
Enter	the	number	to	be	dialed	in	the	"Dial	Out"	field.		If	this	
box	is	not	checked,	no	alarms	are	dialed	out.	

Enable	Network	Alarm	 Check	this	box	to	have	alarms	transmitted	over	an	IP	network	
connected	to	the	S5.	

Dial	Out	Number	1‐3	 These	fields	are	used	to	enter	the	phone	number(s)	to	dial	if	
the	Dial	Out	Alarms	option	is	enabled.		Number	1	is	dialed	first	
and,	if	the	alarm	is	not	reset,	the	BVS	proceeds	to	dial	Number	
2	and	so	on.	

Alarm Output Contacts Definition 

Contact	1‐6	
(below)	

Each	Alarm	Output	[Relay]	that	may	be	used	must	be	
configured	separately.		When	the	button	for	any	of	the	
Contacts	is	clicked,	the	Output	Alarm	Definition	Properties	
Sheet	is	displayed.		

Auxiliary Inputs 

Auxiliary	Inputs	1‐4	 Default	to	“Open”	but	users	can	select	from	the	drop‐down	list.	

Network Settings Properties  

The	Network	Settings	Properties	sheet	is	shown	below.		It	is	only	necessary	to	complete	the	
property	items	if	the	S5	is	being	monitored	over	a	TCP/IP	network.	

 

 

Information for the entries in this property sheet are generally provided by a network 
administrator. 
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Figure	39‐Network	Settings	Property	Sheets	

	
 

Table	15. Network	Settings	Properties	screen	content	

Entry Name  Description 

Address	 TCP/IP	address	assigned	to	the	controller.		Clicking	the	Load	Address	From	
BVM	button	loads	the	network	IP	address	from	the	BVM	Communication	
Settings	into	the	TCP/IP	Address.		Depending	on	the	firmware	version	of	
the	controller,	the	MAC	address	of	the	controller's	network	interface	is	
also	displayed.	
NOTE:			If	the	IP	address	entered	is	0.0.0.0,	the	controller	attempts	to	
retrieve	and	assign	its	address	from	a	DHCP	server	

Subnet	Mask	 The	subnet	mask	that	the	controller	uses	for	network	communications.	
Gateway	Address	 The	gateway	IP	address	that	the	controller	uses	for	network	

communications.	
Alarm	Destination	
Address	 The	IP	address	of	the	computer	running	the	BVS	Observer	(where	the	

alarms	are	sent).		Clicking	the	Address	of	this	Computer	button	loads	the	
network	IP	address	of	the	computer	on	which	the	BVM	is	running	into	the	
Alarm	Destination	field.	

Port	 The	port	on	the	BVS	Observer	where	the	alarm	occurring	on	the	controller	
will	be	sent.	
NOTE:		The	default	value	is	8842.	

Time‐Out	 The	amount	of	the	time	in	seconds	the	controller	waits	to	connect.			
NOTE:		The	default	value	is	60	seconds.	

 

Child Screens 

Load Address from BVM  

This	loads	the	network	address	in	the	software	communication	setting	into	the	address	field.	

Address of this Computer  

This	button	loads	the	address	of	the	current	computer	into	the	alarm	destination	address	field.	
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Impedance Multipliers  

Refer	to:	Impedance	Multipliers	

Obtaining	Baseline	Impedance	Values	

Certain	parameters	must	be	set	once	the	computer	and	the	S5	controller	are	communicating.		This	
is	done	from	various	functions	contained	in	the	primary	Communications	screen.		Utilizing	this	
screen	the	user	can	acquire	a	base	set	of	measurements	from	the	S5,	save	them	to	the	S5’s	location	
file,	and	store	them	in	the	controller	memory.	

Table	16. 	Impedance	Multipliers	Tab	Properties	

Entry Name  Description 

String	n	–	%	
Pos	Half	

	

String	n	–	%	
Neg	Half	

	

 

Figure	40‐Impedance	Multipliers	Property	Sheet	

	
 

Child Screens 

Auto Multiplier Setup  
Manual Multiplier Setup  

Refer	to	“Impedance	Multipliers	

Obtaining	Baseline	Impedance	Values	

Certain	parameters	must	be	set	once	the	computer	and	the	S5	controller	are	communicating.		This	
is	done	from	various	functions	contained	in	the	primary	Communications	screen.		Utilizing	this	
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screen	the	user	can	acquire	a	base	set	of	measurements	from	the	S5,	save	them	to	the	S5’s	location	
file,	and	store	them	in	the	controller	memory.	

Load Plate Settings Properties 

The	following	values	are	the	system	voltage	limits	between	which	Impedance	measurements	may	
be	taken.	If	the	system	shows	measurements	that	are	out	of	these	limits,	no	impedance	
measurements	can	be	made	and	an	alarm	will	be	generated.	

 

 

These settings are determined by BTECH and are read only. They should only be 
changed by authorized personnel. 

 

Figure	41‐Load	Plate	Settings	Property	Sheet	

	
 

Table	17. Load	Plate	Properties	

Entry Name  Description 

Limits for Impedance Measurements 

Positive	Half	Max	Voltage	
Limit	

Not Available.  The	maximum	voltage	limit	for	the	positive	half	of	
the	battery. 

Positive Half Min Voltage Limit  Not Available.  The	minimum	voltage	limit	for	the	positive	half	of	the	
battery. 

Negative Half Max Voltage 
Limit 

Not Available.  The	maximum	voltage	limit	for	the	negative	half	of	
the	battery. 

Negative Half Min Voltage 
Limit 

Not Available.  The	minimum		voltage	limit	for	the	negative	half	of	
the	battery. 

 

Load	Plate	Current	(RMS)	 Not	Available.		The	amount	of	load	current	drawn	by	the	load	plate	
(depends	on	the	load	plate	supplied	with	the	system).	

System	Full	Scale	Voltage	 Not	Available.			
Load	Plate	Off	Time	(sec)	 Not	Available.	
System	Voltage	Offset	 Not	Available.		This	value	is	used	by	the	controller	to	compensate	
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Entry Name  Description 

for	an	offset	of	the	system	voltage	measurement	by	the	load	plate.
Load	Plate	Temp	Cutoff	 Not	Available.		Determines	under	what	temperature,	impedance	

measurements	can	be	taken.		This	is	to	prevent	the	load	plate	from	
overheating.	

Controller	Settings		

Within	the	Controller	Settings	screen,	there	are	six	property	tab	pages	where	settings	can	be	made	
and/or	viewed	(see	Figure	42).	The	majority	of	these	settings	are	controller	alarm	limits.	

System Limits Properties  

Figure	42‐	System	Limits	Property	Sheet	

	
 

Table	18. System	Limits	Properties	Description	

Entry	Name	 Description	

Max	Voltage	 The	maximum	allowed	system	voltage.	If	the	measured	voltage	is	above	
this	value	it	may	indicate	there	is	a	problem	with	the	charger.	

Min	Voltage	 The	minimum	allowed	system	voltage.	If	the	measured	voltage	is	below	
this	value	it	may	indicate	there	is	a	problem	with	the	charger,	or	that	
the	charger	is	disconnected	from	the	battery	or	battery	string.	

Max	Ambient	 The	maximum	allowed	ambient	temperature.	
Min	Ambient	 The	minimum	allowed	ambient	temperature.	

 

Child Screens 

Load BVM System Settings 

Clicking	this	button	loads	the	software's	system	limits	into	the	appropriate	fields	and	syncs	the	
hardware	system	limits	to	the	software	system	limits.		There	is	no	screen	activity	when	this	button	
is	clicked.	
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Unit Limits Properties  

The	Unit Limits	allows	the	limits	for	each	unit	to	be	selected	from	one	of	the	four	sets	of	limits	in	
the	drop‐down.		The	settings	allow	each	individual	unit	to	have	custom	configured	alarm	limits,	
(typically	Unit	Limit	Set	1	is	used	for	all	units).		

 

Figure	43‐	The	Unit	Limits	Property	Sheet	

		
 

Table	19. Unit	Limits	Properties	Descripton	

Entry Name  Description 

String	#		 The	string	number.	
Unit	#		 The	unit	number	within	the	string.	
Unit	Settings	Set	 Enables	the	user	to	select	the	unit	settings	based	on	another	String	and	

Unit	settings.	
Impedance Analysis Drop‐down 

Impedance	Analysis	
drop‐down	

Contains	two	options:	
Average	–	Average	impedance	limits	are	derived	from	the	average	string	
impedance.	
Initial	–	the	unit	impedance	limits	are	calculated	from	an	‘initial’	or	
‘baseline’	impedance	measurement	taken	when	the	battery	is	known	to	
be	healthy.	

 

Controller Measurement Setup Properties 

The	controller	measurement	sheet	allows	the	day,	time,	and	measurement	frequency	to	be	set.		
The	recommended	measurement	interval	is	seven	days.		The	frequency	used	for	performing	the	
impedance	measurement	is	also	displayed	and	cannot	be	changed.	

Table	20. Controller	Measurements	Setup	Properties	Description	

Entry	Name	 Description	

Next	Measurement	
Date		
(calendar	box)	

The	date	of	the	next	measurement.	

Time	 The	time	of	the	next	measurement.	
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Entry	Name	 Description	

(spin	box)	
Measurement	Interval	
Day	
(spin	box)	

The	number	of	days	between	measurements.	

Hour	
(spin	box)	

Only	available	if	a	measurement	will	be	taken	again	in	less	than	24	hours.	

 

Figure	44‐	Controller	Measurement	Setup	Property	Sheet	

	

Unit Limit Set [1‐4] Properties  

Four	sets	of	alarm	limits	that	define	when	a	unit's	measurement	is	in	an	alarm	state.	
 

 

All entered limits should correspond to limits recommended by the battery 
manufacturer for the particular make and model. 

 

Figure	45‐	Unit	Limit	Set	Property	Sheet	
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Table	21. Unit	Limit	Set	#	Properties	Description	

Entry Name  Description 

Voltage	
Max	Maint	Limit	 The	maximum	maintenance	alarm	limit.	
Min	Limit	 The	minimum	maintenance	alarm	limit.	
Max	Critical	Limit	 The	maximum	critical	alarm	limit.	
Min	Critical	Limit	 The	minimum	critical	alarm	limits.	
Impedance		
Maint[enance]	
Percent	Limit	

A	percentage	that	determine	whether	a	unit's	impedance	is	in	a	maintenance	
alarm	state.	

Percent	Limit	
Critical	

A	percentage	that	determine	whether	a	unit's	impedance	is	in	a	critical	alarm	
state.	

Temperature	
Max	Temp	Limit	 The	maximum	alarm	limit.	
Min	Temp	Limit	 The	minimum	alarm	limit.	
Differential	Limit	 The	Differential	Limit	is	the	difference	in	temperature	between	the	ambient	and	

unit	temperature.	
 

Child Screens 

Load BVM Unit Settings  

This	button	loads	the	software's	unit	limits	for	Unit	1	of	String	1	into	the	appropriate	fields,	and	
syncs	the	hardware	unit	limits	to	the	software	unit	limits.		There	is	no	confirming	dialog.	

The Get/Set Configuration Option 

This	allows	the	user	to	extract	and	load	the	configuration	and	settings	from	the	controller	to	
BVM4.x.		Extracting	the	memory	to	the	file	does	not	change	anything	in	the	controller.		However,	
loading	the	configuration	file	into	the	controller	will	erase	all	its	memory.		Every	controller	is	
shipped	from	the	factory	with	a	file	containing	its	configuration	and	default	settings.		The	user	will	
also	be	prompted	to	extract	or	load	the	Initial	and	Interconnect	Impedances	values.	

 

 

The Get/Set Controller Configuration dialog is critical to backing up, and 
restoring, the controller’s memory.  This procedure should be performed 
prior to backing up the BVM4.x application and database files. 

 

Figure	46‐	The	Get/Set	Controller	Configuration	dialog	
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Extracting Controller Data to the Software 

Controller	data	content	can	be	extracted	periodically	and	sent	to	a	location	file.		Use	the	following	
procedure.	

a. Navigate	to	the	Communications	main	screen	and	expand	it	by	clicking	Advanced,	(see	
Figure	31,	pg,	48),	

b. Click	the	Get/Set	Controller	Configuration	button,	(see	above),	
c. In	the	resulting	dialog	(see	above),	select	the	Extract	radio	button	and	click	OK,	
d. In	the	resulting	dialog	select	the	file	and	location	(must	be	a	.set	file)	where	the	data	will	be	

saved	and	click	Save,	
e. Click	Yes	when	prompted	to	save	the	Initial	and	Interconnect	measurement	values	if	the	

data	will	be	retained.		

Restoring Controller Data from BVM4.x Using Load 

Using	the	Get/Set	Controller	Configuration	button,	data	from	a	.set	file	can	be	downloaded	to	the	S5	
controller.		Generally	this	is	done	to	restore	controller	settings	that	have	become	corrupt	or	
otherwise	unreliable.		To	restore	data	use	the	following	procedure.	

a. Navigate	to	the	Communications	main	screen	and	expand	it	by	clicking	Advanced,	
b. Click	the	Get/Set	Controller	Configuration	button,	(see	Figure	31,	pg.	48),	
c. In	the	resulting	dialog	(see	above),	select	the	Load	radio	button	and	click	OK,	
d. In	the	resulting	dialog	select	the	desired	.set	file	and	click	OK.		This	loads	the	data	from	the	

selected	file.	
 NOTE:		In	most	cases	the	most	recent	data	will	be	restored,	however	any	available	data	file	

can	be	used	for	the	‘restore’.	

Click	Yes	when	prompted	to	load	the	Initial	and	Interconnect	measurement	values,	

The	Reboot	Option	

This	button	reboots	the	S5.		There	is	no	specific	screen	for	rebooting	but	a	confirmation	dialog	is	
displayed	where	the	user	can	proceed	or	cancel	the	action	(see	Figure	31,	pg.	48).	

The	Standby	Option		

This	button	functions	as	a	toggle	and	is	most	often	used	to	perform	work	on	the	battery	string.		
Placing	the	battery	monitor	in	Standby	prevents	closure	of	the	relays	that	connect	the	battery	
string	to	the	battery	monitor.		This	prevents	the	battery	monitor	from	alarming	for	any	out‐of‐
limits	conditions,	as	well	as	protecting	personnel	and	equipment.		Use	the	following	procedure.	

a. Click	the	Standby	button	and	the	status	indicator	in	the	window	indicates	the	monitor	is	
being	placed	in	standby	mode.	
 the	Standby	button	text	changes	to	“Exit	Standby”.	

b. To	exit	Standby	mode	click	the	Exit	Standby	button.	
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 the	Standby	button	text	changes	to	“Standby”.	

The	Interconnect	Impedance	Drop‐down	

The	unit	interconnect	impedance	values	are	used	to	adjust	individual	unit	impedance	
measurements	where	there	are	different	length	interconnects	than	used	on	the	rest	of	the	battery.		
The	drop‐down	contains	the	following	options	(see	Figure	31,	pg.		48).	

“Retrieve	Interconnect	Impedance	Values	from	Controller	and	Save	to	BVM	Software”	

This	option	retrieves	the	current	interconnect	impedance	values	and	writes	them	to	the	location	
file.	

a. Click	on	the	Initial	Impedance	drop‐down	and	select	‘Retrieve	Interconnect		
Impedance	.	.	.’	

b. In	the	preview	data	screen	click	OK,	
c. Click	OK	in	the	warning	dialog.	

 

	“Load	Interconnect	Impedance	Values	to		Controller	from	BVM	Software”	

This	option	reads	the	interconnect	vales	from	the	location	file	and	writes	them	to	the	S5	controller.	

Figure	47‐Interconnect	Impedance	Options	

	

Initial	Impedance	Drop‐down	Options	

The	options	listed	in	this	drop‐down	function	are	used	to	retrieve	initial	impedance	values	from	
the	batteries.		The	data	can	then	be	saved	to	the	BVM	database	and/or	be	written	to	the	
controller’s	memory.		The	options	are	generally	used	during	the	initial	configuration	of	a	new	site,	
or	when	major	changes	are	made	to	the	configuration	of	an	existing	site.		Refer	to	Figure	48,	on	
page	66.		

Create Initial Impedance Measurements in Controller 

This	function	causes	the	controller	to	perform	a	new	impedance	measurement.	The	impedance	
data	is	recorded	for	each	unitduring	this	measurement	and	is	used	as	the	new	"Initial	Impedance"	
data.		The	user	is	alerted	and	prompted	that	performing	this	action	will	overwrite	the	initial	
impedance	information	stored	in	the	controller.	After	this	operation	has	is	completed,	the	user	
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should	perform	the	"Retrieve	Initial	Impedance	Measurements	From	Controller	and	Save	to	
BVMSoftware	Unit	Settings"	command	to	retrieve	the	initial	impedance	measurements.	

a. Click	the	drop‐down	and	select	this	option	from	the	list,	
b. Select	the	current	date	in	the	date	dialog	and	click	OK,	
c. Click	Yes	in	the	warning	dialog.	

Retrieve Initial Impedance Measurements from Controller and Save to BVM 
Software Unit Settings 

This	retrieves	the	initial	impedance	measurements	from	the	controller	and	shows	them	to	the	
user.	This	allows	the	user	to	preview	the	information	before	making	any	changes.		It	then	prompts	
the	user	to	overwrite	any	existing	initial	impedance	measurements	in	the	Unit	Settings.		If	they	
agree,	it	saves	the	initial	impedance	measurements	to	the	Unit	Settings.	

a. Click	the	Initial	Impedance	drop‐down	and	select	‘Retrieve	Initial	Impedance	.	.	.’	
b. In	the	preview	data	screen	confirm	that	TBA	and	click	OK,	
c. Click	OK	in	the	warning	dialog.	

Figure	48‐Initial	Impedance	Drop‐down	Options	

	

Load Initial Impedance Measurements to the Controller from BVM Software Unit Settings 

This	loads	the	controller's	initial	impedance	memory	with	the	initial	measurements	stored	in	the	
BVM's	Unit	Settings.	The	user	is	alerted	and	prompted	that	performing	this	action	will	overwrite	
the	initial	impedance	information	stored	in	the	controller.	

a. Click	the	Initial	Impedance	drop‐down	and	select	‘Load	Initial	Impedance	Measurements	.	.	.’,	
b. Click	Yes	in	the	dialog.	
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6.   Equipment Checks and Troubleshooting 

BTECH	provides	a	complete,	custom	wire	list	and	install	diagram(s)	that	specifies	the	position	and	
connections	for	all	components.		If	this	diagram	is	not	available	contact	BTECH	for	a	duplicate.		If	a	
thorough	check	of	all	component	connections	does	not	resolve	pending	issues,	check	the	
components	and	connections	to	the	BTECH‐provided	diagram(s).				

Battery Connections 

If	tab	washers	are	used,	verify	that	they	are	correctly	installed	to	the	cell	terminal	bolt	or	nut;	and	
in	compliance	with	the	wiring	diagram.		Tabs	should	be	facing	in	an	appropriate	direction	for	
correct	wire	routing	(see	Routing	VSL	and	LCL	Wiring,	beginning	on	pg.	68).		If	the	cell	has	3	pairs	
of	posts,	tab	washer	should	be	installed	under	the	middle	cell	terminal	bolt	if	possible.	

Where	the	VSL	and	LCL	Pigtails	connect	to	battery	terminals	using	a	Tab	washer	confirm	the	
following:	

 Tab	washers	and	related	hardware	are	properly	connected	to	battery	terminals	as	shown	
below	(A	&	B),	

 The	female	end	of	the	pigtail	is	securly	connected	to	the	tab	washer,	(C	)	

Figure	49:		Tab	Washers	mounted	Directly	to	Batteries	(A	&	B);	VSL	Pigtail	connection	using	a	Tab	washer	
(C),		
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Stainless Steel Clamps 

For	installations	where	the	connection	are	made	to	battery	straps,	BTECH	include	sets	of	stainless	
steel	clamps	with	the	pigtail	assembled	to	the	clamp.		Actual	positioning	of	the	clamp(s)	on	the	
battery	straps	is	determined	by	the	system	wiring	diagram.		Verify	that	the	clamps	are	positioned	
as	close	to	cell	post	as	practical.		If	the	cell	has	three	pairs	of	posts,	clamp	should	be	near	the	middle	
post	if	possible.	

 Confirm	that	the	clamps	are	securly	attached	to	the	battery	straps.	

Figure	50‐	Attaching	Stainless	Steel	Clamps	to	battery	straps	

	

The	LCL	and	VSL	Wires	

The	VSL	wires	must	be	secured	in	the	appropriate	10‐	and	16‐pin	Wago™	connectors	and	
terminated	to	the	VM‐24i	unit.		Additionally,	the	LCL	wires	must	be	secured	in	a	4‐pin	screw	
connector	and	terminated	to	the	S5.		The	path	used	to	route	the	wires	and	the	conduit	(if	used)	
through	which	the	wires	pass,	must	be	installed	correctly	or	erroneous	readings	may	result,	(see	
Figure	51	below).	

Routing VSL and LCL Wiring 

The	following	practices	should	be	observed	for	VSL	and	LCL	wire	routing.	
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 Confirm	that	the	VSL	wiring	is	routed	along	the	current	path.	

 Wiring	ducts	mounted	on	battery	racks	are	installed	on	the	INSIDE	of	the	rack.	

 Whenever	VSL	and	LCL	lines	are	routed	in	parallel,	they	MUST	be	separated	by	a	minimum	
of	2	feet,	(61	cm).			

 Whenever	VSL	and	LCL	wiring	cross	–	they	MUST	do	so	at	right	angles.	

 VSL	and	LCL	lines	must	be	routed	in	separate	channels	or	conduits.	

 Communication	cables	MUST	be	routed	separately	from	VSL	and	LCL	wiring.	
 

Figure	51‐	VSL‐LCL	Wiring	Diagrams	

	

Connecting S5 and VM‐24i Units 

Single Unit Connections  

Confirm	that	the	following	conditions	have	been	met,	(see	Figure	52,	pg.	70).	

 The	‘White’	connector	is	securly	plugged	into	the	the	back	of	the	S5	unit	and	the	‘Orange’	
connector	is	plugged	into	the	IN	port	of	the	VM‐24i.	

 The	BTECH‐provided	‘Communication	Termination	plug	is	correctly	positioned	and	securly	
plugged	into	the	OUT	port	of	the	VM‐24i.	

 

 
DO NOT attempt to use the S5 system without the Termination Plug in place. 

Daisy-chained VM-24i Unit Connections  

VM‐24i	units	are	daisy‐chained	in	an	S5	system	using	‘Communication’	cables.		Confirm	the	
following	connections	have	been	made.	

 The	‘White’	connector	is	securly	plugged	into	the	the	back	of	the	S5,	and	the	‘Orange’	
connector	is	plugged	into	the	IN	port	of	the	first	VM‐24i	(see	Figure	52,	pg.	70).	
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 The	‘White’	connector	is	plugged	into	the	‘OUT’	port	of	the	first	VM‐24i,	and	the	‘Orange’	
connector	is	plugged	into	the	IN	port	of	the	next	VM‐24i.	

Continue	this	process	until	the	last	daisy‐chained	VM‐24i	is	connected	using	the	BTECH‐provided	
‘Communication	Termination	plug	into	the	OUT	port	(see	below).	

 

 

The	termination	plug	should	be	used	as	described	in	this	guide.		DO	NOT	insert	
any	wires	into	the	plug.	

 

Figure	52‐	Daisy‐chained	VM‐24i	units.		The	last	unit	MUST	have	the	‘termination	plug	installed		

	

Current	Transducer	Connections	

Current	Transducers	(CTs)	are	shipped	by	BTECH	terminated	to	the	4‐pin	connector.		Confirm	that	
the	CTs	are	correctly	installed.	

 The	CTs	are	installed	around	the	‘Battery	Charging’	cable	so	that	the	red	dot	faces	the	
positive	side	of	the	UPS	(uninterruptable	power	supply).			

 The	CT	cable	is	securly	plugged	into	the	VM‐24i.	

 The	serial	number	on	each	CT	is	correctly	matched	to	the	corresponding	VM‐24i	(see	
below).		

 The	green	plug	of	the	current	transducer	is	correctly	inserted	into	the	left‐side	of	the	eight‐
pin	connector.	
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Figure	53‐Matching	serial	numbers	between	a	CT	and	S5	

	

Battery	Top	Temperature	Sensors	(Thermistors)	

Thermistors	are	not	a	required	component	of	an	S5	monitoring	system.		If	they	are	used,	the	
following	items	should	be	checked.	

 The	sensor	should	be	positioned	adjascent	to	the	rack	or	cabinet	containing	the	battery	
unit:	
 Rack Mounted batteries – install near battery strings. 

 Cabinet Configurations – install inside the cabinet approximately 3/4 of the distance to the 
cabinet bottom. 

 The	2‐pin	connector	should	be	firmly	inserted	into	the	designated	port	on	the	S5	mid‐
panel.	(see	Figure	55,	pg.	73).	

 

 

Thermistors installed to measure ambient temperatures must be placed away 
from heating or cooling sources to prevent erroneous readings. 

S5	Ground	Connections	

Once	all	wires	have	been	terminated	to	the	correct	module	the	S5	system	MUST	be	grounded.	
 

 

The SCM‐600 should NOT be connected to a power source until grounding is 
complete. 

Ground the S5 

The	S5	system	must	be	grounded	before	power	is	applied.		Confirm	that	the	following	condition	
exists.	

 The	ground	wire	tip	is	secured	to	the	GnD	conector	on	the	mid‐panel	of	the	S5	(see	Figure	
55,	pg.	73).	

 The	BTECH	supplied	3/8	inch	(9.5	mm)	connecting	ring	or	similar	device	is	attached	to	the	
opposite	end	of	the	wire	and	secured	to	a	grounding	point	on	the	rack	or	cabinet	(see	
below).	
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The S5 System MUST be properly grounded as described in this section 
or damage to the system and voiding of the warranty may result. 

 

Figure	54	–	S5	Grounding	Example	

	

Fuses	and	to	Power	Source	Connections	

The	inline	fuses	for	all	of	the	LCL	and	VSL	pigtails	must	be	correctly	installed.		BTECH	provides	all	
of	the	fuses	required	for	the	S5	system.		Confirm	the	following	conditions	are	met.	

 All	pigtails	have	the	correct	fuse	in	place,	
 For VSL leads BTECH supplies 62 Ma fuses, 

 For LCL leads BTECH provides ATM fuses.  

 The	leads	from	the	VSL	and	LCL	pigtail	are	correctly	paired	with	the	corresponding	lead	
from	the	S5	or	VM‐24i	as	specified	in	the	wiring	diagram.		

 The	halves	of	the	fuse	holders	are	securly	connected.	

Checking Fuses 

When	installing	or	inspecting	fuses	the	following	practices	should	always	be	observed.	

 Insert	the	fuse	into	the	fuse	holder	attached	to	the	lead	terminating	at	the	VM‐24i	or	the	S5.		
Mate	the	two	halves	of	the	fuse	holder	and	rotate	clockwise	until	the	two	sections	are	
connected.		Rotate	counter‐clockwise	to	separate	the	fuseholder	halves.	

 

 

Always insert the fuse in section of the fuse holder attached to the lead that 
terminates at the VM‐24i unit.  DO NOT insert the fuse into the section of the 
fuse holder for the pigtail attached to the battery. 

 

 

Do NOT use fuses of a different power rating then the ones provided or damage 
to the system and voiding of the warranty may result. 

 

 

Do NOT connect the S5 to a power source until ALL fuses have been installed.  Always 
disconnect the S5 from its power source before inspecting fuses. 
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Figure	55	–	S5	Mid‐panel	showing	with	certain	connections	Labeled	
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Installation	Check	List	

This	section	contains	an	checklist	for	the	installer	to	record	equipment,	communication,	and	
configuration	information	for	a	particular	customer	S5	site.		The	form	should	be	completed	and	
signed	by	the	customer	and	forwarded	to	the	BTECH	home	office.	

This	section	can	be	printed	by	clicking	Print	and	entering	“S9”	(no	quotes)	in	the	‘Pages”	field	on	
the	Windows	Print	dialog,	(see	below).		The	form	can	be	copied	and	pasted	and	completed	using	
Microsoft	Word.	

Figure	56‐The	Win	7	Print	Dialog	
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S5	Startup	Check	List	
 

Customer  Location 

  Date: 

BVS M/N  BVS Serial # System #/ID

   

 

VM‐24i‐CT    Serial #    Installed Around    String Cables CAL Code 

          of       

          of       

          of       

          of       

          of       

          of       

          of       

          of       

A. 	Installation,	Inspection,	and	Confirmation	

      YES  NO 

1  Was there any shipping damage?  If YES describe       

 

2  Was the BVS wired completely and according to instructions?  (Was this a BTECH install?) 

Describe         Acceptable       Unacceptable          

     

 

3  Was enclosure clean and free of metal chips and filings?       

4  Is a ground wire correctly installed (chassis ground lug to battery rack\cabinet)?       

5  Are power and communications (if required) installed and active?       

  Power       

Communications       

6  Is ambient temp. installed away from heating or cooling air ducts?       

Installed Location: 

7  A.  Do the serial numbers of the current clamps and CM‐2/VM‐24i modules match?       

B.  CT is around                          of                         battery cables.     Multiplier is: 

8  Were pilot cell thermistors correctly installed?       

Record jar numbers on attached form 



	
S5	Operating	Manual		

	 Equipment Checks and Troubleshooting 

 

Ver.	2.0	(August	2012)			 P a g e 	|	76	

	
 

      YES  NO 

9  Was wiring between cells and VM‐24s terminated and routed correctly?       

10  Were the VSL fuses installed?       

11  Was Comm. wiring between modules terminated correctly (color code and order)?       

12  Was Comm. wiring damaged in any way?       

13  Were the Load Leads (LCL) correctly routed and terminated?       

14  Are all LCL fuses installed? Confirm the fuse rating matches the load plate current.       

15  Confirm the load lead terminal voltage matches the split as designed.  Correct as required.       

16  Confirm that the BVS is powered according to design. (DC Powered)       

17  Is the single Comm. cable terminator installed at last 24i?       

B. 	Operation	Verification	

After section “A” is complete, power can be applied to the BVS S5.  Turn on both switches.  

      YES  NO 

1  Confirm that the number of modules matches the configuration of the .set file.       

2  Is an inline power delay module in use?       

Measure and record the voltage supplied to the last module. 
(Min. acceptable is 18 VDC). 

3  Use Module diagnostics to confirm that the number of units and Thermistors connected to each 
VM‐24i matches the module configuration.  Correct module configuration as required. 

     

4  Run Relearn Connections.  Did the S5 learn the system correctly?  If NO explain modifications that 
were made. 

     

 

5  Confirm installation of the current clamps (polarity and number of cables).       

6  Confirm that the multiplier in the module configuration matches the physical configuration as 
recorded in Sect A‐7A (above).  Change the CM‐2/VM‐24i as necessary. 

     

7  Is the voltage to the current clamp 5 VDC (red to black) and 2.5 VDC (white to black)?       

8  Was current clamp operation verified, (disconnect the CT cable in real‐time mode)?       

9  Was VSL wiring and Comm. wiring verified by removing VSL fuses (one per Voltage Module towards 
one end) while watching real‐time unit voltage graph? 

     

10  Where the impedance multipliers set?  Check one.                    Auto is for even split ONLY.       

  Manual setup                    Automatic setup 

11  Are any interconnect impedance values set?  If YES load values into SCM.       

12  Did the S5 perform a complete measurement?         

If NO – explain. 

13  Download alarms, measurements, and discharge data.  If setup and alarms are in BVS memory – 
clear memory and delete alarms and measurements from memory. 

     

14  Were successive impedance measurements consistent?        
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      YES  NO 

15  Confirm the Unit and System Analysis and Reports do not generate false alarms.  Correct as 
required. 

     

16  BVS S5 (and BVM 4.x) was left in which impedance mode?       

  Average           Initial    

17  Are Communication available?       

Type:                        Modem phone # 
Network:     Gateway IP:                                                              Subnet Mask:   
  

18  If modem connection is used: 
A.  Check communication with ring emulator if no permanent line installed. 
B.  Dial out prefix (circle one):  9   8   
C.  Dial “1” and/or 10 digits 

     

     Use analog phone to dial cell number. 

     Use BVM to dial alarm out to cell number. 

19  Next read date and time and interval per customer agreement.       

Date:                       Time:                        Interval:                        (hours or days) 

20  Extract .set file (as left) and label with:  “As left”,  “Date:”.          

21  Obtain copy of BVM files. 

22  Controller and TCP firmware version as left.       

Controller:                                         TCP:                                

23  Is the BVS fully operational per Operations Manual procedures?       

 

C.		Customer	Computer	Setup	

      YES  NO 

1  A.  Was software installed and configured?       

B.  Did it operate correctly?           Software ver.  BVM                           PC OS:               

2  If required was USB driver installed?       

3  Confirm two‐way communication for all installed options.       

4  Download data from controller saved in the customer’s PC data directory       

5  Is the .set file, as currently loaded in the SCM‐600, saved in the customer’s data directory?       

6  Was a custom battery map prepared? (standard is to complete this on site).       

7  Were Thermistors mapped?  (standard is to map shelves/groups to a single Thermistor).       

8  Obtain a copy of BVM files as left on customer’s computer.       

9  Is BVM 4.x and Observer fully operational per Operating Manual procedures?       

10  Describe planned repair work:       
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      YES  NO 

 

D.		Customer	Sign	off	

     

Customer    Date 
     
     

BTECH Rep.    Date 

Additional Comments and Information: 
 
 
 

Post‐Startup/Service	Report	
 

Site  Date

 
BTECH Personnel   Serial #

 

 

List ALL changes made at Startup 

 
 
 
 
 

 

 

List ALL follow‐up issues 

 
 
 
 
 
 

 

Items that need to be shipped to customer 

Item  Cost  Date Shipped 
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Items that need to be returned from customer 

Item    Date Received 

     

     

     

     

 

Contact 1  Contact 2 

Name:  Name: 

Address: 
 

Address: 
 

Off. Phone/Ext:  Off. Phone/Ext: 

Cell:  Cell: 

FAX:  FAX: 

Email:  Email: 

 

Thermistor Mapping 

VM 24i    VM 24i   

1          2         

3          4         

5          6         

7          8         

9          10         

11          12         

13          14         

15          16         

17          18         

19          20         
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7. Reports 
BVM	software	incorporates	base	report	formats	for	a	number	of	parameters	that	it	records	and	
trends.		Depending	on	the	particular	measurement	the	user	must	provide	a	specified	date,	and/or	a	
date	range	and	time.		

General	Information	

 The	columns	on	most	reports	can	be	expanded	or	condensed	by	placing	the	cursor	on	the	
column	border	in	the	heading	row	and	dragging	the	border	right	or	left.		When	placed	on	
the	border	the	cursor	changes	to	a	double‐pointed	arrow(	see	Figure	60,	pg.	83).	

 Data	can	be	deleted	from	the	report.	

Exporting Data 

The	data	from	most	reports	can	be	exported	in	.csv	format	by	selecting	File>Export	Data	in	the	
menu	bar.		A	submenu	of	options	is	displayed.		Formats	for	exported	data	will	vary.	

Date-Time Parameters  

Many	reports	require	the	user	to	set	or	enter	one,	or	a	pair	of	dates.		Generally	this	is	done	in	a	
calendar	spin	box.		If	no	date	is	available	it	means	no	data	is	currently	available	for	that	date.	

 

Figure	57‐Accept	or	change	the	date	or	the	date	range	for	a	report.	

	

String/Unit Parameters 

Some	reports	can	be	restricted	to	a	particular	string	and/or	unit	by	selecting	them	in	the	tool	bar.		
The	default	is	‘All	Strings	and	Units’.		Users	can	also	display	data	for	Voltage,	Impedance,	Current,	
or	Temperature	by	selecting	the	appropriate	icon	in	the	tool	bar.	
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Figure	58‐	Selecting	Strings	and/or	Units	for	Reports	

	

 

If an icon is grayed out (unavailable) it cannot be used for the report 
type selected from the menu or side bar. 

 

Sorting Report Data 

Data	from	some	–	but	not	all	–	reports	can	be	sorted	by	clicking	on	the	column	title	or	on	a	sort	
arrow	in	the	title	row	(see	Figure	61,	page	84).		It’s	possible	to	sort	report	data	on	multiple	
columns	but	only	one	column	can	be	sorted	at	a	time.		

Highlighted Data 

Many	reports	display	data	row	entries	highlighted	in	red	or	yellow	if	the	data	is	outside	of	normal	
parameters	(see	Figure	63,	pg.	86).			

Printing Reports 

Some	–	but	not	all	–	reports	can	be	printed	from	the	File	menu	in	the	menu	bar.		If	the	Print	option	
is	unavailable	(grayed	out)	in	the	menu	list	the	data	must	be	exported	to	another	application	to	be	
printed.	

Dual Report Sources 

Some	reports	can	be	generated	from	multiple	sources	(typically	the	Home	screen	side	bar	and	the	
Reports	or	View	menu).		It	makes	no	difference	which	source	is	used.		The	individual	report	
descriptions	in	this	section	describe	all	sources	for	a	particular	report.	

BVM	Home	Screen	Side	Bar	Reports	

The	side	panel	of	the	Home	screen	provides	a	list	of	reports	and	graphs	that	BVM	can	generate		
(see	,	page	16).		All	sidebar	reports	are	also	available	from	Reports	in	the	menu	bar.			
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Figure	59‐The	Reports	menu	from	the	BVM4	main	screen.	

	

Measurement Listings Reports 

Clicking	Measurements	at	the	bottom	of	the	Home	screen	sidebar	displays	a	three‐page	log	report	
containing	data	described	below.		Default	dates	appear	in	the	date‐dialog	and	can	be	changed	by	
clicking	the	drop‐down	arrow	for	either	or	both	of	the	fields	(see	Figure	57,	page	80).		To	print	the	
report	data,	first	export	it	as	a	coma	delimited	file,	load	it	into	a	spreadsheet	application,	and	then	
print	it.	

 

This data is also available by selecting Measurement Listings in the View menu. 

Measurements Log  

This	log	is	tab	1	and	provides	a	chronological	listing	of	system	voltage,	system	current,	and	system	
temperature.		Data	in	this	report	cannot	be	sorted.	

Comments 

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 To	refresh	data	and	display	the	most	current	readings	select	View>Refresh	in	the	menu	
bar	or	press	F5.	

 The	column	widths	can	be	changed	by	moving	the	heading	column	border	right	or	left.	

 Notes	can	be	added	to,	and	edited	in,	the	report	by	right	clicking	and	selecting	the	‘Note’	
option	in	the	resulting	context	menu.	

 Data	can	be	deleted	from	the	report.	
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Figure	60‐The	Measurements	Log	–	Measurements	tab			

	
 
 

Discharge Intervals Logs    

This	report	is	tab	two	and	is	formatted	as	two	separate	tables.		It	provides	date	and	duration	data	
for	any	discharge	periods	occurring	during	the	covered	period,	(i.e.	any	periods	that	power	was	
supplied	from	the	battery	source	rather	than	the	power	grid).		The	top	panel	table	discharge	start	
date,	time,	and	duration;	the	bottom	table	displays	system	discharge	current,	system	voltage,	and	
ambient	temperature.			

Comments 

 Discharges:		Selecting	a	row	in	the	Discharges	log	(top	table)	determines	the	detail	data	
displayed	in	the	System	Discharge	log,	(bottom	table).	

 Data	contained	in	the	report	logs	can	be	exported	using	the	File>Export	option	in	the	
menu	bar.			

 The	column	widths	can	be	changed	by	moving	the	heading	column	border	right	or	left.	

 Notes	can	be	added	to,	and	edited,	in	the	report.	

 Data	can	be	deleted	from	the	report.	
 

Report	columns	can	be	
expanded	or	condensed	by	
dragging	the	column	
border	left	or	right.	

Right‐clicking	in	the	log	
screen	displays	a	context	
menu.		Select	“Edit	
Measurement	Note”
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Figure	61‐Discharge	and	System	Discharge	Measurement	Logs			

	

Alarms and Alerts Tab Log  

This	report	(called	the	“Alerts	and	Alarms	from	BVS”	in	the	Reports	menu)	provides	date‐time,	and	
type	of	alert	or	alarm	during	the	specified	period.		It	also	reflects	actions	taken	by	the	individual	
site	staff	and	records	the	identity	of	the	staff	member	updating	the	log	entry.	

 

Alarms and alerts can be acknowledged in this page.  See Acknowledging Alarms 
and Alerts , pg. 28. 

 

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 The	column	widths	can	be	changed	by	moving	the	heading	column	border	right	or	left.	

 Notes	can	be	added	to,	and	edited,	the	report.	
 

Figure	62‐The	Alarms	and	Alerts	Logs	(partial	illustration)	
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Side	Bar	Reports	

These	buttons	are	short	cuts	to	the	most	commonly	used	reports.		Each	of	the	reports	is	also	
available	underneath	“Reports”	in	the	menu	bar.	

System Analysis Report 

This	report,	(called	the	“Analysis	Report”	in	the	Reports	sub‐menu)	requires	the	user	to	select	a	
date/time.		It	shows	a	variety	of	statistical	information	about	the	voltage,	impedance,	and	
temperature	data	gathered	during	a	measurement.		Another	result	of	the	analysis	is	a	list	of	the	
unit	measurements	that	are	out‐of‐limits.		Depending	on	the	selection,	either	all	units	can	be	shown	
or	just	the	out‐of‐limits.	

Comments 

 The	column	widths	can	be	changed	by	moving	the	heading	column	border	right	or	left.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	
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Figure	63‐System	Analysis	Report	from	the	BVM	Main	Screen	Side	Bar	

	
 

Discharge Intervals 

This	report	(called	“Discharge	Durations”	in	the	Reports	menu)	requires	the	user	to	enter	a	
beginning	and	ending	date/time.		It	displays	the	date	and	time,	duration	and	any	notes	recorded	
for	the	selected	date	and	time	range.			

 

 

This report is essentially identical to the Discharges tab in the “Measurement 
Listing Report (see Discharge Intervals, page 86).  Using this report option 
enables the user to set specific dates. 

Comments 

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	
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 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 Report	data	can	be	sorted	by	clicking	the	arrow	in	the	column	heading.	
 

Figure	64‐Discharge	Intervals	(Home	screen	sidebar	–	partial	illustration)	

	

Alerts and Alarms Report 

This	report	displays	the	date,	time,	and	a	description	of	any	alerts	received	from	the	BVS over	the	
stipulated	range.		Any	notes	added	to	an	alert	by	a	user	are	also	shown.		The	date	and	time	the	
alarm	was	acknowledged	by	the	user	will	also	be	shown.		If	the	alarm	state	was	resolved,	(e.g.	a	
temperature	returning	to	within	limits),	the	date	and	time	are	also	shown.	

 

 

This report is essentially identical to the Alarms and Alerts tab in the 
“Measurement Listing Report (see Alerts and Alarms Report, page 87).  Using 
this report option enables the user to set specific dates. 

 

Comments  

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 Report	data	can	be	sorted	by	clicking	the	arrow	in	the	column	heading.	

 Right‐clicking	in	the	report	screen	displays	a	popup	menu	(described	below).	
 

Figure	65‐Alerts	and	Alarms,	Sidebar		(partial	illustration)	
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Filter and Sort Alarms and Alerts 

This	functionality	is	available	from	the	report’s	popup	menu.		It	enables	the	user	to	broaden	or	
restrict	the	report	results	according	to	selected	criteria.		It	also	allows	sort	criteria	to	be	defined.	

Figure	66‐Alarms	and	Alerts	Filter	screen	

	

Reports	Menu		

An	extensive	number	of	additional	reports	are	found	under	the	Reports	menu.		As	previously	noted	
some	items	are	available	in	the	Home	screen	sidebar	and	will	not	be	repeated	here.			

When	most	reports	are	selected	a	date	dialog	box	is	displayed	(see	Figure	57,	page	80).		For	some	
reports	the	user	must	enter	a	date	and	time	range	(or	accept	the	default).		In	other	cases	only	a	
single	date	is	necessary.	

 

 

If no date(s) appear in the drop‐down box no data is available for the report. 

Snapshot of Unit Measurements  

This	report	displays	all	the	voltage,	impedance,	and	temperature	measurements	taken	during	one	
read	of	the	BVS.		Any	units	with	measurements	exceeding	the	maintenance	limits	are	highlighted	in	
yellow	while	those	exceeding	the	critical	limits	are	shown	in	red.		The	measurement	(s)	(voltage,	
impedance,	or	temperature)	causing	the	out‐of‐limits	condition	are	displayed	in	bold.			

Comments 

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	
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 Users	can	move	the	report	date	backward	or	forward	by	right‐clicking	in	the	report	screen	
and	making	the	appropriate	selection	in	the	popup	menu	(see	below	–	inset).	

 Data	can	be	sorted	by	clicking	the	arrow	in	the	heading	row.	
 

Figure	67‐Snapshot	of	Unit	Measurements	Report	Example	(partial	illustration)	

	

Trend of System Measurements Report 

This	report	requires	the	user	to	enter	a	beginning	and	ending	date/time.		It	shows	the	system's	
voltage,	charge	current,	average	unit temp,	and	ambient	temp	over	the	date	and	time	selected.		Any	
measurements	exceeding	the	limits	are	shown	in	yellow	or	red.		The	measurement	(s)	(voltage,	
current,	or	temperature)	causing	the	out‐of‐limits	condition	are	displayed	in	bold.	

Comments 

 The	measurements	can	be	sorted	by	clicking	on	the	arrow	in	the	top	of	each	column.	

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

Figure	68‐	Trend	of	System	Measurements	Report	(partial	illustration)	

	

Trend of Unit Measurements Report 

This	report	requires	the	user	to	enter	a	beginning	and	ending	date/time.		It	shows	data	for	one	
unit’s	voltage,	impedance,	and	temperature	measurements	over	the	date	and	time	selected.		Any	
measurements	exceeding	maintenance	limits	are	highlighted	in	yellow	while	those	exceeding	
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critical	limits	are	shown	in	red.		The	measurement	(s)	(voltage,	impedance,	or	temperature)	
causing	the	out‐of‐limits	condition	is	displayed	in	bold.   

Comments 

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Users	can	move	the	selected	unit	backward	or	forward,	or	select	it	directly	by	right‐clicking	
in	the	report	screen	and	making	the	appropriate	selection	in	the	popup	menu	(see	below	–	
inset).	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 The	measurements	can	be	sorted	by	clicking	on	the	arrow	in	the	top	of	each	column.	

Figure	69‐Trend	of	Unit	Measurement	Report	(partial	illustration)	

	

Trend of String Measurements Report 

This	report	requires	the	user	to	enter	a	beginning	and	ending	date/time.		It	shows	one	or	more	
string's	charge	current	spanning	the	date	and	time	selected.		With	the	latest	firmware,	the	reports	
will	also	show	the	individual	string	voltages.		Any	current	measurements	exceeding	the	string	
charge	current	limit	or	voltage	measurements	outside	the	voltage	limits	are	highlighted	in	red.			

Comments 

 The	measurements	can	be	sorted	by	clicking	on	the	arrow	in	the	top	of	each	column.	

 Users	can	select	individual	Strings	and	units	for	the	report	in	the	tool	bar.	

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 Users	can	select	individual	units	or	All	units	by	right‐clicking	in	the	report	screen	and	
making	the	appropriate	selection	in	the	popup	menu	(see	below	–	inset).	
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Figure	70‐	Trend	of	String	Measurements	(partial	illustration)	

	

Trend of Temperature Measurements Report 

This	report	requires	the	user	to	enter	a	beginning	and	ending	date/time.		It	shows	the	temperature	
measurements	trended	over	the	date	and	time	selected.		Any	measurements	exceeding	the	limits	
are	highlighted	red.			

Comments 

 The	measurements	can	be	sorted	by	clicking	on	the	arrow	in	the	top	of	each	column.	

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 Users	can	select	a	specific	sensor	to	report	on	by	selecting	it	from	a	drop‐down	list	in	the	
tool	bar.	

 Users	can	select	individual	sensors	or	All	sensors	by	right‐clicking	in	the	report	screen	and	
making	the	appropriate	selection	in	the	popup	menu	(see	below	–	inset).	

 

Figure	71‐	Trend	of	Temperature	Measurements	(partial	illustration)	
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Discharge Durations Report 

This	report	requires	the	user	to	enter	a	beginning	and	ending	date/time.		It	displays	the	date/time	
the	discharge	took	place	and	the	length	of	time	it	lasted.			

Comments 

 The	measurements	can	be	sorted	by	clicking	on	the	arrow	in	the	top	of	each	column.	

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	
 

Figure	72‐Discharge	Durations	Report	

	

Cumulative Durations Report 

This	report	requires	the	user	to	enter	a	beginning	and	ending	date/time.		It	shows	the	cumulative	
number	and	duration	of	discharges	over	the	selected	date	and	time	range.		It	also	shows	the	
distribution	of	discharges	by	duration.		For	each	duration	category,	it	lists	the	number	of	
discharges,	its	percentage	of	the	total	number	of	discharges,	the	cumulative	discharge	time,	and	the	
percentage	of	the	total	discharge	time.		

The	duration	categories	can	be	changed	in	the	Change	Discharge	Duration	Grouping	screen	
accessed	from	the	View	menu	(see	Figure	37,	pg.54).	

Comments 

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 The	grouping	for	the	Discharge	Data	can	be	re‐grouped	by	right‐clicking	in	the	report	
screen	and	selecting	Change	Discharge	Duration	Group,	see	below	–	inset).	
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Figure	73‐Cumulative	Durations	Report	(partial	illustration)	

	

Discharge Duration Grouping Screen 

This	screen	is	used	to	view	or	modify	the	15	categories	groupings.	

Figure	74‐Discharge	Duration	Grouping	screen	

	

System Discharge Measurements Report 

This	report	requires	the	user	to	enter	a	beginning	and	ending	date/time.		It	shows	the	system's	
voltage,	discharge	current,	average	unit	temp,	and	ambient	temp	while	the	battery	is	undergoing	
discharge.		Any	measurements	exceeding	the	discharge	limits	are	shown	in	red.		The	
measurements	(voltage,	current,	or	temperature)	causing	the	out	of	limits	condition	are	displayed	
in	bold.		Any	current	measurements	exceeding	the	system	charge	current	limit	or	voltage	
measurements	outside	the	voltage	limits	are	highlighted	in	red.			

Comments 

 The	Date/Time	entries	can	be	sorted	by	clicking	on	the	arrow	in	the	top	of	each	column.	

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 If	the	system	voltage	and	current	are	both	available,	the	discharge	performance	is	
calculated	and	shown	at	the	bottom	of	the	report.	
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Figure	75‐System	Discharge	Measurements	Report	(partial	illustration)	

	

String Discharge Measurements Report 

This	report	requires	the	user	to	enter	a	beginning	and	ending	date/time.		It	shows	discharge	
current	while	the	battery	is	in	a	discharge	for	one	or	more	strings.		With	the	latest	firmware,	the	
reports	also	show	the	individual	string	voltages.		Any	measurements	exceeding	the	string	
discharge	current	limit,	or	the	voltage	limits,	are	highlighted	in	red.			

Comments 

 The	measurements	can	be	sorted	by	clicking	on	the	arrow	in	the	top	of	each	column.	

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 The	user	can	select	a	specific	string	for	the	report	by	selecting	it	from	a	drop‐down	list	in	
the	tool	bar;	or	by	right‐clicking	in	the	report	screen	and	selecting	it	from	the	the	Display	
String	sub‐menu,	see	below	–	inset).	

 If	one	string	is	selected	and	the	string	voltage	and	current	are	both	available,	the	discharge	
performance	is	calculated	and	shown	at	the	bottom	of	the	report.	
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Figure	76‐String	Discharge	Measurements	Report	(partial	illustration)	

	

Temperature Discharge Measurements Report 

This	report	requires	the	user	to	enter	a	beginning	and	ending	date/time.		It	shows	the	temperature	
measurements	over	the	date	and	time	selected.		Any	measurements	exceeding	the	limits	are	
highlighted.			

Comments 

 The	measurements	can	be	sorted	by	clicking	on	the	arrow	in	the	top	of	each	column.	

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 The	user	can	select	a	specific	string	to	report	on	by	selecting	it	from	a	drop‐down	list	in	the	
tool	bar.	

 

Figure	77‐Temperature	Discharge	Measurements	Report	(partial	illustration)	
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Unit Discharge Measurements Report 

This	report	requires	the	user	to	enter	a	beginning	and	ending	date/time.		It	shows	one	unit's	
voltage	and	temperature	measurements	while	the	battery	is	in	discharge.		Any	measurements	
exceeding	the	discharge	limits	are	highlighted.		The	measurement	(voltage	or	temperature)	
causing	the	out	of	limits	condition	is	displayed	in	bold.			

Comments 

 The	measurements	can	be	re‐sorted	by	clicking	on	the	arrow	in	the	top	of	each	column.	

 Data	from	this	report	can	be	printed	using	the	File>Print	menu	function.	

 Data	from	this	report	can	be	exported	using	the	File>Export	data	menu	function.	

 The	user	can	select	a	specific	string	and	limit	to	report	on	by	selecting	it	from	a	drop‐down	
list	in	the	tool	bar;	or	by	right‐clicking	in	the	report	screen	a	nd	selecting	it	from	the	the	
Display	String	sub‐menu,	see	below	–	inset).	

 If	string	current	is	available,	the	discharge	performance	is	calculated	and	shown	at	the	
bottom	of	the	report.	

 

Figure	78‐Unit	Discharge	Measurements	Report	(partial	illustration)	
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8. Graphs 
The	BVM4	graphing	options	are	accessed	from	the	menu	bar	and,	in	some	cases	the	Home	screen	
side	bar	(see	,	page	16).		Some	S5	data	can	be	graphed	on	up	to	four	parameters	(Voltage,	Current,	
Impedance,	and	Temperature).		Graphs	can	be	printed	either	by	selecting	Print	from	the	File	menu	
or	clicking	the	Print	icon	in	the	Icon	bar.	

The	graphing	feature	uses	the	range	and	other	parameters	entered	when	configuring	the	BVM	4	
software.		Symbols	and	colors	can	be	chosen	or	changed	using	the	customization	feature.	

 

Figure	79‐Selecting	graph	

	
 

 

If an icon is grayed out (unavailable) it cannot be used for the graph 
type selected from the menu or side bar. 

General Information 

Date-Time Parameters  

Most	reports	require	the	user	to	enter	one,	or	a	pair	of	dates	and	times	(see	below).		Generally	this	
is	done	in	a	calendar	spin	box.		If	no	date	is	available	it	means	no	data	is	currently	available	for	the	
graph.		BVM	will	generally	display	default	dates/times	which	can	be	changed.			

 

Figure	80‐Date‐Time	Spin	box.		Some	boxes	only	have	one	entry	

	

Viewing Individual Unit and String Measurements 
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Many	graphs	include	a	feature	allowing	a	user	to	view	individual	measurements	for	specific	data	
points.		Placing	the	cursor	on	a	graphed	measuring	point	will	display	a	‘tool	tip’	showing	the	actual	
measurement	data	(see	Figure	83,	page	101).		Most	illustrations	in	this	section	include	examples	of	
this	feature.	

Exporting Graphs 

Most	graphs	can	be	exported	in	one	or	more	graphical	formats	by	selecting	File	in	the	menu	bar	
and	clicking	Export	Graphic.		A	submenu	of	options	is	displayed	showing	the	available	export	
format	options.			

Printing Graphs 

Some	–	but	not	all	–	graphs	can	be	printed	directly	from	the	File	menu	in	the	menu	bar.		If	the	Print	
option	is	unavailable	in	the	menu	list	the	data	must	be	exported	to	another	application	to	be	
printed.	

Graph Menu 

The	BMV4	Graph	menu	includes	the	options	shown	in	Figure	67.		Note	that	not	all	graphs	are	
available	at	all	times.		After	selecting	the	graph	title	and	entering	dates,	one	or	more	of	the	
parameter	icons	(current,	impedance,	temperature,	or	voltage)	may	be	available	in	the	icon	bar.	
Selecting	one	of	these	icons	determines	precisely	which	measurement	will	be	graphed.			

When	a	particular	graph	style	can	be	switched	among	several	different	parameters	(one	at	a	time)	
pressing	F10	will	cycle	through	the	available	parameters.	

Sources for Graphs 

Some	Graphs	can	be	generated	from	multiple	sources	(typically	the	Home	screen	sidebar	and	the	
Graphs	menu).		It	makes	no	difference	which	source	is	used.		In	either	case	date/time	parameters	
usually	must	be	entered.		In	a	few	instances	graphs	common	to	two	sources	have	slightly	different	
titles	in	each	source.		When	this	occurs	both	titles	are	referenced	in	the	specific	graph	descriptions	
later	in	this	section.			

 

 

Graphs available from multiple sources will only be described once this section.  
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Figure	81‐The	BVM4	‘Graphs’	drop‐down	menu	

	

Setting Graph Display Parameters and Features 

Many	of	the	Graphing	parameters	such	as	dates	are	selected	at	the	time	the	graph	is	created.		Other	
parameters	such	as	ranges	are	set	when	the	software	is	configured.		All	graph	styles	have	default	
settings.		Some	display	parameters	for	some	graphs,	such	as	bar	and	line	colors,	marker	symbols,	
etc.,	can	be	changed	when	the	graph	is	open	and	selected	by	using	the	View	menu,	(see	Figure	82,	
below).			

 These	commands	are	also	available	(on	an	individual	graph	basis)	from	a	context	menu	
that	is	displayed	by	right‐clicking	on	the	graph.	

 Graphs	can	be	saved	as	an	image	file	(bmp,	jpg,	gif,	or	png)	using	the	Export	Graphics	
function	found	in	the	File	menu.			

 

 

Not all graphs can have their formats changed and not all display parameters 
can be changed for all graphs.  When a graph is selected only the options that 
appear under the View menu or in the popup menu can be changed. 

 

The Graphs View Menu 

The	View	menu	can	be	used	to	control	the	display	a	large	number	of	color,	symbol,	and	marker	
shapes	used	in	a	graph.	The	graph	illustration	used	in	this	section	show	a	variety	of	these	options.		
The	actual	options	available	in	the	menu	depend	on	the	selected	graph	type.		Both	the	items	and	
the	options	shown	in	the	menu	will	vary.	Not	all	options	are	available	for	all	graphs.			

 

 

The View menu can be ‘popped up’ as a context menu within a graph panel by 
right‐clicking. 
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Figure	82‐An	extended	example	of	the	View	menu.	

	

BVM	Home	Screen	Side	Bar	Graphs	

The	side	panel	of	the	Home	screen	provides	a	list	of	reports	and	graphs	that	BVM	can	generate	(see		

Figure	8,	page	16).		Some	sidebar	reports	are	also	available	from	the	Reports	menu	bar.		

Unit Snapshot Graph 

This	graph	–	called	the	Snapshot	of	Unit	Measurements	in	the	Graphs	menu	–	can	be	displayed	for	
either	unit	voltage,	impedance,	or	temperature	measurements	taken	during	one	‘read’	on	one’	
specified	date.		It	requires	the	user	to	select	a	specific	date	from	a	drop‐down	list.		Users	must	
enter/select	a	date	for	the	graph.	

The	unit	numbers	are	shown	on	the	x‐axis	while	the	voltage,	impedance,	and	temperature	values	
are	shown	on	the	y‐axis.		Position	the	mouse	pointer	over	the	measurement	point	to	view	the	unit	
number	and	exact	measurement	value	in	a	tool	tip.		Double‐clicking	on	the	measurement	of	a	
particular	unit	will	open	a	Unit	Trend	Graph	of	that	unit.	

Comments 

 This	graph	can	be	generated	for	Current,	Impedence.	or	Temperature	by	clicking	the	
appropriate	icon	in	the	icon	bar,	or	by	pressing	F10.	

 Individual	Graph	data	can	be	exported	or	printed	using	the	File	menu.	

 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 The	user	can	elect	to	graph	data	for	all	strings,	or	select	a	specific	string	from	a	drop‐down	
list	in	thed	tool	bar.	

 Data	can	be	displayed	as	either	bars	(shown)	or	data	points	by	pressing	F8.	
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Figure	83‐Unit	Snapshot	[of	Unit	Measurements]	Graphs	for	Voltage,	Impedance,	and	Temperature		

	

Unit Trend Graph 

This	graph	–	called	the	Trend	of	Unit	Measurements	in	the	Graphs	menu	–	show	one	unit’s	Voltage,	
Impedance,	or	Temperature	for	a	user‐specified	range	of	dates.		The	graph's	x‐axis	will	vary	
depending	on	the	period	of	time	selected.			

The	unit	maintenance	voltage	limits	are	represented	by	two	purple	dashed	lines.		Critical	limits	are	
represented	by	two	red	lines.		The	unit	float	voltage	should	remain	steady	between	those	two	
limits.		A	best‐fit	curve	of	the	voltage	and	impedance	measurements	is	graphed	to	assist	the	user	in	
spotting	a	rising	or	falling	unit	voltage	or	impedance.		To	disable	this	feature,	un‐check	the	Display	
Best	Fit	Voltage	Measurement	Trend.	

Comments 

 This	graph	can	be	generated	for	Current,	Impedence.	or	Temperature	by	clicking	the	
appropriate	icon	in	the	icon	bar	or	pressing	F10.	

 Users	can	select	a	specific	string	and	unit	from	the	drop‐down	list	in	the	tool	bar.	

 Individual	Graph	data	can	be	exported	or	printed	using	the	File	menu.		

 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 Data	can	be	graphed	as	either	data	points	(shown)	or	bars	by	pressing	F8.	
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Figure	84‐Unit	Trend	(Trend	of	Unit	Measurement)	Graphs	for	Voltage,	Impedance,	and	Temperature		

	

Temp Trend 

Called	“Trend	of	Temperature	Measurements”	in	the	Graphs	menu,	it	shows	the	temperature	
measurements	trended	over	the	dates	and	times	selected.			

To	increase	or	decrease	the	date	and	time	range	of	the	displayed	measurements,	use	the	Zoom	In	
or	Zoom	Out	selection	in	the	View	menu.			

 

Figure	85‐	Temperature	Trends	(Trend	of	Temperature	Measurements)	Graph	

	

Comments 

 Individual	Graph	data	can	be	exported	or	printed	using	the	File	menu.	

 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 Users	can	select	a	specific	sensor	from	the	drop‐down	list	in	the	tool	bar.	

 Data	can	be	graphed	as	either	data	points	(shown)	or	bars	by	pressing	F8.	
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String Trend 

Called	the	“Trend	of	String	Measurements	Graph”	in	the	Graphs	menu	–	it	shows	string	charge	
currents	over	a	period	of	time.		With	the	latest	firmware,	the	graphs	will	also	show	the	individual	
string	voltages.		The	graph's	x‐axis	varies	depending	on	the	time	period	selected.			

Figure	86‐String	Trend	(Trend	of	String	Measurements)	Graph	

	

Comments 

 Any	current	measurements	exceeding	the	string	charge	current	limit	or	voltage	
measurements	outside	the	voltage	limits	are	highlighted	in	red.	

 Individual	Graph	data	can	be	exported	or	printed	using	the	File	menu.		

 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 Data	can	be	graphed	as	either	data	points	(shown)	or	bars	by	pressing	F8.	

 The	user	can	graph	data	from	a	specific	string	by	selecting	it	from	a	drop‐down	list	in	the	
tool	bar.	

System Trend 

Called	the	“Trend	of	System	Measurements”	in	the	Graphs	menu	–	it	shows	the	system’s	Voltage,	
Charge	Current,	or	Average	Unit	Temperature,	and	Ambient	Temperature	for	a	user‐	specified	
range	of	dates.		The	graph's	x‐axis	varies	depending	on	the	period	of	time	selected.		 
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Figure	87‐System	Trend	(Trend	of	System	Measurements)	Graph			
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Discharge	Graphs	–	Menu	Bar	

Power Outage Intervals Graph 

This	graph	shows	the	distribution	of	discharges	for	hours‐of‐the‐day,	days‐of‐the‐week,	or	
months‐of‐the‐year	over	the	user‐determined	date	and	time	range.		The	distribution	of	discharges	
by	the	duration	of	the	outages	can	also	be	graphed.		The	data	can	be	classified	either	by	the	number	
of	discharges	or	by	the	discharge	durations,	

Comments 

 The	duration	categories	can	be	changed	in	the	Change	Discharge	Duration	Grouping	screen	
accessed	from	the	View	menu.		

 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 The	graph	can	be	saved	as	an	image	file	(bmp,	jpg,	gif,	or	png)	using	the	Export	Graphics	
function	found	in	the	File	menu.	

 The	graph	can	be	printed	from	the	File	menu.	
 

Figure	88‐Power	Outage	Interval	Graph		

	

Snapshot of Unit Discharge Measurements Graph 

These	graphs	depict	the	voltage	and	temperature	measurements	taken	during	one	measurement	
scan	for	either	a	single	string	or	all	strings	in	the	battery	system.		The	graph's	x‐axis	varies	
depending	on	the	period	of	time	selected.	

Any	measurements	exceeding	the	discharge	limits	are	highlighted.		If	a	unit	is	replaced,	the	
measurements	taken	before	the	new	(replacement)	unit	is	installed	are	dimmed.		To	determine	the	
date	and	exact	measurement	value	represented	by	a	yellow	diamond,	place	the	mouse	cursor	over	
the	measurement.		The	string	and	unit	number	and	value	are	shown	in	a	tool	tip.	

Comments 

 To	scroll	the	time	of	the	displayed	measurements,	use	the	left	and	right	arrow	keys.	

 Use	F10	to	toggle	between	the	unit	voltage	and	unit	temperature.	

 To	toggle	between	data	points	(shown),	or	bars	press	F8.	

 BVM	can	graph	average,	initial,	max,	min,	and	limits	data.		Each	data	type	can	be	enabled	
and	disabled	in	the	View	menu.			
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 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 The	Page	Up	and	Page	Down	keys	can	be	used	to	change	the	graph	to	the	previous	or	next	
unit's	data.	

 To	increase	or	decrease	the	date	and	time	range	of	the	displayed	measurements,	use	the	
“Zoom	In”	and	“Zoom	Out”	selections	in	the	View	menu.	

 The	user	can	sellect	all	strings	or	specific	strings	from	a	drop‐down	list	in	the	tool	bar.	

 Double‐clicking	on	the	measurement	of	a	particular	unit	will	open	a	Unit	Trend	Graph	of	
that	unit.	

 

Figure	89‐	Voltage	and	Temperature	Discharge	Measurements	Graph		

	

System Discharge Voltage and Current Measurements Graphs 

These	graphs	show	the	system's	voltage,	current,	average	temp,	and	ambient	temp	while	the	
battery	is	in	a	discharge.		The	graph's	x‐axis	will	vary	depending	on	the	time	period	selected.		The	
string	discharge	current	limit	is	shown	as	a	purple	dashed	line.		The	current	should	remain	below	
the	line	during	the	discharge	operation.		On	the	string	voltage	graph,	the	discharge	voltage	limits	
are	represented	by	two	dashed	lines.		The	string	voltage	should	not	go	below	these	limits	during	a	
discharge.	

Comments 

 Use	the	F10	key	to	toggle	between	graphs	for	Voltage	and	Temperature.	

 To	scroll	the	date	and	time	of	the	displayed	measurements	use	the	left	and	right	arrow	
keys.	

 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 The	graph	can	be	saved	as	an	image	file	(bmp,	jpg,	gif,	or	png)	using	the	Export	Graphics	
function	found	in	the	File	menu.	

 The	graph	can	be	printed	from	the	File	menu.	
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Figure	90‐System	Discharge	Voltage	and	Current	Trend	Graphs		

	

String Discharge Measurements Graph  

This	graph	shows	string	discharge	current	taken	from	the	battery	during	discharge.		With	the	latest	
firmware,	the	graphs	will	also	show	the	individual	string	voltages.		The	graph's	x‐axis	will	vary	
depending	on	the	period	of	time	selected.	

The	string	discharge	current	limit	is	shown	as	a	purple	dashed	line.		The	current	should	remain	
below	this	line	during	the	discharge	operation.		On	the	string	voltage	graph,	the	discharge	voltage	
limits	are	represented	by	two	dashed	lines.		The	string	voltage	should	remain	between	these	limits	
during	a	discharge	or	an	alarm	will	be	generated.	

Comments 

 The	graph	can	be	saved	as	an	image	file	(bmp,	jpg,	gif,	or	png)	using	the	Export	Graphics	
function	found	in	the	File	menu.	

 The	graph	can	be	printed	from	the	File	menu.		

 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 The	user	can	graph	data	for	individual	strings	by	selecting	a	string	from	a	drop‐down	list	in	
the	tool	bar.	
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Figure	91‐String	Discharge	Measurement	Graph	(partial	illustration)	

	
 

To	scroll	the	date	and	time	of	the	displayed	measurements,	use	the	left	and	right	arrow	keys.		To	
determine	the	date	and	exact	measurement	value	represented	by	a	red	diamond,	place	the	mouse	
cursor	over	the	measurement.		The	measurement	and	its	value	are	shown	in	a	pop‐up	window.		To	
increase	or	decrease	the	date	and	time	range	of	the	displayed	measurements,	use	the	Zoom	In	or	
Zoom	Out	selection	in	the	View	menu.	

Temperature Discharge Measurements Graph 

This	graph	shows	the	temperature	sensor	measurements	taken	while	the	battery	is	under	
discharge.		The	graph's	x‐axis	will	vary	depending	on	the	period	of	time	selected.		The	red	dashed	
line	on	the	temperature	graph	shows	the	temperature	limits.	Both	the	ambient	and	temperature	
measurement	should	remain	within	the	limits.	

Comments 

 The	graph	can	be	saved	as	an	image	file	(bmp,	jpg,	gif,	or	png)	using	the	Export	Graphics	
function	found	in	the	File	menu.		

 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 The	graph	can	be	printed	from	the	File	menu.	

 The	data	can	be	graphed	as	bars	or	data	points	(shown).	

 The	user	can	select	individual	sensors	from	a	drop‐down	list	in	the	tool	bar.	
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Figure	92‐Temperature	Discharge	Measurement	Graph	

	

Unit Discharge Measurements Graphs 

These	graphs	show	one	unit’s	voltage	or	temperature	measurements	taken	while	the	battery	is	
under	discharge.		The	graph's	x‐axis	will	vary	depending	on	the	period	of	time	selected.	

To	determine	the	date	and	exact	measurement	value	represented	by	a	yellow	diamond,	place	the	
mouse	cursor	over	the	measurement.		The	string	and	unit	number	and	value	will	be	shown	in	tool	
tip.	To	increase	or	decrease	the	date	and	time	range	of	the	displayed	measurements,	use	the	Zoom	
In	or	Zoom	Out	selection	in	the	View	menu.	

On	the	unit	Voltage	graph,	the	unit	discharge	voltage	limits	are	represented	by	two	colored	dashed	
lines.		The	unit	voltage	should	not	go	below	these	voltages	during	a	discharge.		Unit	Temperatures	
during	discharge	are	also	available	on	the	graph.		During	a	discharge,	unit	temperatures	will	
elevate	within	a	reasonable	range.		

Comments 

 The	graph	can	be	saved	as	an	image	file	(bmp,	jpg,	gif,	or	png)	using	the	Export	Graphics	
function	found	in	the	File	menu.	

 The	graph	can	be	printed	from	the	File	menu.	

 If	a	unit	is	replaced,	the	measurements	taken	before	the	replacement	unit	is	installed	are	
dimmed.		

 The	user	can	toggle	between	bars	and	datapoints	(shown)	by	pressing	F8.	

 Placing	the	cursor	on	a	bar	or	symbol	will	display	individual	unit	data	in	a	tool	tip.	

 Use	F10	to	toggle	between	the	unit	Voltage	and	unit	Temperature.	

 The	user	can	select	a	string	and	unit	from	a	drop‐down	list	in	the	tool	bar.	
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Figure	93‐Unit	Discharge	Measurements	Graph	
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Installing	BVM	4.x	Software	on	a	Server	
When	the	BVM	4.x	software	is	installed	to	a	server	or	dedicated	workstation	use	the	
following	procedure.		The	installation	software	can	be	downloaded	from	the	BTECH	web	
site	or	run	from	the	BTECH	installation	CD.			

a. Do	one	of	the	following:	
 Insert	the	BVM	software	CD‐ROM	into	the	machine’s	CD	drive	and	close	the	tray.		In	

a	few	moments	the	Autoplay	panel	is	displayed.	

 Navigate	to	the	“Downloads”	directory.	

b. Click	run	BVM_4.x.x_Setup.exe		
c. In	the	resulting	options	dialog	select	Install	BVS	Observer,	
 NOTE:		It	is	not	necessary	to	include	the	USB	Comm	Port	driver	for	server‐based	

installations.	

The	Update	System	panel	is	displayed	showing	a	progress	bar	indicating	the	installation	
status.		If	the	BVM	Software	Activation	dialog	is	displayed	refer	to	THE	FOLLOWING	STEP	IS	
ONLY	REQUIRED	IF	THE	ACTIVATE	BVS	OBSERVER	SOFTWARE	DIALOG		
IS	DISPLAYED	

 Click	Finish	when	the	successful	installation	window	is	displayed.			

Setting Up BVM Observer Services 

One	or	two	services	must	be	configured	when	Observer	is	run	on	a	server.		BTECH	Observer	
Services	collects	data	from	the	S5	controller	(including	Alarms	and	Alerts).		The	BTECH	
Email	Data	Services	emails	data	to	BTECH	if	the	customer	has	contracted	to	have	BTECH	do	
the	monitoring.			

Opening the Services Window 

To	access	either	service	use	the	following	procedure,	

a. Click	the	Windows	Start	button	and	type	“services”	in	the	“Search	files	and	
programs”	text	box.	

b. In	the	response	screen	click	Services.		The	Services	screen	is	displayed.	
c. Select	BTECH	Observer	Service	in	the	list	and	right‐click.		In	the	resulting	tabbed	

screen	click	Log	On,	(see	Figure	94	below).	
d. Select	the	This	account	radion	button	and	complete	the	field.		Enter	a	password	and	

confirm	it	in	the	fields	provided,	
 The	system	will	use	the	default	passwords	unless	these	entries	are	changed.	

e. Click	Apply	to	enforce	the	changes.	

IF	the	BTECH	Email	Data	Services	function	will	be	used	–	repeat	this	procedure	after	
selecting	it	from	the	Service	list.	

Restarting the Services 

Once	the	services	have	been	configured	they	must	be	restarted.		For	each	service	to	be	
utilized	do	the	following:	
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a. Select	each	of	the	service(s)	to	be	restarted	and	right	click.	
b. In	the	popup	menu	click	Restart.	

 

Figure	94‐Configuring	BTECH	Observer	Service	

	



	
S5	Operating	Manual	

	 Appendix 

 

Ver.	2.0	(August	2012)			 P a g e 	|	114	

	
 

Installing and Configuring SQL Server Software 

For	larger	sites	(approximately	20	or	more	BTECH	BVS	S5	units)	BTECH	recommends	using	
Microsoft	SQL	Server	Express	(in	place	of	Microsoft	Access)	as	the	backend	database.		Server	
Express	is	usually	included	on	the	BTECH	installation	CD.		In	situations	where	a	location	has	
increased	the	number	of	S5	units	over	time,	Server	Express	can	installed	to	replace	Access,	
see	“Converting	to	SQL	from	MS	Access”,	pg.	126.		If	a	full	version	of	SQL	is	available	it	can	
also	be	used.	

 

SQL Server Express 2008 can be installed as the database engine regardless of the 
battery system size.  It may be advisable to include it in the initial installation to 
avoid having to complete the conversion process at a later time.  

Password Authentication 

The	BVM	software	can	use	either	SQL	or	Windows	authentication	to	connect	to	the	database	
server.		The	type	of	authentication,	username,	and	password	will	be	part	of	the	
configuration	for	each	of	the	software	components.		By	default,	there	are	two	SQL	logins;	
one	is	for	web	access	and	the	other	is	for	BVM	access.		Each	uses	the	same	default	password:	
“p@ssw0rd”.		

 

 

BTECH strongly recommends changing the password to more secure versions and 
then changing them periodically. 

Installing SQL Server Express 2008 

The	SQL	Server	Express	2008	and	the	SQL	Server	Management	Tools,	together	with	the	
installation	application,	are	included	on	the	BVM	installation	disk.		Both	32‐bit	and	64‐bit	
versions	of	SQL	Express	are	available.		Be	certain	to	install	the	correct	version	for	the	host	
operating	system.	

Once	the	installation	is	complete,	the	TCP/IP	protocol	needs	to	be	enabled	if	the	battery	
data	will	be	accessed	by	a	remote	machine	running	BVM	or	BVS	Status	Monitor	software.		
To	enable	TCP/IP,	launch	the	SQL	Server	Configuration	Manager.		Under	the	SQL	Server	
Network	Configuration,	enable	TCP/IP	and	then	restart	the	SQL	Server	service	under	SQL	
Server	Services.	

 

 

This guide section depicts a full install to a machine that does not have 
an existing SQL Express version resident and active.   

 

To	install	SQL	Express	2008	from	the	BTECH	installation	disc	do	the	following:	

a. Use	Windows	Explorer	to	navigate	to,	and	download	the	executable	install	file	from	
the	BTECH	installation	CD	–	
 SQLEXPRWT_x86_ENU.exe.	(32‐bit),	or		
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 SQLEXPRWT_x64.exe	(64‐bit),		

By	default,	Windows	downloads	all	files	to	the	Download	folder.		This	can	be	changed	in	the	
download	dialog	if	necessary.	

b. Double‐click	on	the	correct	installation	file.		A	number	of	files	are	extracted	and	a	
number	of	progress	bar	dialogs	are	displayed	in	succession.			

 

 

Be certain to download and install the correct file – 32‐bit or 64‐bit, for 
the host system OS.  If the wrong program version is installed, delete it 
completely using the Widows Control panel and repeat this procedure 
for the correct program. 

 

c. In	the	SQL	Server	Express	Installation	Center	screen,	select	the	“New	Installation	or	
add	features	.	.	“	option	(see	Figure	95	below),	

d. After	verifying	that	the	installation	computer	has	the	necessary	hardware	–	accept	
the	license	terms	and	conditions	by	clicking	Next.		The	Setup	Support	Files	screen	is	
displayed	with	a	progress	bar	at	the	bottom.	
 The	install	process	next	displays	the	Set	Up	Rules	screen	with	a	progress	bar	at	the	

bottom.	

e. The	Set‐up	program	continues	the	install	displaying	a	number	of	informational	
dialogs	and	progress	bar	panels.	

 

Figure	95‐The	initial	SQL	installation	screen	

	

Installing SQL Express 2008 Features 

The	Feature	Selection	dialog	is	displayed	automatically.		It	is	not	necessary	(or	advisable)	to	
install	all	of	the	available	features.		In	the	Feature	Selection	screen	do	the	following:	

a. Clear	the	checkbox	for	SQL	Server	Replication	(if	it	is	checked),	
b. Leave	the	following	items	selected	(or	select	them	if	necessary):	
 Database	Selection	Services,	

 Management	tools	–	basic,	

 SQL	Client	Connectivity	SDK.	

c. Click	Next.	
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Figure	96‐The	SQL	Express	Server	Feature	Selection	screen	

	

Naming the Instance  

Once	the	base	installation	is	complete	the	following	items	must	be	added,	(see	Figure	97,	
below).	

a. Select	the	Named	Instance	radio	button	(if	necessary),	
b. Accept	the	default	or	change	the	following:	
 Named	instance	entry,	

 Instance	id	entry,	

 Instance	root	directory	entry.	

c. Click	Next	to	proceed	to	the	configuration	portion	of	the	installation.	



	
S5	Operating	Manual	

	 Appendix 

 

Ver.	2.0	(August	2012)			 P a g e 	|	117	

	
 

Configuring	the	Database	Engine	–	Server	Accounts	Tab,	
Accounts	Provisioning	Tab	

The	Database	Engine	Configuration	screen	is	displayed	and	must	be	configured	as	described	
below	(see	Figure	98,	pg.	118).		Some	items	are	specific	to	the	particular	server.	

Server Accounts Tab – 

a. In	the	Server	Accounts	tab	use	the	drop‐down	arrow	to	set	Start	up	type	for	both	the	
SQL	Server	Database	engin	AND	the	SQL	Server	Browser	entries	to	Automatic,	(see	
Figure	99)	Click	Next	to	proceed	to	the	Account	Provisioning	tab,	

Figure	97‐Instance	Configuration	Screen	

	
 

Account Provisioning Tab – 

This	tab	sets	user	authentication	requirements	and	passwords.	

a. Select	the	Radio	button	for:	Mixed	Mode	(SQL	Server	.	.	.).		This	enables	the	use	of	
both	SQL	and	Windows	authentication,	(see	Figure	98,	below).	

b. Enter	and	confirm	a	password	and	click	Next,	then	Next	again	to	start	the	
configuration.	

The	installation	will	run	for	several	minutes	and	display	various	informational	and	progress	
dialogs.			

c. Once	the	install	program	indicates	that	the	process	is	complete,	click	Close	to	close	
the	SQL	setup	panel	and	click	Close	again	to	close	the	Install	center.			

 

 

 The password entries MUST conform to minimum requirements or an error 
message is displayed.    

 The current and any additional users can be added via the buttons beneath the 
‘…administrators’ list box 
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Figure	98‐Account	Provisioning	tab	

	
 

Figure	99‐Service	Accounts	tab	

	

Configuring	and	Controlling	SQL	Network	Access	

By	default	SQL	Express	does	not	have	network	access.		It	must	be	turned	on	using	the	
management	tools.		In	the	programs	list,	navigate	to:	

Microsoft	SQL	Server	2008	R2>SQL	Server	Management	Studio>Configuration	Tools>SQL	
Server	Configuration	Manager.		

Configuring Network Access to Server Express 

a. Click	the	Widows	Start	button,	and	select	All	Programs,	
b. Click	Microsoft	SQL	Server	2008	to	expand	it	and	select	and	expand	Configuration	

tools	in	the	resulting	list,	
c. Select	SQL	Server	Configuration	Manager	to	display	the	properties	panels,		
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d. In	the	left	panel	select	and	expand	SQL	server	newtwork	configuration,	
e. Select	Protocols	for	SQL	Express	in	the	expanded	list	and	–		
f. in	the	right	panel,	right‐click	on	TCP/IP,	
g. select	Enable	from	the	pop‐up	menu	and	click	OK	in	the	Warning	dialog.	
h. Return	to	the	left	panel	and	select	SQL	Server	Services		
i. Right‐click	SQL	Server	(SQL	Express)	in	the	right	panel	and	select	Stop	in	the	popup	

menu.	
j. Select	SQL	Server	Browser	in	the	right	panel.	and	select	Stop	in	the	popup	menu.	
k. Repeat	the	process	in	steps	and	h	but	select	Start	in	the	popup	menu.	

 

Figure	100‐Installed	directory	structure	for	SQL	server	

	

Stopping and Starting SQL Services 

In	order	to	activate	the	configuration	settings	that	have	been	added	or	changed,	it’s	
necessary	to	stop,	and	re‐start	two	SQL	services.		This	is	done	from	the	SQL	Server	
Configuration	Manager	(see	Figure	101)	as	follows.	

a. In	the	left	side	navigation	panel	select	SQL	Server	Services,		
b. In	the	right	panel	–	right	click	SQL	Server	and	select	Stop	from	the	popup	menu,	
c. Select	SQL	Server	Browser	–	right	click,	and	select	Stop	from	the	popup	menu,	
d. Repeat	steps	b	and	c	but	select	Start	from	the	popup	menu.	

When	the	procedure	steps	are	finished,	the	two	services	should	show	“Running”	in	the	State	
column.		Close	the	Installation	screen.	
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Figure	101‐Stopping	and	starting	SQL	server	services	

	

Updating SQL Server 

Once	the	installation	and	configuration	is	complete	it’s	a	good	idea	to	check	for	any	
upgrades	or	patches	to	any	of	the	programs.		This	should	also	be	done	periodically.		Use	the	
procedure	below.	

a. Click	the	Widows	Start	button,	and	select	Windows	Updates,	
b. When	the	Windows	Update	screen	opens,	select	Check	for	updates.		One	of	the	

following	will	occure:		
 If	updates	are	available	click	Install	Updates.		A	progress	bar	is	displayed	to	

indicate	the	download	and	installation	activity,	

 If	no	updates	are	available	the	panel	can	be	closed.	
 

Figure	102‐Configuring	Network	Access	

	

Verifying Database Connectivity 

Following	the	installation	and	configuration,	and	before	ending	the	session,	it	is	advisable	to	
confirm	that	the	database	is	accessible	using	the	SQL	server.		This	is	done	using	the	SQL	
Server	2008	Studio	Manager	(see	Figure	103).	

a. Click	the	Widows	Start	button,	and	select	All	Programs,	
b. Click	Microsoft	SQL	Server	2008	to	expand	it	and	select	Microsoft	SQL	Server	2008	

Studio	in	the	resulting	list,	
c. Click	Connect	when	the	Connect	to	Server	pane	is	displayed.	
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If	any	errors	occur	address	them	at	this	point.		Otherwise	a	panel	is	displayed	showing	the	
database	structure	using	expandable	elements.		Administrators	can	select	elements	for	
viewing	and	editing.	

 

Figure	103‐The	SQL	Express	Server	database	Connect	to	Server	panel	
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Installing	the	SQL	Database	
Once	the	SQL	server	has	been	installed	it’s	necessary	to	install	the	requisite	BVM	databases.			

Run	the	BVM	database	executable:		“BVM_Database_Setup.exe”	which	is	located	in	either	the	
computer’s	download	folder,	the	computer’s	BVM4	directory,	the	BTECH	distribution	CD,	or	
the	BTECH	web	site.	

a. Locate	the	executable	file	and	double‐click,	
b. In	the	Run	Package	dialog	–	select	the	name	of	the	server	where	the	database	will	be	

installed	(see	Figure	104),			
 Be	certain	that	the	correct	instance	is	selected	when	multiple	instances	have	been	

installed.	

c. Click	Advanced	to	display	the	Advanced	panel.	
 Accept	or	change	the	database	folder	where	the	db	files	will	be	kept.	

 Accept	or	change	the	database	size	entry.		

d. Click	Run.		The	Execution	Started	dialog	with	a	progress	bar	is	displayed.	
e. When	the	“Package	executed	successfully”	message	dialog	is	displayed	–	click	OK.	

 

 

BTECH recommends 100 MB for the initial installation, and 100 MB for each 
additional 25 locations 

 

Figure	104‐	The	Run	Package/Advanced	screens	

	

SQL Server Management Studio 

Once	the	database	installation	is	complete	use	the	SQL	Server	Management	Studio	to	verify	
that	the	installation	is	correct	and	set	the	required	passwords.		

a. Navigate	to	and	start	the	SQL	Server	Management	Studio	from	the	Windows	Start	
panel.	
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 Click	Connect	in	the	Connect	to	Server	dialog,	(see	below).		This	displays	a	twp‐panel	
screen.		

 

Figure	105‐The	Connect	to	Server	dialog	

	

Setting User Passwords 

a. Click	Security	to	expand	it,	and	select	Logins	in	the	left	panel.		The	list	expands	as	
shown	in	Figure	106.	

b. Right‐click	on	either	bvm_user	or	bvmweb_user	to	display	a	pop‐up	menu.	
c. Click	Properties	to	display	the	Properties	panel	for	the	selected	user	type.	

 

Figure	106‐Setting	Database	Server	user	passwords	

	

Setting User Properties and Passwords 

a. In	the	Properties	Panel	(see	Figure	107)	change	the	pasword	from	the	default	to	a	
more	secure	one	and	confirm	the	change	in	the	second	field.	

b. Repeat	steps	‘c’	through	‘e’	for	the	bvmweb_user	password.	
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Figure	107‐Changing	User	Passwords	

	

Close	the	SQL	Server	Management	Studio	tool	once	the	passwords	have	been	changed.	
 

The default bvm_user password is P@ss0rd.  The default bvmweb_user default 
password is the same as the default SQL Server login. 

 

Configuring BVM to Work with the SQL Server  

Once	the	SQL	server	is	installed	and	configured	BVM	must	be	linked	to	it	and	have	certain	
items	(e.g.	user	passwords)	configured.		The	configuration	entries	required	for	BVM	and	
BVS	Observer	are	described	in	this	section.	

a. Start	BVM	and	close	the	location	list	panel	if	it’s	displayed.	
b. Click	Settings	in	the	menu	bar	and	select	Preferences	from	the	submenu.		The	

Software	Preferences	dialog	is	displayed.	

c. Click	the	 	button	to	display	a	list	window.		Drop	down	the	list	and	select	the	correct	
server	instance	(see	Figure	109).	

d. Check	the	“Use	SQL	Server	Authentication”	box	and	enter	or	change	the	user	role	and	
password.	

e. Close	BVM.	
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Figure	108‐Setting	SQL	Server	Authentication	

	

Setting	Passwords	in	BVS	Observer	

a. Open	BVM	Observer	and	select	Locations.	
b. Click	File	in	the	menu	bar	and	select	Observer	Settings.		The	Observer	Settings	dialog	

is	displayed	(see	Figure	109).	
c. Enter	the	same	user	role	and	password	that	was	entered	in	the	BVM	Settings	dialog.	
d. Repeat	this	process	for	all	additional	user	roles.		
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Figure	109‐The	Observer	Settings	Dialog	

	

Converting	to	SQL	from	MS	Access	

S5	installations	consisting	of	fewer	than	(approximately)	20	units	will	generally	use	
Microsoft	Access	as	a	database.		If	the	monitoring	configuration	increases	substantially	
converting	to	Microsoft	SQL	Express	2008	server	is	recommended.		The	conversion	process	
is	described	below.	

 

 

During the conversion process, existing MS Access database files are 
backed up to a separate sub‐directory.  They can be recovered using the 
Windows backup/recovery functionality and opened in MS Access. 

Removing Locations from BVM, Observer, and Status Monitor 

Most	S5	installations	use	Microsoft	Access	as	the	BVM	database.		This	generally	works	well	
as	long	as	the	total	number	of	S5s	for	a	location	does	not	exceed	about	20	units.		When	a	
location	exceeds	this	level,	the	SQL	Express	Server	should	be	installed	(see	Installing	SQL	
Server	Express	2008),	and	have	SQL	databases	created	and	configured.		To	convert	to	SQL	
databases	use	the	following	procedure.	

a. Install	the	SQL	server	and	server	management	software.	
b. Start	BVM	and	navigate	to	the	Locations	List	screen	(see	Figure	5,	pg.	11),	
c. Select	all	of	the	current	locations	and	click	Remove	Locations	from	List	and	click	

OK.		All	of	the	locations	are	removed	from	the	List	screen.			
d. NOTE:		Each	location	must	be	selected	and	removed	separately.	
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e. Start	Observer		

Once	the	locations	have	been	removed	configure	BVM	to	work	with	SQL,	(see	Configuring	
BVM	to	Work	with	the	SQL	Server,	above).	

Adding Locations to SQL 

After	BVM	has	been	configured	to	work	with	SQL	add	the	locations	as	follows:	

a. In	the	Locations	List	screen	click	Add	Location(s)	to	List.		Windows	Explorer	opens	
and	displays	the	.bvm	files	on	the	computer’s	BVM4	directory.	
 NOTE:		refer	to		

 Starting	BVM	and	Transferring	Location	Files	from	the	CD,	pg.	10.	

b. Select	all	of	the	appropriate	.bvm	files	from	the	CD	and	click	OK.	
c. In	the	option	dialog	select	SQL.	

All	of	the	Location	files	will	now	have	their	data	kept	in	an	SQL	database.	

Using BVS Observer and Status Monitor in an SQL Environment 

The	BVM	Observer	and	the	Status	Monitor	(if	installed)	is	compatible	with	an	SQL	database	
once	the	following	steps	are	performed.		Note	that	the	steps	must	be	performed	separately	
for	each	application.	

 

 

Convert the BVM 4.x software to SQL as described above prior to converting 
Observer  

 

a. Start	the	BVS	Observer	or	Status	Monitor.		If	the	BVM	Home	screen	is	displayed	close	
it,	(see	,	pg.	16).	

b. In	the	blank	BVM	screen	open	the	Location	List	screen	by	selecting	File‐Open	in	the	
menu	bar	or	clicking	the	File	icon	in	the	icon	bar,	(see	Figure	5,	pg.	11).	

c. Select	each	of	the	current	locations	and	click	Remove	Locations	from	List.	Click	
OK.		All	of	the	locations	are	removed	from	the	List	screen.	
 NOTE:		Each	location	must	be	selected	and	removed	individually.		

d. Close	and	re‐open	BVS	Observer	and	navigate	to	the	Location	List	screen	(if	
necessary).	

e. Click	Add	Locations	to	List(s).			
f. Windows	Explorer	opens	and	displays	the	.bvm	files	on	the	computer’s	hard	drive.	
g. Select	all	of	the	appropriate	.bvm	files	and	click	OK.	

These	files	are	added	to	the	BVS	Observer	that	is	now	utilizing	SQL.			
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BVM	Home	Screen	Display	Options	
The	BVM	home	screen	typically	uses	a	default	set	of	styles	to	display	string	data.		Some	of	the	styles	
can	be	changed	as	described	below.		Any	style	changes	made	by	a	user	become	the	default	and	the	
Home	screen	for	all	strings	will	use	them.		

There	are	a	limited	number	of	options	that	a	user	can	select	that	control	the	way	the	String	and	
Unit	architecture	is	displayed.		Once	a	desired	display	is	achieved	it	can	be	locked	so	that	other	
users	cannot	change	it.		Setting	display	options	is	done	either	by:	

a. Clicking	View	in	the	Menu	bar	and	selectiong	the	configuration	options	from	the	resulting	
menu	list	or,	

b. Right‐clicking	in	the	Home	screen	and	selecting	the	configuration	options	from	the	popup	
menu	(shown	below).	

 

Figure	110‐	The	Home	Screen	Popup	Configuration	Menu	

	
 

Table	22. Home	Screen	Configuration	Options	

Reverse String Order –  This option displays the stings from highest to lowest numbered, i.e. negative to 
positive (reverses the default order) 

Set String Label –  Enables the user to set custom labels for each string 

Change Unit Layout –  Enables the user to display the individual unit blocks horizontally or ‘stacked’ in 

columns.  See Figure	112 below. 
Unit Shape –  Enables the user to select one of three shapes to display the individual units 

Layout Locked –  Enables the administrator to lock the display parameters so users cannot change 
them. 

 

The	following	illustration	shows	the	unit	list	reversed	and	the	unit	numbers	in	horizontal	
rectangles.		Note	–	some	changes	have	been	made	to	the	graphic	below	to	improve	readability.	
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Figure	111	–Example	of	Home	screen	with	units	in	reverse	order	

	
 

The	Unit	layout	below	was	changed	to	a	‘stacked’	format	using	the	Change	Unit	Layout	option.	

Figure	112‐A	changed	layout	after	using	“Change	Unit	Layout	

	
 

When	‘Change	Unit	Layout’	is	selected	from	the	menu	the	following	dialog	is	displayed.		This	is	the	
only	changes	that	can	be	made	to	the	Units	display.	

 

Figure	113‐The	Change	Unit	Layout	dialog	
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Battery	Monitor	Alarms	–	Descriptions	
	

Alarm	Message	Description	

Error Message  Cause 

AC Power Failure –   The battery monitor has detected a loss of AC power to itself. 

Battery Discharge Alarm –   The battery monitor has detected a discharge of the battery system. 

System Voltage Alarm:450.0 Volts –   The system or charger voltage is out of limits. 

Critical Alarm: String 1 Unit 1 
Voltage:12.500 Volts –  

A unit voltage is outside of critical voltage limits. 

Maint Alert: String 1 Unit 1 
Voltage:12.750 Volts –  

A unit voltage is outside of maintenance voltage  limit. 

Critical Alarm: String 1 Unit 1 
Impedance:4.500 mOhms Average 
Method –  

A unit impedance is above of the average critical impedance limit. 

Maint Alert: String 1 Unit 1 
Impedance:4.250 mOhms Average 
Method –  

A unit impedance is above of the average maintenance impedance 
limit. 

Critical Alarm: String 1 Unit 1 
Impedance:4.500 mOhms Initial Method 
–  

A unit impedance is above of the initial critical impedance limit. 

Maint Alert: String 1 Unit 1 
Impedance:4.250 mOhms Initial Method 
–  

A unit impedance is above the initial maintenance impedance limit. 

Ambient Temperature:95.0 deg F –   The ambient temperature sensor is outside the temperature limits. 

Battery Temperature 1:96.8 deg F   – S3/S4 Alarm – A battery temperature sensor is outside the 
temperature limits. 

String 1 Unit 1 Temperature:96.8 deg F –   A unit temperature is outside of the temperature limits. 

Battery Temperature 1 Alarm:18.0 deg F 
above ambient –  

A battery temperature sensor is above the differential temperature 
limit. This indicates a possible thermal runaway. 

String 1 Unit 1 Temperature Alarm:18.0 
deg F above ambient –  

A unit temperature is above the differential temperature limit. This 
indicates a possible thermal runaway. 

Standby battery out of limits –   The backup battery in the battery monitor is outside of limits. The 
battery may not be able to power the battery monitor when power is 
lost. 

BVS is unlearned –   The battery monitor doesn’t know the battery configuration. 

BVS is unable to learn   – The battery monitor cannot determine the battery configuration. 

Ground Fault –   The battery monitor detected a ground fault. 

BVS is unable to learn ‐   The battery monitor cannot determine the battery configuration. 

(Auxiliary) Alarm (Relay Outputs) –   One of the Alarm Relay Outputs was triggered. 

Memory battery out of limits ‐   The backup battery in the battery monitor is outside of limits. The 
battery may not be able to power the battery monitor when power is 
lost. 
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BVS found the wrong number of  
units –  

The battery monitor found the wrong number of units when 
determining the battery configuration. 

BVS found the center lead placed 
incorrectly –  

The battery monitor found the center lead placed incorrectly when 
determining the battery configuration. 

BVS was unable to take impedance 
measurements –  

The battery monitor was unable to take impedance measurements. 

String 1 Voltage Alarm: 396.0 Volts ‐   The string voltage is out of limits. 

(Auxiliary) Alarm [Relay Outputs) 1 – 4  The particular alarm relay (auxiliary) output was triggered. 

Wrong number of voltage modules 
found: 3 –  

The battery monitor found the wrong number of voltage modules 
attached. 

Wrong number of current modules 
found: 1 –  

The battery monitor found the wrong number of current modules 
attached. 

Found unknown type of module: 13 –   The battery monitor found an unknown type of module. 

Corrupted configuration due to bad 
checksum –  

The battery monitor determined its configuration was corrupted due 
to the checksum not matching. It will then reset the configuration to 
the factory default. 

Corrupted configuration due to value out 
of limits –  

The battery monitor determined its configuration was corrupted due 
to a value of limits. It will then reset the configuration to the factory 
default. 

Hardware failure of network and local 
serial port –  

The battery monitor detected a hardware failure of a serial port. 

Hardware failure of modem serial  
port –  

The battery monitor detected a hardware failure of a serial port. 

Hardware failure of module serial  
port –  

The battery monitor detected a hardware failure of a serial port. 

Backup battery out of limits: 
 9.5 Volts –  

The backup battery in the battery monitor is outside of limits. The 
battery may not be able to power the battery monitor when power is 
lost. 

Module failed to initialize at position: 5 –  A module failed to initialize. 

Measurement aborted due to high 
voltage on positive half string –  

The measurement aborted due to a high half string voltage on the 
positive half of the battery string. 

Measurement aborted due to low 
voltage on positive half string –  

The measurement aborted due to a low half string voltage on the 
positive half of the battery string. 

Measurement aborted due to high 
voltage on negative half string –  

The measurement aborted due to a high half string voltage on the 
negative half of the battery string. 

Measurement aborted due to low 
voltage on negative half string –  

The measurement aborted due to a low half string voltage on the 
negative half of the battery string. 

Measurement aborted due to high load 
plate temperature –  

The measurement aborted due to a high load plate temperature. The 
“Load Plate Off Time” needs to be increased to allow the load plate to 
cool down before the next measurement 

Modem Failure –   The battery monitor’s modem is not functioning. 

Modem line error –   The battery monitor’s modem was unable to detect a dial‐tone to dial 
out. 

Invalid communications  
configuration –  

The communication’s configuration in the battery monitor is invalid. 
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Network controller is missing –   The battery monitor cannot detect its network controller. 

Wrong number of voltages (1) found on 
module 1 –  

A voltage module on the battery monitor was unable to find the 
correct number of unit voltage connections. 

Wrong number of temperatures (1) 
found on module 1 –  

A voltage module on the battery monitor was unable to find the 
correct number of temperature sensors. 

Temp Sensor 5:59.0 deg F ‐   The temperature sensor is outside of the temperature limits. 

Temp Sensor 7:18.0 deg F above ambient 
–  

The temperature sensor is above the differential temperature limit. 
This indicates a possible thermal runaway. 

Module 11 failed to relearn its 
connections ‐  

A module on the battery monitor was unable to find the correct 
number of connections. 

Measurement aborted due to a 
discharge –  

The measurement was aborted when a battery discharge occurred. 

String 2 breaker is open –   The battery monitor detected the breaker to a string was open. 

Measurement aborted due to string 2 
breaker being open –  

The measurement was aborted due to a string being open. 

Ambient Sensor Fault ‐ Equipment 
Hardware Alarm –  

The battery monitor was unable to detect a connected ambient 
temperature sensor. 

S‐Bus Module 1 Communications  
Fault ‐  

Equipment Hardware Alarm – The battery monitor was unable to 
communicate with a module on the S‐Bus. 

I‐Bus Module 1 Communications  
Fault ‐  

Equipment Hardware Alarm – The battery monitor was unable to 
communicate with a module on the S‐Bus. 

Controller needs to reboot –   Changes to the configuration require the battery monitor to be 
rebooted. 

S‐Module Communication Fault during 
Measurement –  

A communications error occurred between the controller and a 
module on the S‐Buss during a measurement. 

I‐Module Communication Fault during 
Measurement –  

A communications error occurred between the controller and a 
module on the I‐Buss during a measurement. 

S‐Module not Ready –   A module on the S‐Bus is not ready to perform a command. This can 
occur when a voltage module has just performed an impedance 
reading and receives a command to take another impedance reading. 
To prevent any damage to the module, there is a timeout period which 
prevents consecutive impedance measurements. 

Redundant S‐Module Address ‐ 
Equipment Configuration Alarm –  

The controller encountered multiple models on the S‐Bus with the 
same address. 

Redundant I‐Module Address ‐ 
Equipment Configuration Alarm –  

The controller encountered multiple models on the I‐Bus with the 
same address. 

Redundant S‐Module BVM Address ‐ 
Equipment Configuration Alarm 

 

Redundant I‐Module BVM Address ‐ 
Equipment Configuration Alarm 

 

Location Quantity out of Range ‐ 
Equipment Configuration Alarm 

 

Module / BVM Quantity Mismatch ‐ 
Equipment Configuration Alarm 

 

S‐Module Quantity out of Range ‐ 
Equipment Configuration Alarm –  

The number of modules on the S‐Bus is out of range. 
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I‐Module Quantity out of Range ‐ 
Equipment Configuration Alarm –  

The number of modules on the I‐Buss is out of range. 

S‐Module Address out of Range ‐ 
Equipment Configuration Alarm –  

The address of the module on the S‐Bus is not in the valid range. 

I‐Module Address out of Range ‐ 
Equipment Configuration Alarm –  

The address of the module on the I‐Bus is not in the valid range. 

S‐Module BVM 1 String or Unit ‐ 
Equipment Configuration Alarm 

 

I‐Module BVM 1 String ‐ Equipment 
Configuration Alarm – 

 

I‐Module BVM String Mismatch –   

Measurement has been aborted 
manually –  

An ongoing measurement was commanded to abort. 

Measurement has been aborted due to a 
major equipment alarm –  

A major equipment alarm prevented a measurement from completing. 

Wrong number of TSV modules found: 2 
–  

The battery monitor controller found the wrong number of TSV 
modules connected. 

The controller lost external power –   

BVS	Observer	Logged	Alarms	

BVS	Logged	Alarms	

Message  Cause 

  A network error between the computer and BVS has occurred 

	

BVS	Observer	Alarms	
The	following	alarm	descriptions	must	be	resolved	through	the	communications	
functionality.	

 The	discharge	memory	is	full.	Please	retrieve	the	discharge	data	and	clear	the	
discharge	memory.	

 The	system	does	not	have	the	correct	number	of	connections	to	the	battery	system.	
Please	use	Module	Diagnostic	in	the	BVM	and	the	installation	wiring	list	to	identify	
any	connection	issues.	

 Unable	to	open	comm	port	‐	comm	port	is	not	present.	

 Unable	to	open	comm	port	‐	comm	port	is	busy.	

 Unable	to	load	location.	

 Unable	to	load	communication	settings.		

 Comm	port	is	wrong.	

 Unable	to	change	the	comm	speed.	

 Communications	failure	occurred.	No	Response.	



	
S5	Operating	Manual	

	 Appendix 

 

Ver.	2.0	(August	2012)			 P a g e 	|	134	

	
 

 Location	ID's	did	not	match.	

 Wrong	Controller.	

 Number	of	strings	did	not	match.	

 Number	of	units	did	not	match.	

 Model	number	does	not	match.	

 The	number	of	temperature	sensors	did	not	match.	

 The	serial	numbers	did	not	match.	

 The	BVS	is	busy	measuring	impedance.	

 The	BVS	is	busy	taking	discharge	measurements.	

 Error	retrieving	discharge	measurements.	

 No	response	from	modem.	

 Number	busy.	

 Modem	Error.	

 No	Dialtone.	

 Dial	Timed	Out.	

 No	Answer.	

 No	Carrier.	

 Error	retrieving	measurment	data.	

 Phone	number	is	missing.	

 Dial	modem	not	available	on	comm	port.	

 Network	connection	timeout.	

 Permisson	Denied.	

 The	address	is	already	in	use.	

 The	address	is	not	available.	

 Address	family	not	supported	by	protocol	family.	

 Operation	already	in	progress.	

 Network	connection	has	aborted.	

 Connection	refused.	

 Network	connection	has	reset.	

 Destination	address	required.	

 Bad	address.	

 No	route	to	host.	

 Operation	now	in	progress.	

 Interrupted	funtion	call.	

 Invalid	argument.	

 Socket	is	already	connected.	

 Too	many	open	sockets.	

 Message	too	long.	
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 Network	is	down.	

 Network	connection	was	reset.	

 The	network	cannot	be	reached	from	this	host	at	this	time.	

 No	buffer	space	available.	

 Socket	is	not	connected.	

 Network	connection	has	closed.	

 Socket	operation	on	non‐socket.	

 Protocol	family	not	supported.	

 Too	many	processes.	

 Protocol	not	supported.	

 Protocol	wrong	type	for	socket.	

 Network	connection	has	shutdown.	

 Socket	type	not	supported.	

 Attempt	to	connect	timed	out	without	establishing	a	connection.	

 Host	not	found.	

 Network	initialization	not	successful.	

 This	is	non‐recoverable	error.	

 Network	subsystem	is	unavailable.	
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SNMP	Manager	Description	and	Configuration	
BVM	4.x	allows	an	SNMP	manager	to	use	an	S5	as	an	SNMP	agent.		The	S5	includes	an	SNMP	
model	web	server	capable	of	responding	to	“Get”	and	“GetNext”	requests,	and	sending	
unsolicited	‘trap’	messages.			

As	an	agent,	the	S5	listens	on	UDP	port	161	for	SNMP	messages	from	the	manager.		When	
the	S5	BVS	encounters	an	alarm	in	the	battery	system,	a	SNMP	trap	is	sent	out.		
Configuration	of	IP	addresses	that	receive	the	SNMP	trap,	and	the	resend	interval	is	
provided.		Optionally	up	to	three	IP	addresses	can	receive	a	trap.	

.mib Files 

A	MIB	(Management	Information	Base)	file,	named	BTECH	Battery	Monitor	S5.mib	is	
provided.		All	objects	provided	and	defined	in	the	MIB	file	are	in	the	enterprise	sub	tree.		
The	set	of	objects	in	the	alarm	directory	describe	an	alarm	as	an	object’s:	

 Severity,		

 Description,		

 Type,		

 Year,		

 Month,		

 Day,		

 Hour,	Minute,	Second,		

 String,		

 Unit.	

The	S5	BVS	sends	a	SNMP	trap	when	an	alarm	occurs	which	is	bound	with	these	objects	so	
the	SNMP	manager	can	determine	a	course	of	action.		If	more	than	one	alarm	occurs	at	a	
given	time,	multiple	traps	are	sent	to	the	manager.		Each	trap	describes	one	alarm.		One	of	
the	objects	bound	to	the	trap	is	called	“Severity”.	The	S5	BVS	defines	this	object	as	one	of	the	
following:	

1=Critical	–	immediate	action	needed,	page	someone	even	after	hours	

2=Major	–	action	needed	soon,	if	after	hours,	next	business	day	will	do	

4=Minor	–	action	could	probably	wait	for	next	maintenance	window	

8=Warning	–	informative,	sometimes	require	action	

There	is	one	object	in	the	MIB	tree	that	indicates	if	other	applications,	such	as	BTECH’s	BVM	
4.x,	BTECH’s	Observer	program,	or	a	MODBUS	master,	are	connected	to	the	S5	BVS.		The	
SNMP	manager	can	still	access	SNMP	objects	but	the	objects	or	traps	will	not	be	available	at	
this	time.		The	S5	BVS	can	be	configured	to	automatically	connect	to	an	Observer	application	
when	an	alarm	occurs.		The	Observer	retrieves	the	alarms	and,	if	set,	can	clear	the	alarms.		
In	this	scenario,	the	S5	BVS	will	at	least	send	out	one	trap	before	connecting	to	the	observer.	
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Configuration	

To	modify	these	settings	click	the	Configure	SNMP	Settings	button.		A	user	name	of	“btech”	
and	password	of	“monitor”	is	required	to	display	the	Configure	SNMP	Settings	page.		After	
modifying	the	settings,	click	on	the	Submit	button.	

 The	S5	BVS	IP	address	is	set	using	the	BVM	4.1	software.	The	IP	address	can	be	fixed	
or	obtained	using	DHCP,	

 The	S5	BVS	listens	on	Ethernet	adapter	UDP	port	161	for	SNMP	messages.		Use	the	
community	name	“public”	for	all	of	the	read	objects.		There	are	no	write	objects.	
Authentication	protocol	of	“MD5”	and	Privacy	protocol	of	“DES”	should	be	used.		Use	
only	“Get”	and	“GetNext”	requests.	

 The	SNMP	settings	can	be	queried	and	modified	using	the	web	pages	the	S5	BVS	
serves.		Using	Internet	Explorer,	type	the	IP	address	in	the	address	bar.		The	SNMP	
SETTINGS	web	page	is	displayed	with	the	present	settings	of	trap	resend	interval,	
three	trap	IP	addresses,	and	a	trap	community	name.		All	Zeroes	in	the	IP	address	
indicates	a	trap	will	not	be	sent	out	for	that	IP	address.	

MIB	Objects	Table	

The	base	directory	of	the	following	objects	is	(.1.3.6.1.4.1.26059.1.1.1)	or	
(iso.org.dod.internet.private.enterprise.btech.battery.monitor.S5.)	

 

MIB	Objects	Table	
 

Name  Address  Type  Comment 

Connect  1.0  Integer  B0= Observer B1=BV M B2=MODB 
US 

Severity  2.1.0  Integer  1=Critic al, 2=Major, 4=Minor, 

8=Warning 

Description  2.2.0  String  Phrase 

Type  2.3.0  Integer  See Alarm Type Table 

Year  2.4.0  Integer   

Month  2.5.0  Integer   

Day  2.6.0  Integer   

Hour  2.7.0  Integer   

Minute  2.8.0  Integer   

Second  2.9.0  Integer   

String  2.10.0  Integer  String Causing Alarm 
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Name  Address  Type  Comment 

Unit  2.11.0  Integer  Unit Causing Alarm 
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Modbus	Messaging	–	S5	[‐ML]	Battery	Validation	System	
This	S5	feature	allows	a	plant	computer	(DCS)	to	monitor	the	measurements	taken	by	the	S5.		The	
DCS	communicates	with	the	S5	over	an	Ethernet	connection	using	the	MODBUS	over	TCP/IP	
protocol.	The	plant	DCS	reads	and	displays	the	following	measurements	taken	by	the	S5:	

 System	voltages	

 System	current	

 String	Currents/Voltages	

 Ambient	temperature	

 Unit	float	voltage	

 Unit	temperature	

 Unit	Impedance	

As	soon	as	the	MODBUS	Master	connects,	its	holding	registers	for	Unit	Impedance	are	the	values	
taken	at	the	last	impedance	read.		Measurements	(#1	thru	#6)	are	then	updated	to	the	MODBUS	
holding	registers	every	time	the	VTz3	modules	are	scanned.		This	update	happens	even	when	the	
S5	is	in	discharge	mode.			

Unit	Impedance	is	updated	to	the	MODBUS	holding	registers	at	a	rate	configured	by	the	user.	
During	an	impedance	measurement,	measurements	numbered	1	through	6	are	not	updated.	There	
are	a	couple	of	MODBUS	registers	that	indicate	when	the	last	impedance	measurement	was	taken.		

Comments 

 All	data	values	are	supplied	to	the	registers	pre‐scaled.	

 Logged	Discharge	data	is	NOT	reported	via	MODBUS.	

All	MODBUS	holding	registers	are	read	only,	meaning	the	DCS	can	only	interrogate	the	S5	but	not	
configure	it.		Neither	can	the	DCS	clear	alarms	in	the	S5	via	MODBUS.		All	configurations	and	alarm	
resets	are	done	with	the	BVM	software	through	another	S5	connection.		The	DCS	can	examine	a	
couple	of	MODBUS	registers	that	indicate	how	the	S5	was	configured.		They	are:	

 location,	

 number	of	strings,	and		

 units	per	string.	

Additional Measurement Registers 

In	addition	to	the	above	measurements,	the	S5–ML	also	lets	the	DCS	obtain	status	of	the	S5	through	
the	following	output	coil	registers.		

 Maintenance	Alarm	

 Critical	Alarm	

 Equipment	error	

 In	Discharge	

 Impedance	measurement	in	progress	

 Discharge	memory	full	
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Alarm Registers 

The	S5‐ML	updates	a	set	of	registers	if	an	alarm	occurs.		The	last	32	alarms	can	be	monitored	by	
the	DCS.		However,	once	the	32	alarm	registers	are	filled,	the	S5‐ML	cannot	accept	additional	
alarms.		The	alarms	can	only	be	cleared	by	using	the	BVM	software.			

The	S5‐ML	can	report	an	alarm	to	an	OBSERVER	that	is	connected	to	the	network.		The	socket	
connection	to	the	MODBUS	master	remains	open	during	the	conversation	from	the	S5‐ML	to	the	
OBSERVER.	

The	BVM	software	can	connect	to	the	S5‐ML	while	the	MODBUS	master	is	also	connected.		The	
socket	connection	to	the	MODBUS	master	remains	open	during	the	conversation	from	the	S5‐ML	to	
the	BVM	software.	

See		

Alarm	Definitions,	page	141	

Configuration	

The	S5	IP	address	is	set	up	within	the	BVM	Software.		It	can	be	a	fixed	IP	address	or	obtained	from	
a	DHCP	server.		The	S5	has	a	fixed	port	address	(502)	for	MODBUS.		The	MODBUS	slave	address	is	
1.		On	power‐up,	the	S5	opens	two	sockets	for	either	the	BVM	software	or	the	DCS.	

 

S5‐ML Location Registers and Addresses 

The	S5‐ML	can	be	configured	to	have	at	most	4	locations.	

Location	1:	add	offset	of	0	to	holding	Registers,	
																					and	0	to	Coil	addresses	(Same	as	addresses	in	table).	

Location	2:	add	offset	of	1000	to	holding	Registers,	
																				and	offset	of	20	to	Coil	addresses.	

Location	3:	add	offset	of	2000	to	holding	Registers,	
																				and	offset	of	30	to	Coil	addresses.		

Location	4:	add	offset	of	3000	to	holding	Registers,	
																				and	40	to	Coil	addresses.	

 

MODBUS	Registers	

Name	 Address	 Type	 Comment	
Location	 40001	 Integer	 	
Number	of	Strings	 40002	 Integer	 	
Number	Units	per	String	 40003	 Integer	 	
System	Voltage	 40004	 Float	 (volts)	
System	Current		 40006	 Float	 (a)	
Ambient	Temperature	 40008	 Float	 (deg	c)	
String	Current	1	 40010	 Float	 (a)	
String	Current	2	 40012	 Float	 (a)	
String	Current	3	 40014	 Float	 (a)	
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Name	 Address	 Type	 Comment	
String	Current	4	 40016	 Float	 (a)	
String	Current	5	 40018	 Float	 (a)	
String	Current	6	 40020	 Float	 (a)	
String	Current	7	 40022	 Float	 (a)	
Unit	Float	Voltage	1	 40024	 Float	 (volts)	
Unit	Float	Voltage	2	 40026	 Float	 (volts)	
Unit	Float	Voltage	3	 40028	 Float	 (volts)	
Unit	Float	Voltage	4	 40030	 Float	 (volts)	
Unit	Float	Voltage	498	 41018	 Float	 (volts)	
Unit	Float	Voltage	499	 41020	 Float	 (volts)	
Unit	Float	Voltage	500	 41022	 Float	 (volts)	
Unit	Temperature	1	 41024	 Float	 (deg	c)	
Unit	Temperature	2	 41026	 Float	 (deg	c)	
Unit	Temperature	3	 41028	 Float	 (deg	c)	
Unit	Temperature	4	 41030	 Float	 (deg	c)	
Unit	Temperature	496	 42016	 Float	 (deg	c)	
Unit	Temperature	498	 42018	 Float	 (deg	c)	
Unit	Temperature	499	 42020	 Float	 (deg	c)	
Unit	Temperature	500	 42022	 Float	 (deg	c)	
Impedance	Measure	Year	 42024	 Integer	 Last	done	
Impedance	Measure	
Month	

42025	 Integer	 	

Impedance	Measure	Day	 42026	 Integer	 	
Impedance	Measure	Hour	 42027	 Integer	 Time	in	UTC	
Impedance	Measure	
Minute	

42028	 Integer	 Time	in	UTC	

Unit	Impedance	1	 42029	 Float	 (milliohms)	
Unit	Impedance	2	 42031	 Float	 (milliohms)	
Unit	Impedance	3	 42033	 Float	 (milliohms)	
Unit	Impedance	4	 42035	 Float	 (milliohms)	
Unit	Impedance	498	 43023	 Float	 (milliohms)	
Unit	Impedance	499	 43025	 Float	 (milliohms)	
Unit	Impedance	500	 43027	 Float	 (milliohms)	
Alarm	1	Year		 43029	 Integer	 	

	

Alarm	Definitions	
Table	23. Alarm	Definitions	

Alarm	 Type	 Severity	 Number	 Value	 Notes	
Discharge  1  8  Blank  Blank   

System Voltage  2  4  Blank  Voltage   

Ambient Temperature  3  4  Blank  Temp   

Ground Fault  4  2  Blank  Value   

Unit Voltage – Critical  5  2  Blank  Voltage  String, Unit 
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Alarm	 Type	 Severity	 Number	 Value	 Notes	
Unit Voltage ‐ Maintenance  6  4  Blank  Voltage  String, Unit 

Unit Impedance Average ‐ Critical  7  2  Blank  Impedance  String, Unit 

Unit Impedance Average ‐ 
Maintenance 

8  4  Blank  Impedance  String, Unit 

Unit Impedance Initial ‐ Critical  9  2  Blank  Impedance  String, Unit 

Unit Impedance Initial ‐ 
Maintenance 

10  4  Blank  Impedance  String, Unit 

Unit Temperature   11  4  Blank  Temp  String, Unit 

Unit Temperature ‐ Differential  12  4  Blank  Temp Difference  String, Unit 

String Voltage  13  4  Blank  Voltage  String # 

Aux Alarm [Relay outputs] 1  14  4  Blank  Blank   

Aux Alarm [Relay outputs]  2  15  2  Blank  Blank   

Aux Alarm [Relay outputs] 3  16  2  Blank  Blank   

Aux Alarm  [Relay outputs] 4  17  2  Blank  Blank   

Wrong Number of Voltage 
Modules 

18  2  Number  Blank   

Wrong Number of Discharge 
Current Modules 

19  2  Number  Blank   

Communication Error with 
Voltage Module 

20  2  Module #  Blank   

Communication Error with 
Current Module 

21  2  Module #  Blank   

Unknown Type of Module  22  2  Module #  Blank   

Corrupted Configuration  23  2  Reason  Blank  1 = Bad checksum 
2 = Value out of limits 

Hardware Failure  24  2  Serial port  Blank  1 = Network or front panel 
2 = Modem 
3 = Module port 

Backup Battery  25  2  Blank  Voltage   

Module Initialization Failure  26  4  Physical probe 
position 

   

Modem Failure  27  2       

Modem Line Failure  28  2       

Invalid Communication’s 
Configuration 

29  2       

Network controller is missing  30  2       

Number of units found is not 
equal to the amount specified. 
(voltage  modules)  

31  2  Module #  # of Voltages 
found 

 

Number of temperatures found is 
not equal to the amount 
specified. (voltage and temp 
module) 

32  2  Module #  # of 
Temperatures 
found 
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Alarm	 Type	 Severity	 Number	 Value	 Notes	
Temperature Sensor  33  2  Sensor Number Temperature   

Temperature Sensor – Differential 34  2  Sensor Number Temperature 
Difference 

 

Module Relearn Connection 
Failure 

35  2  Module #     

Impedance measurement 
aborted due to high voltage on 
positive half string. 

101  8    Voltage   

Impedance measurement 
aborted due to low voltage on 
positive half string. 

102  8    Voltage   

Impedance measurement 
aborted due to high voltage on 
negative half string. 

103  8    Voltage   

Impedance measurement 
aborted due to low voltage on 
negative half string. 

104  8    Voltage   

Impedance measurement 
aborted due to high load plate 
temperature. 

105  8    Temp   

Impedance measurement 
aborted due to discharge 

106  8       
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Product Warranty 
NOTE:	THIS	WARRANTY	IS	GIVEN	TO	THE	ORIGINAL	PURCHASING	END	USER	AND	IS	
APPLICABLE	ONLY	TO	PRODUCTS	AND	LICENSED	MATERIALS	SOLD	OR	DISTRIBUTED	TO	SUCH	
END	USER	BY	AN	AUTHORIZED	BTECH	RESELLER,	OR	BTECH	INC.	AND	BEARING	THE	“BTECH”	
BRAND	NAME.	

A. Hardware Warranty 

 BTECH	warrants	to	the	original	purchasing	End	User	that	each	unit	of	BTECH	hardware	
products	(“Hardware	Products”or	“Products”)	will	be	free	from	defects	in	material	and	
workmanship	for	a	period	of	one	(1)	year	from	the	date	of	shipment	to	End	User.	

 The	warranty	 period	will	 be	 defined	 as	 (15)	 fifteen	months	 from	 shipment	 or	 (1)	 one	 year	 from	 startup,	
whichever	comes	first.	

 Breach	of	warranty	will	be	enforceable	against	BTECH	only	if	written	notice	of	such	breach	is	
received	by	BTECH	within	the	applicable	warranty	period.	

 If	a	warranty	claim	is	invalid	for	any	reason,	the	End	User	will	be	charged	for	services	
performed	and	expenses	incurred	by	BTECH	in	repairing,	handling	and	shipping	the	returned	
Product.	

 Expendable	parts,	such	as	fuses	and	other	parts	that	are	regularly	replaced	due	to	normal	use,	
are	excluded	from	this	warranty.	

 As	to	Products	repaired	or	replaced	during	the	original	warranty	period	for	such	Product,	the	
warranty	period	on	the	replacement	Product	or	the	repaired	Product	shall	terminate	thirty	
(30)	days	after	shipment	to	End	User	or	upon	the	termination	of	the	original	warranty	period,	
whichever	is	longer.	

 As	to	any	out‐of‐warranty	Products	repaired,	modified	or	replaced	by	BTECH	at	BTECH	regular	
charges,	the	warranty	period	with	respect	to	the	material	and	workmanship	hereunder	shall	
expire	thirty	(30)	days	after	the	date	of	shipment	of	said	Product	to	End	User.	

B. Software Warranty 
The	only	warranty	BTECH	makes	to	End	User	in	connection	with	BTECH	licensed	materials,	which	
includes	BTECH	software,	together	with	related	documentation	and	the	media	embodying	the	
software	(“Licensed	Materials”),	is	that	the	media	on	which	the	Licensed	Materials	are	recorded	
will	be	replaced	without	charge,	if	BTECH,	in	good	faith,	determines	that	the	media	was	defective	
and	not	subject	to	misuse	for	a	period	of	ninety	(90)	days	from	the	date	of	shipment	to	End	User.	
Within	thirty	(30)	days	of	determination	of	same,	BTECH	shall	use	commercially	reasonable	efforts	
to	replace	any	defective	media	that	BTECH	has	determined	to	be	under	warranty.	

C. Entitlement During the Applicable Warranty Period 

Technical Support 

Technical	telephone	support	will	be	provided	by	BTECH	Factory	Technical	Service	Assistance	
Center	to	End	User	from	8:00	a.m.	to	5:00	p.m.	EST	Monday	through	Friday,	excluding	holidays.	
Telephone	support	provided	hereunder	will	be	limited	to	that	necessary	to	confirm	functional	
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operation	or	determine	if	a	Product	is	performing	in	accordance	with	Section	A	or	B	above,	
whichever	applies.	Should	further	support	be	required,	normal	support	charges	will	apply.	

Firmware/Software for the Version Licensed 

Should	BTECH	Factory	Service	determine,	during	the	course	of	providing	support	hereunder,	that	
the	End	User	may	benefit	from	the	installation	of	a	firmware	patch,	upgrade	or	software	bug	fix,	if	
and	when	BTECH,	at	its	sole	discretion,	develops	and	releases	said	firmware	patch,	or	upgrade,	or	
software	bug	fix,	BTECH	may	make	same	available	to	the	End	User	at	no	charge.	

Product Replacement 

During	the	initial	thirty	(30)	days	from	the	date	of	shipment	of	Hardware	Products	having	a	one	
(1)	year	warranty	hereunder,	such	Hardware	Products	which,	after	reasonable	due	diligence	and	
support	attempts	by	BTECH	Factory	Service,	is	determined	by	BTECH	Factory	Service	to	be	non‐
functioning	due	to	product	defect,	shall	be	replaced	on	a	commercially	reasonable	efforts	basis.	
BTECH	and	End	User	will	follow	the	procedures	outlined	in	Section	C	herein	for	the	return	and	
replacement	of	such	Hardware	Products	during	the	above	referenced	periods	that	End	User	has	
purchased	directly	from	BTECH.	For	such	Hardware	Products	that	End	User	has	purchased	from	a	
BTECH	Reseller,	the	following	procedures	shall	be	followed	for	the	return	and	replacement	of	such	
Hardware	Products	during	the	above	referenced	periods:	

 BTECH	must	be	notified	by	End	User	prior	to	the	return	of	said	Product.	Within	ten	(10)	
days	of	the	date	of	said	notification	BTECH	will	provide	End	User	with	a	valid	Return	
Material	Authorization	Number	(RMA).	

 b)			Within	ten	(10)	days	of	receipt	of	a	Return	Material	Authorization	Number	from	BTECH,	
the	End	User	will	notify	the	Reseller	from	whom	the	Product	was	purchased	of	t	he	RMA	
Number,	request	Product	replacement,	and	obtain	information	regarding	the	location	to	which	
the	End	User	must	return	the	Product	claimed	to	be	defective,	as	well	as	any	other	pertinent	
information.		

 Transportation	costs	relating	to	the	delivery	of	warranty	claims	to	Reseller	will	be	borne	by	the	
End	User.	In	no	event	will	Reseller	accept	any	returned	Product	that	does	not	have	a	valid	RMA	
Number.	All	Products	returned	to	Reseller	must	be	packaged	in	packing	materials	that	affords	
the	same	degree	of	protection	from	damage	and	electrical	discharge	as	the	original	packaging	
materials.	

 All	Products	returned	to	Reseller	should	be	configured	as	originally	shipped	to	End	User	by	
removing	all	add‐on	hardware.	Add‐on	hardware	returned	with	the	Products	may	be	lost	in	the	
repair	process,	and	Reseller	shall	bear	no	responsibility	for	such	loss.		

 	End	User	shall	promptly,	but	in	no	event	later	than	ten	(10)	days	of	receipt	of	an	RMA	Number	
from	BTECH,	deliver	said	shipment	to	a	carrier	at	End	User’s	facilities	as	previously	stated.	

 Within	thirty	(30)	days	of	receipt	of	same,	Reseller	shall	use	commercially	reasonable	efforts	to	
replace	any	defective	Products	that	BTECH	or	Reseller	has	determined	to	be	under	warranty.	

 Transportation	costs	relating	to	the	return	of	warranty	claims	to	the	End	User	will	be	borne	by	
Reseller	only	in	cases	where	replacement	is	made	and	authorized	pursuant	hereto,	but	any	
applicable	duties	or	taxes	will	be	paid	by	End	User.	If	no	warranty	replacement	was	required,	
all	transportation	costs	will	be	borne	by	End	User.	“Emergency”	transportation	costs	shall	be	
borne	by	End	User.	
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Return and Repair 

 During	the	remainder	of	the	hardware	warranty	period,	if	Products	under	warranty	are	
claimed	to	be	defective,	BTECH	must	be	notified	by	End	User	prior	to	the	return	of	said	
Product.	Within	ten	(10)	days	of	the	date	of	said	notification	BTECH	will	provide	End	User	
with	a	valid	Return	Material	Authorization	number	and	the	location	to	which	End	User	
must	return	the	Product	claimed	to	be	defective.	Transportation	costs	relating	to	the	
delivery	of	warranty	claims	to	BTECH	will	be	borne	by	the	End	User.	In	no	event	will	
BTECH	accept	any	returned	Product	which	does	not	have	a	valid	Return	Material	
Authorization	number.	All	Products	returned	to	BTECH	should	be	configured	as	originally	
shipped	to	End	User	by	removing	all	add‐on	hardware.	Any	add‐on	hardware	returned	
with	the	Products	may	be	lost	in	the	repair	process,	and	BTECH	shall	bear	no	responsibility	
for	such	loss.	

 Within	the	(10)	days	of	receipt	of	notice	from	BTECH	requiring	return,	End	User	shall	deliver	
said	shipment	to	a	carrier	at	End	User’s	facilities	as	aforesaid.	

 Within	thirty	(30)	days	of	receipt	of	same,	BTECH	shall	use	commercially	reasonable	efforts	to	
fix	or	replace,	at	its	option	(except	as	provided	in	Section	C	herein),	any	defective	Products	that	
BTECH	has	determined	to	be	under	warranty.	

 Transportation	costs	relating	to	the	return	of	warranty	claims	to	the	End	User	will	be	borne	by	
BTECH	only	in	cases	where	repair	or	replacement	is	made	and	authorized	pursuant	hereto,	but	
any	applicable	duties	or	taxes	will	be	paid	by	End	User.	If	no	warranty	repair	or	replacement	
was	required,	all	transportation	costs	will	be	borne	by	End	User.	“Emergency”	transportation	
costs	shall	be	borne	by	End	User.	

General 

The	warranties	set	forth	in	Sections	A	and	B	above,	and	the	entitlements	set	forth	in	Section	C	
above,	are	for	the	benefit	of	and	shall	apply	only	to	End	User.	

 BTECH	warranties	shall	not	apply	to	any	Product	or	Licensed	Material	which	has	been	
damaged	as	a	result	of,	or	subjected	to,	accident,	neglect,	misuse,	abuse,	vandalism,	riot,	
war,	acts	of	terrorism,	negligence	in	transportation	or	handling,	failure	or	surges	in	electric	
power,	air	conditioning,	humidity	control,	flood,	water,	fire	or	smoke	and	heat	damage,	
causes	other	than	ordinary	use,	acts	of	God	or	causes	beyond	BTECH	control,	or	if	the	
Product	or	Licensed	Material	was	not	properly	maintained	by	End	User	during	the	
warranty	period.	

 There	shall	be	no	warranty	or	liability	for	any	Products	or	Licensed	Materials	that	have	been	
modified	by	End	User	without	BTECH	prior	written	approval.	

 Replacement	Products	or	Licensed	Materials	outside	the	scope	of	this	warranty	or	with	respect	
to	Product(s)	or	Licensed	Materials	out‐of‐warranty	will	be	furnished	at	the	established	
charges	of	BTECH	then	in	effect.	End	User	shall	ensure	that	BTECH	will	have	full	and	free	
access	to	the	Products	and	Licensed	Materials	and	End	User’s	site,	if	required.	BTECH	shall	not	
be	responsible	for	failure	to	repair	or	replace	Products	or	Licensed	Materials	due	to	causes	
beyond	its	control.	BTECH	shall	not	be	required	to	replace	any	Product	or	Licensed	Material	if	
it	would	be	impractical	for	BTECH	personnel	to	do	so	because	of	unauthorized	alterations	to	
the	Products	or	Licensed	Materials	or	its	unauthorized	connection	by	mechanical	or	electrical	
means	to	another	system	or	device.	
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Limitation of Liability 

THESE	WARRANTIES	AND	BTECH	AND	ITS	AFFILIATES’	LIABILITY	AND	END	USER’S	REMEDIES	
WITH	RESPECT	THERETO,	AS	SET	FORTH	HEREIN,	ARE	EXCLUSIVE	AND	EXPRESSLY	IN	LIEU	OF	
ALL	OTHER	WARRANTIES,	LIABILITIES,	REMEDIES,	EXPRESS	OR	IMPLIED,	INCLUDING	ANY	
OBLIGATION,	LIABILITY,	RIGHT,	CLAIM	OR	REMEDY	IN	TORT,	WHETHER	OR	NOT	ARISING	FROM	
NEGLIGENCE	OF	BTECH	OR	ITS	AFFILIATES,	ACTUAL	OR	IMPUTED,	AND	NO	WARRANTIES,	
EXPRESS	OR	IMPLIED	REPRESENTATIONS,	PROMISES	OR	STATEMENTS	HAVE	BEEN	MADE	BY	
BTECH	OR	ITS	AFFILIATES	UNLESS	CONTAINED	IN	THIS	AGREEMENT.	NO	WARRANTY,	EXPRESS	
OR	IMPLIED,	IS	MADE	HEREIN	THAT	THE	LICENSED	MATERIALS,	PRODUCTS	OR	ANY	PARTS	ARE	
MERCHATABLE,	OR	FIT	OR	SUITABLE	FOR	THE	PARTICULAR	PURPOSES	FOR	WHICH	THE	
LICENSED	MATERIALS,	PRODUCTS	OR	PARTS	MAY	BE	ACQUIRED	BY	END	USER.	IN	NO	EVENT	
SHALL	BTECH	OR	ITS	AFFILIATES	BE	LIABLE	TO	END	USER	FOR	ANY	INDIRECT,	INCIDENTAL,	OR	
CONSEQUENTIAL	DAMAGES	INCLUDING	WITHOUT	LIMITATION,	LOSS	OF	DATA,	OR	PROFITS,	
WHETHER	CLAIMED	BY	REASON	OF	BREACH	OF	WARRANTY	OR	OTHERWISE,	AND	WITHOUT	
REGARD	TO	THE	FORM	OF	ACTION	IN	WHICH	SUCH	CLAIM	IS	MADE.	

 The	Products	and	Licensed	Materials	are	not	specifically	developed,	or	licensed	for	use	in	
any	nuclear,	aviation,	mass	transit,	or	medical	applications	or	in	any	other	inherently	
dangerous	applications.	

 End	User	agrees	to	indemnify	and	hold	BTECH	harmless	from	any	claims	for	losses,	costs,	
damages,	or	liability	arising	out	of	or	in	connection	with	the	use	of	the	Products	and/or	
Licensed	Materials	in	such	applications.	

 Notwithstanding	anything	contained	herein	to	the	contrary,	the	total	maximum	liability	of	
BTECH	and	its	Affiliates	under	this	warranty	for	the	affected	Product(s)	and	Licensed	Materials	
is	limited,	at	the	option	of	BTECH,	to	either:	

 	BTECH	use	of	reasonable	efforts	to	repair	any	Product	or	Licensed		
	Materials;	or		BTECH	use	of	reasonable	efforts	to	replace	any	Product	or	Licensed	Materials,	or	
any	shipment	as	to	which	any	defect	is	claimed	by	End	User	and	duly	verified	by	BTECH;	or	

 The	refund	of	the	purchase	price	or	license	fee	paid.	

	

	

 
 
 


